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INTRODUCTION
Aphelion appreciates your business and welcomes you to our family of satisfied customers.
Aphelion has written this introductory manual for you to use as a reference while training to
use the software. You will find that the system is easy to use and most of the keystrokes are
intuitive. The system is designed to utilize as few menus as possible. This makes the
system easy to use and quick to learn.
Aphelion software is designed to manage your facility. The system is designed to automatically track member check-ins, prospects, ProShop sales and transactions, and allows you to
bill your members. Aphelion software prints ProShop receipts and reports, stores detailed
data pertaining to the members, and keeps the member records current with accurate
accounting information. The system provides for the printing of special reports, including
those that detail the day-to-day activities of the club. Reports include sales information,
cash reconciliation for the ProShop, member billing details and summaries, and member
status. In a nutshell, the program is designed to totally automate your facility.

First Look
The Aphelion software is a system that consists of several modules. These modules isolate
the tasks and make it easier to operate the system. The modules include Marketing, Sales,
Front Counter (Check-in and POS), Workout Tracking, Reports, Data Entry, Configuration, Expert, Billing, Collections, and Commissions. Also, you may have the
optional Data Exchange software, or several special utilities. These modules are designed
to automate the different work areas of the club. The modules will be discussed in detail
further in this guide.
You will find the word “database” used throughout this manual. The database area of the
program is the information storage area of the system. Data entered in one module flows to
all other modules. Information regarding the members, inventory, employees, classes, etc
is entered into each database via the Data Entry module. As transactions occur, the
information in the databases is automatically updated. The software references this information and uses it during the generation of reports and during a Point-of-Sale (POS)
transaction. You can add new information to the databases or modify information that is
already present. Aphelion records all information in the various databases, and allows you
to have access to current member and product information.
The Reports module is used to view the business management reports. The reports include
preformatted database query and accounting reports. The preformatted reports are grouped
together in menus, corresponding to the type of report. For example, membership reports
are separated from the inventory reports in separate menus. The Aphelion system also
provides a method for you to create your own custom reports. The Report Wizard will allow
you to create a custom query and a custom layout for the printed report. Queries and
Layouts are combined to create named reports that can be printed on demand. Additionally,
the system will output all of the information that is contained in each report to “Form”
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Aphelion Program Group

letters, using Microsoft Word or Excel. For example, this capability will let you view the list
of 30-day delinquent accounts, and then send a customized form letter or create a spreadsheet.
The Front Counter module is provided to check-in the members, access account or
member details, sell ProShop items, schedule classes, log employee work hours, and track
personal training. This module is designed to provide all the tools needed to automate the
Front Counter or ProShop of the club.
The Configuration module is provided to tailor the system to each health club’s individual
needs. Since no two clubs are alike, minor changes need to be made to the system to
accommodate differences from club to club. This area includes provision for different tax
rates, types of printers, cash drawers, membership types, setting the passwords, etc. The
Configuration module allows the user to customize the system to each site’s particular
needs.
Be comfortable with the system.... You can’t hurt it. The system will always ask for a
confirmation before it allows you to delete any information, so don’t hesitate to experiment. Pressing the wrong key usually results in a “beep” or message. The message indicates that a wrong key has been entered, but no damage has been done. Just press the
correct key and continue.
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What’s In This Guide
This manual will show you how to operate the Aphelion Software and take full advantage of
its features. In it you’ll find:
An overview of the system capabilities.
An introduction to timesaving techniques.
Advice about how to get your work done efficiently.
Aphelion offers varied and abundant assistance in learning to use the program. You can
learn about the software features the way that’s most comfortable to you. Here are the
options:
Manual - Tells you the benefits of a feature and provides conceptual information.
Tool Tips - Tells you what each icon does. This is helpful for choosing which icon to
use. Tool Tips is available when you place the mouse over an icon for more than one
second. Tool Tips is also available for many menu items.
Training - Training allows you to get the most from the software. Training can be
performed at your site or in our facility in Houston. Our courses in Houston are taught
every month and are highly recommended!
License Agreement
APHELION, Inc.’s application software is protected by the copyright laws that pertain to
computer software. The Software contains trade secrets and in order to protect them you
may not decompile, reverse engineer, disassemble, or otherwise reduce the software to
human perceivable form.
The Software is provided in the form of non-exclusive Licenses granted in connection with
the furnishing and use of APHELION, Inc.’s Software products. Purchaser agrees to (i) use
the Software products only on the number of computer system(s) for which a license has
been purchased; (ii) not modify, adapt, translate, rent, lease, or create derivative works
based upon the Software or any part thereof.
You are encouraged to make a backup copy of the software for your own use, however you
shall not provide or otherwise make available the Software or any part or copies thereof in
any form to any third party (except your employees or agent directly employed with your
use of the Software) without APHELION, Inc.’s written consent. Documentation, including
user manuals and program listings, if provided, shall be non-transferable. Purchaser shall
not copy, reproduce, disclose, duplicate, or allow to be copied, in whole or in part, any
licensed program or any information deemed proprietary by APHELION, Inc.
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Copyright
NOTICE: This software and system has been provided pursuant to a License Agreement
that contains restrictions on its use. This product contains APHELION proprietary and trade
secrets that are protected under federal copyright law. It is UNLAWFUL to COPY or
DISTRIBUTE this product in any form or medium, or to disclose to any third party, or to
use in any manner not provided in said License Agreement, except with the prior written
permission of APHELION.
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Getting Started
This section will describe the method used to install the program on your computer. Instructions are provided on the method used to “run” the program after it is installed.

Hardware Requirements
Certain minimum hardware is required to run the software. A Pentium P150 class computer, about 5 GB or larger hard disk, one CD ROM, Windows 95 or later, and 32
Mbytes of memory are the minimum system requirements.
For best performance or for multiple workstations, or networked applications, a Pentium
300 class machine with large hard disk and at least 64 Mbytes of memory is preferred.
Networks such as Windows ’98 and Windows NT, are ideally suited for networking the
software.
To enhance the system, a barcode reader can be added to speed the data entry process and
reduce errors. Aphelion software also supports an electronic cash drawer, POS printer,
visual card reader, display pole and a turnstile.
To get the most from your system, a touchscreen monitor should be added to the front
counter or member workout tracking workstations. A touchscreen monitor provides the
fastest transaction times and simplifies training. This type of monitor is recommended,
since it has been proven to reduce operator fatigue and simplifies operation of the
system.

Data Backup
Before you get started, we would like to insert an editorial comment (just once). You have
purchased a software package that is complete, comprehensive and tested. You can’t hurt it,
and it won’t lose your data, unless you deliberately delete records. Computer hardware, on
the other hand, does fail. Failures do not occur very often, but when they do, it’s always at
the most inappropriate time. We feel that one of the most important sections of this manual
is the DATA BACKUP section. The importance of backing up your data cannot be emphasized enough. Significant hardware failures can be trivial if you have a data backup.
Without a backup, trivial failures can become major catastrophes. Hardware can and does
fail, particularly with the heavy use that occurs in a Point of Sale environment, so Please,
Please, Please, backup your data on a regular (DAILY) basis. Thank-You! Trust us, it’s
worth the time.

Major Features
Many capabilities are available in the Aphelion software. Details on how to use the system
are contained in this and subsequent chapters. For those of you in a hurry, here’s a quick
summary of some of the main capabilities available in the system that you shouldn’t miss:
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File Card Icon:
When you check-in members to your facility, don’t forget that you can use the File Card
icon during check-in to pop-up the member roster if a member forgets his card or ID
number, or just type the last name instead of the ID number. Use the mouse to click on
various areas of the check-in and POS screen. Just about every area will display more
information when you click on it. For example, if you click on the name of a member on
the recent check-in list, details of the member’s account will appear.
Visit Counter:
The Visit Counter will let you sell visits to an activity within the club, and then it will count
down as the activity is used. This feature is similar to a punchcard-- use it to sell nursery
visits, tanning beds, Apex, c ourt usage, etc.
Monitored Mode:
If the check-in activity is not very high, set the Front Counter to “Monitored mode” checkin. This allows you to monitor the check-in visually without having to type anything on the
keyboard. This mode is very helpful if there is only one person behind the counter.
POS Register:
When selling ProShop items, the point-of-sale Register screen provides revenue and profit
reports by department, cash reconciliation, and Z-out.
Schedule Appointments:
Use the View Appointments icon in the Front Counter module to schedule appointments for
tanning beds, trainers, courts, managers, etc. You can view each calendar by month or by
individual schedules.
Voice Messaging:
If you have a sound card for your PC, be sure to setup the voice messaging. This can be
used to provide vocal alerts during the check-in and sales process. Remember, you can
customize these so they use your personalized alerts.
Classes:
Setup classes using the database module. From the Front Counter module, the Class
function will track member enrollment, class capacity, and create standby lists. Additionally, you can create a printout if you want to post class schedules.
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Club Restrictions:
Setup Club Services, Time of Day check-in restrictions, and Club Privileges in the Configuration module. Each member can then be setup to restrict access to the club by time (Peak
and Off-Peak memberships) and type of Activity.
Group Database:
The Group database (available in the Data Entry module) will let you track corporate
members, groups, or affiliations. Setup groups in the Group database, and bill each company directly. You can even setup minimum club usage for each member in order to be
billed to the company.
Printing Receipts:
Printing customer receipts from the Front Counter Register can be turned on, off, or you
can be prompted after each sale is completed.
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Installation
If you purchased a complete system from Aphelion, you can safely skip this section. If you
are installing the software locally, follow these steps:
1.

Start Windows.

2.

Insert the Aphelion Software distribution CD into your CD-ROM drive. (Auto run should
bring up a menu.)

3.

From the main menu select “Install Software”.

4.

Select the type of installation (server or workstation) based on your needs and the given
description.

5.

Follow the on-screen instructions to complete the installation process. That’s it! The
software is installed on your system.

If you have purchased optional software, such as the Data Exchange Utilities, you will
have additional icons.

Network Installation
If you are installing the program on a network, you should select a unique terminal number
for each Workstation. These terminal numbers should be numbered starting at station 1, and
incrementing for each additional station on the network. The install program should be used
to install the software for each Workstation.
When installing to a network certain precautions must be taken. First, you must determine
if you are installing the software on a computer that is acting as the network Server or one
of the Workstations. Second, you must know the assigned network drive of the server’s
hard drive within the network.
When you are installing the software you will be asked if the installation is to the network
Server or Workstation. If you are installing the software to the Server, then choose that
option. If you choose the option to install to a network Workstation, you will be asked for
the network Server drive letter.
Be sure to install the software on your Workstations as such, not as a Server. The reason
this is important is because a full installation of the software is only done on the network
Server. The Workstations are “mapped” to the Server so that customer information will be
shared by all of the computers within the network. While technically possible to fully
install the software on every Workstation, a long-term maintenance benefit is better
achieved by installing one copy of the software on the Server, and our Workstation software
on the stations.
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Hardware Keys
Along with the Aphelion program disks, most versions of the software package include a
hardware key. (The hardware key is a small black plastic device with a male, 25 pin,
connector on one side and a similar female connector on the other.) The key is to be
inserted, in series, with the printer cable. To install the key, remove the printer cable from
the back of your computer, plug the key onto the exposed parallel port and secure with the
screw fasteners. Plug the printer cable into the exposed port on the key and secure. This
completes the installation of the key onto your computer system.
The installation and use of the hardware key is provided for security purposes, and will not
interfere with the normal operation of the printer.

Automatic Start-Up
If desired, the system can be configured to start a selected module automatically upon
system power-up. At a minimum, you should have the Front Counter module start automatically when you turn the front counter computer on. To do this, you should place the
appropriate program icon into the Windows Startup Program Group
Right mouse click on the program that you want to start automatically. Select “Copy” from
the menu that is displayed. Open the Startup folder. Place the mouse pointer within the
folder, then click the right mouse. Select “Paste Shortcut” from the menu.
Consult your Windows manual for detailed instructions on adding items to the Startup
folder.
The Front Counter can be configured to open directly to check-in or POS. Put the \Check-in
or \POS command extension after the program name on the properties.

Touchscreen
If you purchased a complete system directly from Aphelion, you can safely skip this section.
If you need to install the touchscreen locally, you’ll need to follow these directions. The
touchscreen software is installed in a similar fashion to the main software.
1.

Close any Windows programs that you may have open.

2.

Start Microsoft Windows 95 or a later release of any of these operating systems if you are
not running it already.

3.

Insert the Touchscreen software disk labeled “Disk 1” into the A: (or B:) drive.

4.

From the Program Manager, Select the File menu.

5.

Choose Run. Type A:setup, (or B:setup) then click OK.

6.

Follow the instructions that appear on the screen.

7.

The Install program will automatically copy the files from the disks to your hard disk. The
program will give you step by step directions as it installs the touchscreen software.

That’s it! The software is installed on your system.
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Picture Capture
For Aphelion customers with the ScreenPics option, Aphelion has developed a simple
method to capture your members’ images. To use the video capture utility, you must have a
camera and special Aphelion software.
There are two methods to take member pictures. By far the easiest is to click on the camera
icon when the member checks-in to the club. The camera icon is displayed on the check-in
screen. When you click the camera icon, the member’s image is displayed on the screen,
and permanently associated with the member every time he checks-in. To manage all of the
images at one time, or to set up a workstation to take pictures on initial club startup, use the
Capture utility. Select the PICTURES icon from Aphelion Club Management Program
Group rather than from the Front Counter module.
The first time you execute the (Picture) CAPTURE program it will prompt you for the type
of video input source that is connected to the interface board. For most applications, the
correct response will be Composite Video. Select the S Video option if you are using this
type of interface.
If you select the camera icon from the Front Counter, the member’s picture will appear in a
small box that overlays the check-in screen. When you save the image, the picture is
transferred to the screen and will always appear whenever the member checks-in. If you
want to replace the existing picture, simply click the camera icon again.
If you select the CAPTURE utility from the Aphelion program group, the program will
display an alphabetical list of your members. This is your membership roster. Members
with a picture will show a check mark in the right-most column. The CAPTURE program
can be operated with a mouse or with keyboard input.
Use the up/down arrow keys to highlight a member of interest. Alternately, you can just
type part of the desired name, then search. Click on the menu option to display an existing
image for a highlighted member, or click on the appropriate menu option to capture a new
image for the highlighted member.
The images will be captured in the “GIF” (Graphics Interchange File) file format. We have
found that the “GIF” file format offers savings in space requirement. Fitness Manager will
also allow you to use existing “PCX” files if you have images already stored.

Sound
If your computer has a sound board installed, the system will play sounds for several types
of events. The system uses standard WAV files, and is compatible with most sound blaster
or equivalent boards.
The system can be configured to use different sounds for many types of events, such as OK
Entry, No Entry, Account Balances, expired contract, etc. The sound files make it easy to
hear messages and alerts when the club is busy or noisy. You cannot hear the sounds
through the standard speaker that is installed in most computers.
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To hear the sounds, sound must be enabled in your Windows System Setup before the
program will play the sounds. Refer to the Windows Control Panel of your Windows
manual to setup sound.
The sounds are assigned in the Configuration module, under the Station menu selection.

Technical Support
We are sure you will be pleased with the dependability and reliability of your new system.
We have a variety of services designed to help you get the most out of your new software.
When you become a registered user, you are entitled to PRODUCT UPDATE NOTICES.
You’ll be notified when APHELION introduces new releases. These releases will be
available at a nominal fee.
Our Technical specialists are ready to answer your questions by mail or phone.

(281) 333-9897
9:00 AM - 4:00 P.M. CENTRAL TIME
MONDAY - FRIDAY
You may call within 30 days of your purchase date at no charge.
Technical service calls not covered under the standard service policy are billable at our
service rate. If you prefer, you may write or fax our technical service group at no charge.
We are also available to answer your questions at Aphelion.net. Send e-mail to
Tech@Aphelion.net .
An optional support plan called Premium Support provides specialized technical support.
You can have immediate answers to your technical questions quickly and conveniently
throughout the year. With our Premium Support plan you get:

•
•
•

Fast phone support
Extended support hours
Product updates

Periodically we issue updated releases of software that incorporate new features and
functions. Premium Service customers will receive these updates at no charge, as they
become available. Major version changes are not included, but are available at a nominal
charge.
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If you have difficulty in using the software, or it does not operate as described in your
instruction manual, please follow these steps:
First check this manual. You’ll find the answers to most of your questions in this book.
When calling for technical help, have the following information ready:
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•

Serial Number and Version Number of the software (found on the main menu
display screen when you access the Help menu)

•
•
•
•

Computer make and model; amount of RAM; type and make of hard disk.

•

Specific details of the events that led to your question.

Printer information (make, model, speed, etc.)
Windows version.
Types of memory resident programs and any other programs you are running at
the same time.

WELCOME TO APHELION SOFTWARE
This section will describe the way the software works with your computer. We’ll discuss the
menu conventions, the keyboard, using the mouse, and the touchscreen system.

Starting and Stopping the System
To start the Aphelion Software do one of the following:
Locate and open the “Aphelion Club Management V3” folder on your desktop and select a
module.
From the “Start” button choose Programs | Aphelion Club Management V3 and select a
module, or open the program group on your desktop.
Once your session is complete, you’ll want to exit the program. The easiest method to exit
is to select the <Exit> icon from the menu. Click on the < Exit> icon to close the software
application. Alternately, select File | Exit from the menu. You’ll be prompted “Are you sure
you want to exit?” Answer YES.
Please be sure to shut the system down using the proper Windows “shut down” procedure.
Do not just turn off your computer, as this will cause file errors on the hard disk, thus
possibly corrupting your data files.

Keyboard
Though there are many types of computers and keyboards, all will allow you to navigate
through the system with the following keys. You’ll always know where you are on the
screen if you look for the cursor. The cursor is the small flashing line on the screen. It
indicates where on the screen text will appear when you type something at the keyboard.
When there is not a cursor on screen, there will be a button that will be highlighted to
indicate which of several choices will be selected when you press the <Enter> key. This is
called the BLOCK CURSOR.
The ESCAPE key is sometimes labeled ESC. This manual will refer to it as <ESC>. The
ESC key usually moves to a prior menu selection, or stops the current function. It allows
you to exit from a field or a screen without accepting the information entered.
The Enter key is labeled Enter, but sometimes labeled ↵ on older keyboards. This manual
will refer to it as the ENTER key or as <Enter>. Enter accepts the information from whichever field the cursor is in, and moves the cursor to the next field.
The <Enter> key plays a critical role in Windows.
CURSOR CONTROL keys are the up, down, left and right arrows, as well as the keys
labeled Page Up, (or PgUp), Page Down, (or PgDn), Home, End, Insert, (or INS) and
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Delete, (or DEL). The arrow keys move the cursor or the highlight bar up, down, left and
right.
The PgUp & PgDn (Page Up & Page Down) keys work to move the highlight bar up and
down one full page of text, or to display a second data entry screen.
INS & DEL (INSERT & DELETE) keys toggles the keyboard between Insert and Overwrite
mode. When the keyboard is in Insert Mode, any character you type will be inserted at the
cursor and will push to the right characters to the right of the cursor. When the keyboard is
in Overwrite Mode, any character you type will be inserted at the cursor and will replace
whatever character was previously at the cursor.
When editing, the DEL key will delete the character at the cursor. When displaying a list,
the DEL key will delete the record highlighted by the highlight bar.
The HOME and END keys move the cursor to the beginning of the field the cursor is in
currently. Similarly, the END key will move the cursor to the end of the text in the highlighted field.
The Backspace key is always located in the upper right hand corner of the alphabetic
portion of the keyboard. It may be labeled Backspace, BkSpc or even just have a leftpointing arrow. (Don’t confuse this with the left-arrow cursor control key.) The back space
key deletes any character to the left of the cursor.
FUNCTION keys are usually arrayed across the top and/or side of the keyboard. They’re
labeled F1, F2, F3 and so on. Function keys are so named because their function changes
from program to program and even within a single program. Some function keys work
everywhere, and always do the same thing:
There are several additional special keys available to control other operations on the
keyboard. Each of these special commands uses an Alt key or Ctrl key sequence. To use
these commands the ALT key or Ctrl key must be held down while simultaneously pressing
the second key.
When we want you to press an Alt key combination, we’ll denote the keystrokes like this:
<Alt><KEY combination> or <Ctrl><KEY combination>.
For instance, if we want you to press the ALT key and the “T” key at the same time, we’ll
designate it like this: <Alt><T>.

Keyboard Conventions
Whenever we want you to enter text, the text will be between [brackets]. Any keys we want
you to press will be between <these symbols>, also known as “greater than” and “less than”
symbols.
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Thus, if we want you to type the word WIN, you’ll see our instruction like so:
Type [WIN].
That means type the word WIN, but don’t type the word “type” and don’t type the brackets
or the period.
When we want you to press or click an icon, we’ll say Click <Icon>. For example, if we
want you to press the OK icon, you’ll see our instruction:
Click <OK>.
When we say click <OK>, it means we want you to select the button within the < >
symbols. Generally, a click will be one click, however many times you will need to double
click the item. You’ll double click, for example, when you are starting a program. This
manual will not differentiate between a single click and double click.
When we want you to select a menu item, you’ll see our instruction to select:
First Item | Sub Item | 3rd item
This means to select the First Item, then the Sub Item, and then the 3rd item. Menus are
displayed at the top of every screen. Once you have selected the First Item, another menu
is displayed. We want you to select the Sub Item from the next screen that is displayed.
When you select the Sub Item, another screen will appear. We want you to select the 3rd
item from this screen. In this manner, we will lead you through every menu selection or
keystroke we want you to make.
For example, when we say select Configure | Site | Check-in, we mean to start the Configure module, then select Site from the menu, then select Check-in from the next menu that
is displayed. See the section titled “menu conventions” for more details.

Mouse
It’s easy to navigate the menus with a mouse.
When you place the mouse cursor on any item on a pulldown menu, you may CLICK to
select it. Its associated menu box appears to allow selection of another menu item within
the menu.
When you CLICK the mouse on a BUTTON, it immediately executes.
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Pulldown menus were designed to be used with a mouse, which is why mouse use is so
direct and simple.

Using “hot” keys
There are also “hot” keys associated with each menu item. Each menu item has one
highlighted letter, which identifies its “hot” key.
Most pull-down menu selections and Icons have one letter underlined, usually the first letter,
but not necessarily. You select your desired choice by holding down the ALT key while
typing the letter on your keyboard that corresponds with the underlined letter in the menu.

Touchscreen
The touchscreen is used to operate the system without a mouse. With a touchscreen, instead
of using the mouse, you’ll just touch the screen. This is the quickest, easiest method to
operate the software.
A touchscreen will simplify the operation of the system, and reduce training time.
The touchscreen works in a fashion similar to the mouse. You touch the screen instead of
using the mouse. When you lift your finger from the screen, the cursor is positioned to
where your finger was pointing. The contact point is where your finger is when you
removed it from the screen.
To demonstrate this selection process, place your finger on the screen, and without removing it from the screen surface, move your finger along the screen. You’ll see the arrow icon
move along with your finger. When you remove your finger from the screen surface, the
mouse will be positioned where you removed your finger.

Calibration
Calibration defines the dimensions of the image area of the screen, determines the edges of
the screen image, and locates the center of the touch screen. You may need to calibrate the
touch screen if the cursor does not follow the movement of your finger, or if you adjust the
size (resolution) of the screen image. When you calibrate the touch screen, the controller
stores the touch points. You do not need to calibrate the touch screen each time you start
your system.

To Calibrate the Touch Screen:
1. Open the Touch Screen control panel.
2. Select the Calibrate button. A calibration target appears in various corners of your screen.
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3. Touch the target as instructed on the screen. When you touch the target, you’ll find that you
can calibrate and use the system more easily if you aim just over your fingernail.
4. Perform the calibration in the position (sitting or standing) you expect to use the touch
screen.
5. Touch the calibration targets slowly and accurately.
6. After you touch all of the targets, a dialog box prompts you to test the calibration by moving
the cursor with your finger.

Testing the Calibration:
1. Touch the center of the screen and check that the cursor is located underneath your finger.
2. Drag your finger across the screen and check that the cursor follows your movements.
3. Move your finger to each corner and edge of the screen. Check that the cursor follows your
finger and reaches the edges of the screen image.
4. If you cannot reach the edges of the image or the cursor is not located underneath your
finger, select No and re-calibrate the screen.

Menus and Icons
The Aphelion software system operates using the Windows conventions. The advantage of
this type of interface is that the common look and operation of software programs using this
interface allow you to quickly navigate through other programs using the same type of
interface.
Pulldown menus and the mouse are supported as the primary menu system and provide the
access method to various portions of the program.
Controlling the system is accomplished via two primary methods. The first uses pull-down
menus. A pull down menu is a display containing various selections. These selections are
located along the top of the screen, or in a pop-up window. They are called pulldown menus
because subsequent selections appear to drop down from your choice on the menu.
The second type of control procedure is called an ACTION BUTTON. We’ll call this type
of menu an ICON in this manual. The default icon appears on the screen with a small
“shadow” behind it.
These icons are usually used to perform a simple action, or are used in conjunction with
scrolling data windows where the up/down arrow keys scroll a browser. Each icon has a
label. We’ll refer to each icon in this manual by placing its name within brackets < >.
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MENU CONVENTIONS
Throughout this manual, we will reference various areas of the program. To facilitate your
navigation through the different menus, we will represent subsequent menu selections with
this | symbol.
For example, the sequence of keystrokes used to view the check-in reports while in the
reports module is represented as follows: Reports | Members | Check-in
In English, this means Select the “Reports” option from the menu selection bar, then select
“Members” from the list that appears, then find and select the “Check-in” menu selection.

Software Standards
Aphelion software maintains consistency by following standard procedures no matter what
module you may be working in.

MODIFYING RECORDS
Many types of information are displayed in scrolling “browse” windows. These windows
provide a method to view records, such as members, or to view lists of items, such as
member categories.
To view an existing record, double click the item with the mouse. Or, highlight the item
with the block cursor using the
up/down arrow keys then click
the <CHANGE > icon to view
the record.
To make changes to a record, view the record, then position the cursor to the field you want
to change. Make the desired changes.
To insert a new item into a browse window, use the menu selections. There are several
methods to add a new record. Usually, you’ll click the <ADD> icon.
To delete a highlighted item from a browse window, press the Delete key, or alternately,
click on the <DELETE> icon. You will be prompted before deletion to see if you really
want to delete the record.
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STANDARD ICONS
There are some keystroke and screen conventions used throughout the program. Following
is an overview of these icons.

KEYBOARD ICON
This button is used when you are using a touchscreen, and do not have access to a keyboard.
This KEYBOARD Icon will pop up a numeric or alphanumeric keyboard so you can enter
information into the system.

CARD DECK ICON
This icon directs the software to display the Pop-Up windows containing database information. The pop-up windows allow the user to view information in the databases without
leaving the current screen. This is useful when obtaining ID numbers for members or
checking on the price or availability of a retail product. The information available in these
windows can be used to answer many questions during the transaction.
The Pop-Up window can be used to view information in the member, inventory, and
employee databases. You can search for a name of the member, employee, or product to be
displayed. This process initiates a search to find the name entered by the user. Enter as
many or as few characters as desired. However the more characters entered, the more
reliable the search will be. When you need additional information, press INFO (the card
deck icon). Here are some examples of the INFO key in action:

•

While checking-in members, you may need to find a member name.

•

While selling a ProShop item, you want to find the item number.

•

A member inquires about his account from the front desk.

ACCOUNTS ICON
This icon is used throughout the program to provide information on member account history
and payments.
If you select the account key, you’ll get a snapshot of the member account value and the
account transactions. The “Value of Account” field represents the current total dollar value
of the members account. This means the total of all debits posted on the members account
minus any credit payments. The “Future payments” field reflects the dollar value of all
payments expected, or due, in the future. In other words, this field shows the value of the
remaining payments to be made by the member.
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All credits and debits for each member currently on record can be examined through the
account history browser. Refer to the Billing section, On Account, for additional information.

PICTURE
This icon is used to take a video image of the member. The image is used during the checkin process to visually identify the member to be sure the member is the same person that
purchased the membership.

CHOOSE FROM LIST
This icon is always positioned to the right of an entry field. This icon is shown when you
are entering information into an entry field, or have an option to choose information from a
list box. When you select the down arrow, a drop down a list of choices will appear for you
to make a selection.

SELECT
When you choose the Select icon, the choice that you have highlighted with the cursor will
be selected. This icon is available on many browse windows, and will appear, for example,
when searching for a member’s ID during check-in.

CANCEL
The Cancel icon will allow you to continue without making a selection. This is useful if
you have chosen the wrong function, or wish to exit without making a selection or changes.

INFO
The Info icon provides additional information about the highlighted choice. While in the
check-in module, this icon provides access to additional information screens that will
provide account details, check-in history, family members, scheduled appointments,
personal training sessions, and more.

Program Group
This section will describe the various program modules, how they work together, and how to
use the modules to best manage your club. Aphelion software is designed to automate just
about every area of your club. Just as good exercise machines are designed to isolate
muscle groups, we think good software should be just as focused. That’s why our software
is designed to isolate the requirements of different areas of your club. We’ve designed the
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system to match the floorplan of
your facility, with specially designed software modules for each
area.
These specialized modules are
provided for the front counter,
ProShop, the sales office, the
manager, and even the workout
floor. The software provides
focused operation for the specialized requirements of these areas.
The Program Group contains the
icons that will run the various
aspects of the program. This
program group is provided automatically when you install the
program. The program group
collects all of the icons needed to
run the system and associated
utilities.
The following sections will describe the various selections in turn. This section can be used
as a reference section to gather more information about the program selections.

Front Counter
The Front Counter module handles all of the requirements for the front counter. The front
desk system includes ProShop sales, member check-in, employee timeclock, scheduling,
and class tracking.
The Front Counter module is used to check-in members and sell ProShop items. The
optional scheduling capability can be used to make appointments and provide visual
scheduling calendars. The optional timeclock function can be used as an employee
timeclock, to clock in (and out) employees. Class tracking is used to enroll members in
classes and to track which classes the members are using.
When you check-in members, the system will alert you to every membership problem,
including when the member owes money, birthdays, status problems, contract expired or
frozen, and many others - and the information is always current. The program will monitor
Peak and Off-Peak memberships, track class attendance, and log activity usage. The system
provides easy enforcement of entry rules.
The check-in system will display a high quality color image of your members using the
built-in video imaging system. You can check each member into the facility, specific
activity, or class. And, you can even count down visits for a trainer or the nursery. This

25

count down punchcard ability will track and count down the number of times a member uses
an activity within the club.
Use the ProShop to sell your inventory items, open the cash drawer, obtain credit card
authorization, and print a receipt. The system will automatically monitor par levels, sales
performance, profit margins and print a cash reconciliation for each shift. If you have the
touchscreen monitor, the quick key buttons make it extraordinarily fast and easy to sell your
most common items.
The front counter system provides scheduling calendars. These calendars allow you to
schedule your managers, trainers, courts, or any item you desire. You can setup an unlimited number of calendars and design the start and stop times. Use the system to print
calendars of events, activities, or employee schedules with the touch of a key.

Marketing
The marketing system is a full featured contact management system. You can track every
guest or prospect, and create follow-up and call reports for your salespeople. You can
improve the sales performance of your salespeople with call back lists and performance
reports.
This module is used to track and provide follow-up for Guests and Prospects. Use this
module in the Sales office to record the notes and next action for all your sales calls, or run
it at another station to keep up with guests and prospects while performing other tasks.

Sales
The contract sales module is designed to provide a tool to the salespeople that will help
close more sales. Using this module, your salespeople can sell membership contracts that
are error free. The member’s signature is captured at the time of sale - meaning the entire
contract can be stored electronically, reducing your paper storage. The system will print a
standard membership contract for each type of membership plan.
At the salesperson level, this module provides “what if” screens with pricing options, and
automatically provides proration information. When the sale is complete, a laser printed
custom contract is produced. The information that is entered in the Contract module is
automatically moved into the member database when a membership contract is approved.

Data Entry
Since a lot of the information regarding members is automatically entered when you sell a
Contract, this area is primarily used to enter information for ProShop items, employees,
classes, and schedules. Full membership information is also contained in the data entry
area. This module is used to enter a new member, view or change existing members, or
manage the inventory, class, and employee information that is in the program.
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Configuration
This module will allow the user to customize the system exactly to the needs of the facility.
Use this module to enter information that is specific for the location. For example, the
Configure module will allow you to enter local tax rates, your club name, create member
categories, and set up income accounts. You will run the Configure module initially when
you install the system. Thereafter, run Configure whenever you need to change or add a new
item.

Billing
This module is designed to allow you to automatically bill your members. It will produce a
specially formatted NACHA file to send to your bank or clearing house for EFT transactions, produce statements, electronic credit card transactions, or printed bank drafts. Use
this module to bill your members for monthly fees and items that were charged in the
ProShop.

Collections
This module is used in conjunction with the billing module. It will allow you to efficiently
manage delinquent members and collect dues in a timely fashion through a systematic
follow-up plan. When members become delinquent in their membership dues or ProShop
account, they can be tagged to be placed into the Collection module. The Collection
module will allow you to set follow-up dates, produce call back reports, and prioritize the
members for collection.

Utilities
Utilities executes a file utility program for managing the status of the files. This program
can be used to enhance system performance as well as clear database errors that result from
hardware irregularities. Several of the primary capabilities are to compress or rebuild your
data files, which will compress the data files into a compact form for faster operation by
removing unused space in the database files. Additionally, you can execute test utilities to
verify the operation of your hardware, such as the cashdrawer and POS display pole. Access
Utilities from the Start button.
The system can be configured via the telephone if you wish to add program options such as
additional workstations on the network. This capability is included in the Utility module as
well.

Workout Partner
The workout partner module is used to track member workouts. Members can use the
system to print out each days daily workout. A list of each exercise along with the number
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of sets/reps is displayed. Once the workout is complete, the member records their workout
into the system so the information can be tracked and graphed. This system can be used
with a touchscreen monitor, and will replace member workout cards with an automated
system. One advantage of electronically monitoring a member’s workout is that graphs can
show workout progress in a highly visual and easily printed form.

Configuring the System
You must Configure the system before you enter data or use the system. To configure the
program, select Configure from the Aphelion Club Management Program Group.
Before the system is ready for use, the system must be configured for your health club’s
particular requirements. This includes configuring for items such as member and inventory
categories, password protection, and hardware configuration. NOT ALL FEATURES WILL
WORK PROPERLY UNTIL THE SYSTEM IS CONFIGURED. For example, you will
need to set up the inventory categories before entering the inventory products into the
database, and you will need to setup Activities before you can restrict the type of activities a
member can attend.
The Configure section of this manual provides detailed instructions on how to setup the
program. For detailed information on all of the Configure options, reference the Configuration section, in this manual.

Create New Data Files
The program will allow you to maintain two sets of data. The first is your “live” data to be
used to manage the club. The second is a “training” data set. You can switch to the Training data when you want to train your employees. Any transactions or changes you make
will not affect your live data.
Be sure you are in the “live” data set when operating the system. Once running, you can
copy the live data to the training dataset so you can practice.

Data Sets
Several unique sets of data can be stored on your computer. These different sets of data can
be used at different times, depending on your requirements. For example, you may wish to
create a set of data that will be used to train new employees. This training data can be used
to show new employees how to work the system, without impacting your club data. When
you are finished training, you can switch back to the club’s regular data directory.
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If you have multiple clubs, you may wish to create a dataset for each club. Using this
technique, you can view each club’s data independently.
To switch between different datasets select File | Datasets from the menu of any module. A
screen will be presented that will allow you to choose which set of data you want to use.
The dataset that you are using is displayed at the top of every screen. This will insure you
don’t inadvertently utilize and conduct business using the wrong set of data.

Login Security

Every module can be protected to insure only the appropriate employees have access to the
system. The login security can be implemented in a variety of methods, depending on the
type of club. The system can be configured to operate with little access control, or with
maximum control, and at various stages between. You should analyze your club to determine how much access control you need. Don’t implement more than you need, as you’ll
constantly be typing in access codes.
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The security is implemented at the employee level. Each employee is assigned a password,
along with access to various areas of the system. When an employee logs-in by typing his
security code, the system will only allow access to those screens, areas, and modules for
which he has privileges. Since access control is at an employee level, every employee can
have independent access restrictions.
For those modules where this capability is enabled, you will be asked to enter a login ID
whenever you start one of the modules. (Access control can be turned off at the module
level). If you have the appropriate access, you will be allowed to continue.
Depending on your access privileges, many screens within the modules may not be available
to you. Some may be shown with a simplified view, preventing you from accessing detail
views or more capability. Alternately, a capability may be shown on the screen, but you
may not be able to modify it.
We suggest you learn to use the system with the security off, thus allowing access to all
screens. Once you understand the system, you may wish to prevent others from viewing or
accessing some information, at which point it would be appropriate to enable the access
controls.
As a manager, you may want to have access to all capabilities. For a front counter employee, you may wish to restrict access to all but the simplest functions. Since many
screens change based on access privileges, the front counter personnel will operate the
system with limited, simpler screens, while the manager will have access to more detailed
screens.
Setting security and enabling access control is discussed elsewhere in this manual.

30

SOFTWARE CONFIGURATION
The Configuration module allows you to
set up your system to conform to your
club. Configurable selections, menus,
and windows are used throughout the
program. These selections, such as
membership types, billing cycles, etc.,
are designed so that the system can use
terms that are familiar to you. Others,
such as tax rate, are set up to allow the
program to properly compute local taxes.
To start the Configuration module, select
the Configuration option from the
Program Group.
Each new user is strongly advised to run Configuration before entering any data in the
program. Selections that you set up one time in the Configuration module will be used over
and over again in the main program.
Many features in the software can be configured with user defined items, or are affected by
these settings. Examples include the membership types, billing cycles, schedules, additional member status selections, services, inventory categories or departments, credit card
types, prospect referral selections, prospect to-do lists, and others.

Configuration Menus
When performing the initial setup for your club, you should systematically view each
configuration option to be sure that you setup the options to conform to your club requirements. Go to each menu item in turn, view the selections or information that is present, and
make changes so that it represents your club.
Most of the fields are defaulted in the initial setup. These defaults are provided to give you
an idea of the type of information to include and because it is easier to change information
than to develop it from scratch.
Once you have made your initial selection from the menu, a secondary menu window will
appear with specific information screens. Enter the requested information into the appropriate fields.
You will either enter the required information or select from predefined options. In many
cases, you’ll indicate your choice by placing a checkmark next to an item.
If you wish to leave the configuration screen you are presently editing, press the <ESC>
key. If you leave the selected configuration screen in this manner, the program will disregard your changes to this particular configuration option.
The following sections describe some of the Configuration options.
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FILE
The files menu is primarily used to setup the default report printer that will be used with the
program.
A receipt printer can be physically attached to any one of the parallel ports on the computer,
or on any computer on the network. (The receipt printer is setup under the Site menu).
If, in addition to your receipt printer, you have a laser printer, you can set which printer port
to use when printing.
Select the “PRINT SETUP” to set the printer you are using with the system.
The system will use the default Windows printer unless you setup a different printer using
the “Specific Printer” option.
The “PRINTER SETTINGS” option can be selected to designate printer connection information as well as paper form selection.

STATION
This configuration option allows the user to
specify the options to be used by each station
running the program. Highlight the “STATION”
option from the menu to make the hardware
choices for your system.

Printer Settings
The program can be configured to your requirements when printing receipts, invoices, and
mailing labels.
The default for printing a ProShop receipt can be set to “on” or “off” (Receipt Printing). If
set to “on”, the software will assume you want to print a receipt unless you turn it off at the
time of sale. If set to “off”, the receipt will not be printed at the time of sale unless you
override the default.
Choose the type of forms you are using for Invoices (Invoice form). The “Plain Paper” receipt
is selected for laser printers using plain white paper. The program will print a standard form
on the plain paper that includes all transaction information. If you are using your letterhead
for Statements, select the format for letterhead. If you are using preprinted forms, select the
“Form” options.
For both letterhead and form options, you should print a sample on plain white paper to view
the output to decide which format to use.
The printed receipt that is produced at the Point of Sale (Receipt form) can be selected in a
similar manner. The receipt can be printed on plain white paper using a laser printer, on a
pre-designed form, or on a 3" strip printer. Of these options, the strip printer is preferred. If
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you select the Strip printer, several additional options are available to control the printed
receipt.
When using the Strip printer, you can setup a message that will print at the end of every
receipt (Message at receipt end). This message can be used as a thank-you note, or to
describe club promotions.
Additionally, you can add a message that prints periodically (Periodic message). The
purpose of this message is to offer incentives to your members for requesting a receipt for
ProShop purchases. If your members ask for a receipt, the ProShop purchases tend to get
entered into the system, thus minimizing theft by employees. This system will help insure
the club staff ring-up of ProShop purchases. You can use this message to provide a gift for
the “winning” receipt. A typical message might be to provide a free T-shirt or tanning
session. You can set the periodic message to print as often as you like, from every time to
once every 999 times. Set this item to 0 if you want to disable this feature.

To Configure Printer Settings:
1.

In the Configuration Module select Station > Printer Settings.

2.

Click on the “General” tab.

3.

Choose “Receipt Printer” default setting. (on or off)

4.

Choose “Receipt Form” (plain paper, form, or strip)

5.

Choose “Statement” form (plain paper, letterhead, or form)

6.

Click on “Strip Receipt” tab.

7.

Enter message to appear on receipt if desired.

8.

Enter periodic message on receipt with repeat intervals if desired.

9.

Click <OK>.
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Station Hardware
The “STATION HARDWARE” selection is used to select the port the cash drawer and
turnstile are connected to.
If you are using a combination cashdrawer and receipt printer, you should set the
cashdrawer option to use the receipt port. The default character is ASCII 28, which should
work for most models of cashdrawers.
To Configure Station Hardware:
1.

In the Configuration Module select Station > Hardware

2.

Choose options for your cashdrawer, turnstile, and signature capture pad if available.

3.

Set receipt type cash drawer default string to ASCII 28. (Enclose lower ascii characters with
carets; e.g. <28>)

4.

Click <OK>.

Paths and files
Paths are directory “maps” used by computers to locate desired data files. It is necessary to
define these paths for specific functions of the Fitness Manager.
Path to Member Pictures is used to locate
the folder containing all member picture
files attached to member records.
Path to Image and icon files for POS and
services display is used to locate the
folder containing all icons used to
represent member services attached to
member records and inventory departments/items used as “quick buttons” in the
POS.
Style file for member form letters locates
the source rich text file (.RTF) that
contains the output formatting of all list
tags (status history, interests, services) available in form letter processing.
To Configure Paths and Files:
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1.

From the Configuration Module select Station > Paths and Files.

2.

Press the file icon to choose the path to the appropriate picture and/or letter.

3.

Click <OK>.

Check-in Settings
“CHECK-IN SETTINGS” provides a method to set the initial start-up mode of the check-in
screen. Set “unattended check-in” if you do not wish to have the system pause when a
member in bad standing is checked in. This is useful if the front counter is not attended, or
a barcode reader is used to check members
in, as the system will not stop when a
member in bad standing is encountered.
Select “attended check-in” for this item if
you manually check-in your members, or if
there is an attendant at the front counter.
Select the “monitored” mode so that front
counter employees can attend to other
business while listening for any alert
messages which would require their attention. (A report can be printed later in the day
that will display those members that should
not have checked-in.)
The Attended, Unattended, or Monitored
modes are default choices only, and you can
override these selections from the Check-in
screen.
The check-in options allow you to default
the way the check-in screen operates. If you want to track which activity a member uses
when he checks-in, turn on “always prompt for activity” selection. This feature allows
tracking member check-ins on an activity basis. If you wish to always check-in to a class,
turn on the “always prompt for classes” selection.
(Check-in to a particular activity can be restricted by member type. For each member type,
any combination of activities can be selected as an allowed entry. If a member is not
assigned to an allowable activity, his check-in is denied. This option is setup under the
Member menu selection).
If tracking is disabled, all members are checked into the “General Facilities” area.
If tracking is enabled, when a member is checked in with the program operating in attended
mode, the complete set of activities are displayed in a selection window. “Allowed”
activities, based on the individual’s membership type, are displayed. If a restricted activity
is selected, the operator is alerted and must decide whether to continue the check-in. The
configuration program lets the default activity be selected for each terminal. In attended
check-in mode this is the activity that will be initially highlighted in the selection window.
In unattended check-in mode, the default activity selected for that station is what the
member will be checked into. This “default” activity allows a club with multiple terminals
to better control entry to areas of the facility. For instance, if a turnstile is set up by the pool
area, the activity tracking can be set up to restrict members from entering that area.
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If desired, you can store your member pictures in an area other than the default location
directory (Path to member pictures). This is helpful if you are running low on disk space
because you can store the pictures on another drive.
When you enter a new guest or prospect from the Front Counter module, you can print a
temporary membership card, club rules, coupons for the ProShop, etc. The program works
in conjunction with Microsoft Word to create the document that will be printed. The path
and file name of the file that is to be printed from the “add a guest” screen is defined in the
Front Counter Guest letter selection area.
To Configure Station Check-in:
1.

In the Configuration Module select Station > Check-in settings.

2.

Choose initial check-in mode (Attended, Unattended, or Monitored).

3.

Choose a default check-in type.

4.

Choose check-in option(s).

5.

Choose a default check-in option from the pull-down arrow.

6.

Click <OK>

Credit Card Settings
If you are using IC Verify to send credit card transactions directly from the POS screen, you
should configure the system to conform to the IC Verify settings. Refer to your IC Verify
manual to obtain the correct settings for this area.
To Set POS Credit Card Settings:
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1.

In the Configuration Module select Station > POS Credit Card Settings

2.

Enter IC Verify settings

3.

Click <OK>.

Visual Card Reader
The visual card reader is a unique device that can write a dynamically changing message on
the member’s ID card whenever it is used. The visual card reader is a membership card
reader and writer. The message that is written to the member’s ID card is configurable, and
can display a variety of messages.
As with other POS peripheral devices, the port that the device uses can be selected (Serial
Port). Since this device will write to a membership card, the font size can also be defined
(Font Size). You should experiment with the different font sizes until you find the look that
you like.
The check-in display message screen will allow you to define the messages that are written
to the membership card when it is used.
Since there are up to 3 lines that are available for a message, the configure module allows
you to setup the messages in this area.
For the 1st and 3rd lines, you have the option of writing a software generated message,
rather than your own defined message. Line 1, if selected, will print the number of points
the member has. Points are earned for check-ins, and other defined promotions. Line 3 can
be used to print membership alerts instead of the message.

Visual Card Reader Settings:
1.

In the Configuration Module, select Station > Visual Card Reader.

2.

Select the appropriate serial port and font size.

3.

Click on “Check-in display message” tab.

4.

Enter appropriate line messages.

5.

Click <OK>.
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Serial Port Card Reader
Requires an available serial port on the computer and can be a card swipe or laser barcode
reader. The serial port card reader is most commonly used in situations where a club wishes
to use one computer for both check-in and POS. A laser barcode reader would be attached
through the keyboard (keyboard interface) for POS transactions while, at the same time, the
serial port card reader would be used for check-in.

To Set Serial Port Card Reader Settings:
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1.

In the Configuration module, select Station > Serial Port Card Reader.

2.

Select the appropriate COM Port, Data Rate, Data Bits, and Paring as necessary.

3.

Click <OK>.

POS Pole Settings
The system can utilize a standard POS display. This type of device has a display that is
visible by the member. The display is about 3' high, and is contained on a pole that the
member can view as the POS transaction is conducted. The pole shows progress during
POS transactions or messages during the check-in process.
To utilize a POS display pole, select the serial port that you have the device connected to.
Also, choose whether you want the display to be active on check-in, during POS transactions, or both.
The messages that are shown on the display can be selected. There are two lines available
for your message. The POS pole can display different messages for unattended and attended
check-in modes. Enter the message in the appropriate area.
The “quiet” mode is the message that appears when there has been no activity on the system
for several moments. This should be a message such as “Welcome to Club Aphelion”, or
“Family memberships 1/2 price”.

To Set POS Pole Settings:
1.

In the Configuration Module select Station > POS Pole Settings from the menu bar.

2.

Choose a serial port and usage location.

3.

Click on the “Messages” tab and enter appropriate check-in messages.

4.

Click <OK>.
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Sound Settings
The program will play sounds for
several types of events during the
check-in and POS process. The
sounds menu is used to select
which sounds are played for these
events. Since the program will
operate in Attended and Unattended modes, you have the option
of providing different sounds for
each type of check-in. For example, if the system is Attended,
the sounds may be short messages
such as “Check Status”. For the
Unattended mode, you may wish to
play a longer message, such as “Please see the Manager”.
To have the system play a message during one of the selected events, put the full path and
sound file name in the appropriate field. You can listen to the message by clicking on the
speaker icon located next to the file name.
For your convenience, Aphelion has recorded messages that are available for different types
of events.
Optionally, you may wish to record your own messages.
The following messages are examples of the sound files that are available from Aphelion:

•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Welcome!
Welcome! Have a nice workout.
Enjoy your workout.
Please re-scan your card.
Please see the manager.
STOP!
Happy Birthday.
Member has an Account Balance.
Member has an Expired Membership.
Member has a message.
Member has a Frozen Account.
Member has a Terminated membership.
Member’s Contract expires soon.
Member has Restricted access.
Member has scheduled activity.
Thank you.

Additionally, there are several derivatives of the above sounds that are shorter, which can be
used in the Attended mode.
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SITE
Your facility name, bank information,
database entry defaults, and member
billing defaults information are entered
in this Configuration menu selection.

Clubs
If you are operating a company with multiple clubs, this configuration option allows you to
specify the names of the clubs, along with tax rates and EFT information.
The club information is used at the corporate office to conduct member billing. It is also
used within the clubs to define which clubs receive data and to select which information is
sent to the remote sites.
The specific information about each club is available when you press the <Change> icon.
Since several of your clubs may be similar, you can copy a club when setting up the system
rather than entering the information again. If you use the copy command, you will need to
change the club name in the copy, and any information that is different at the new club.
The ID Banner field is used to print a header on the membership cards, if you are using this
option. Note that the field will allow you to enter up to 30 characters. The local tax rate is
entered in this section.
Up to two local tax rates can be entered and will automatically calculate tax on items sold
through the ProShop module. If your dues payments are taxable, select this option. Tax
will be computed for each member dues payment and added to the monthly total. (Tax rate
number 1 is used for dues payments.) Entering the tax rate here will allow you to quickly
modify the pricing of your recurring dues payments should the local tax rate change.
Each fitness club that you operate will be entered into the system separately. If you have
more than one site, repeat steps 1-10 for each club.
To Configure Club Sites
1.

From the menu bar select Site > Clubs

2.

Click <ADD>

3.

Enter club information (banner prints as header for membership cards).

4.

Click “Taxes” tab at the top of screen.

5.

Enter tax rates.

6.

Click “EFT Settings” tab at the top of screen. This screen will change according to the EFT
format selected in Site > Site Info > EFT Format .

7.

Enter your club’s banking information.

8.

Click “Credit Card Merchant IDs” tab at the top of screen. If you select TELECHECK as your
combined credit card/bank draft file format, in Site > Site Information > Billing, a box will
appear to input your 4-digit TELECHECK account number.

9.

Enter your club’s credit card information. (This list of credit cards can be changed under
the file option Accounting > Credit Cards)

10. Click <OK> when all information is entered..
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Site Information
Information about the site is contained in the Site Information screen of the Configuration
module. The screen is divided into seven tabs (General Information, ProShop, Check-in,
Billing, EFT Format, and Credit Cards) which allow different configurations for each site.
General Information Tab
Choose the site you wish to configure on the General Info tab by using the pull-down arrow.
If you are using existing membership cards that have leading 0’s in the ID number, you
should turn on the option to treat the ID as numeric. This will allow the program to utilize
your existing ID cards. If you do not have the older type ID cards, leave this option turned
“off”.
Since some clubs limit the number of times a member may FREEZE his membership, the
system allows you to preset the member database with a given number of THAWs. You set
the default number under the THAW configuration option. Each time a Freeze is used, the
number of Thaws available is decremented. When 0 Thaws are available, the program will
not allow you to Freeze a member account without an override.
Since member notes can be entered at the Front Counter, a note action is also created when
the note is created. To insure consistency in the type of note action that is selected by front
counter personnel in Configuration choose Site > Site Info > General Tab to default the
type of note created.
Secure employee passwords by checking the box “Mask Employee Passwords”. Astericks
will appear in the password field when editing employee records.

ProShop Tab
The ProShop screen allows you to define certain options for the ProShop operations. If you
decide that you must have an employee name assigned with each ProShop transaction,
select the option that requires that the “salesperson must be set to complete invoice”. If you
have several employees at the ProShop terminal, you may want the name to reset after each
transaction, thus forcing the name to be entered each time. While taking more time, this
will insure that each transaction is assigned to the proper employee.
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Many times you will allow a member to purchase items from the ProShop On Account.
When purchasing items a charge is created in the member’s account. The program has
flexibility when determining the due date of the charge. If you wish to provide a certain
number of days until the charge is due, select the “set ahead by specified days” option.
Then set the number of “days ahead” that the charge will be due.
If you conduct billing on a certain day of the month, such as the 1st, you may want to make
all charges due on a certain day. If so, select the “based on day of the month” option, then
select the day of the month the charges will be due.

Check-in Tab
The check-in tab allows you to configure two fields displayed on the check-in screen. Use
the pull-down arrows to select a preconfigured item from the lists.
To configure the Check-in tab:
1.

In the Configuration module, select Site > Site Information

2.

Select the “Check-in” tab

3.

Use the drop down menus to select the desired fields.

Billing Tab
The billing tab allows you to choose between processing your own checks and credit cards,
or a service company that combines the processing of checks and credit cards. Select
“None” if you are going to process checks and credit cards yourself. EFT format information can be obtained from your bank. Your credit card processor can tell you the format
required for credit card information. If you are planning to use a combined credit card/bank
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draft service company, select either CheckFree, TeleCheck, or Toronto Dominion Enterprise
(for Canadian facilities). You will also need to select the type of “Member Identifier to
include in billing export files”. Select either Barcode ID, Agreement Number, or Data
Exchange ID. The Barcode ID is used most often; however, since your third-party processor
determines this information, ask them which member identifier they require. Telecheck
users often use the agreement number.

CheckFree
This billing format can include entries for both credit card and bank drafts within a single
file.
Setup instructions
Before billing, general setup must be completed with the Configuration module.
Under the Site/Site information menu item, on the Billing tab:
1.

Set the Combined credit card/bank draft file format to CheckFree

2.

Specify the Member Identifier to Include in billing export files to the appropriate
value. The exported value should be unique for each customer and should not
change for that member. We recommend the “Data Exchange ID”, but you must be
sure that each member has a value set for this field.

Under the Site/Clubs menu, edit each club record you have set up and on the EFT Settings
tab:
1.

Place your company name in the Company Name field (this will value appear in the
export under the batch control “5” record, from columns 5 to 20)

2.

Place your CheckFree client ID in the Your IRS employer number field (batch control
header “5” record, columns 41 to 50; also batch control “8” footer record, columns
45 to 54)

The billing program produces a single transaction detail “6” record for each member billed.
It also produces an address verification “7” record for each member billed.

EFT Tab
The EFT tab is used to configure the appropriate Electronic Funds Transfer format. The US
format is the default setting. Since EFT file formats are federally regulated, there is only one
format choice for facilities operating in the U.S. This format is called the NACHA file format.
The Aphelion software also supports the Canadian banking file formats. Canadian clubs
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have several options. If you operate your club in Canada, check with your bank to determine
which EFT format your bank uses. The options at the bottom of the screen change depending
on which file format you choose. “Basic payment transaction code” is an option only
available with Canadian--Royal Bank Standard. “Transaction Type” is only an option for
Canadian--CIBC; Canadian--Toronto Dominion; Canadian--Bank of Montreal; and New
Zealand--DeskBank. Check the “Include Club Deposit” box if you want to include your
deposit in the EFT file. Typically, clubs want to have their deposits included in the EFT file.
If this is the first time to bill customers, the batch number will be “1”. The software will
assign batch numbers sequentially thereafter. If you have already been billing customers, ask
your bank for the next batch number. Enter the “Basic Payment Transaction Code” or the
“Transaction Type” . These numbers are for Canadian clubs only and can be obtained from
your banking intitution.

Credit Card Tab
The information on the Credit Card tab is necessary if you are using a credit card processor. If
you are not using MDI, CIBC, or ICVerify, do not enter any information on this page. (MDI
is a credit card processing company. CIBC is a Canadian bank that will process credit cards.
ICVerify is a software program designed to interface with almost every credit card format. )
The “User/Terminal” name is a required field for MDI or CIBC. If you don’t know what the
user/terminal name is, call your credit card processor to obtain the appropriate value. If you
use ICVerify or CIBC, check the box next to “Place Settlement Command in Export File”.
The credit card processor determines the format you must use. Aphelion software supports
the following electronic credit card formats: Tele*Money, Transnet, MDI PC Batch, MAPP/
Global Retail PC, Personal Ticket Capture, Batch Pro, 4 Sure, and Fast Batch. If you bank
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utilizes one of these credit card processors, the program will format the credit card information in the format that can be read electronically and then send it directly to your bank.
Reports Tab
The Reports tab is used to configure the Member ID field printed on reports. Select either
Barcode number, Agreement number, or Data Exchange ID.

Check-in ID window
The Check-in ID window can be configured to display two defined fields of a member
record. The fields are displayed in the lower right corner of the ID section of the Front
Counter check-in screen.

Check-in Alerts
The Front Counter check-in module will alert when a member checks-in with one of several
pre-defined status. These include contract expiration, account balance, credit card is
expiring, locker expired, inactive member, and multiple check-in on the same day. These
alerts can be tailored to your club’s exact requirements via the Alerts screen.
The “advance Notify contract expiration” option allows you to set the number of days in
advance to be alerted when a membership expires. An alert will be displayed if a member
checks-in within the preset number of days of his expiration date. This feature can be used to
notify members when their contract will expire, and sell a new contract while they are using
the club.
Account balances can be provided with a minimum threshold so as not to below a minimum
level. This is useful to eliminate alerting a member with a very low balance. The system can
also provide a grace period before alerting that there is an account balance. This can be used
to provide a few day grace periods for the members to pay prior to a Front Counter alert.
If you are sending your credit card transactions electronically, and you have a magnetic
stripe reader, you should turn on the “alert for card swipe for credit card billed members”.
This will allow you to alert the Front Counter to swipe the member’s credit card. The
electronic information will be stored and sent with each transaction, thus qualifying for a
lower credit card rate.
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To Configure Check-in Alerts:
1.

In the Configuration Module, select Site > Check-in Alerts.

2.

Set contract expiration advance warning days.

3.

Set number for alerts on accounts over a specified dollar amount.

4.

Set alert for credit card expiration date.

5.

Click on the “Alerts 2” tab.

6.

Set locker expiration date alerts.

7.

Set alert for inactive member on check-in.

8.

Check box if you want to be alerted for multiple check-ins by a member on the
same day.

9.

Click <OK>.

Default Settings
The values you enter in “DEFAULT SETTINGS” are used when you add a new member or
prospect. The default settings screen is divided into two tabs: Values and Formatting. The
Values tab is used to enter the city, state, and zip code most commonly used by your members. Information entered here will automatically be entered into the new member database
entry screens. These defaults are used to save repetitive typing and speed data entry. The
Formatting tab sets the format for phone numbers, zip codes, and Social Security numbers.
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To Set Default Settings
1.

In the Configuration Module select Site > Default Settings from the menu bar.

2.

Enter the default values for member’s city, state, zip code, and area code.

3.

Click the “Formatting” tab.

4.

Choose the preferred formats for phone numbers, zip codes, and social security
numbers.

5.

Click <OK>.

Next Receipt Number
Receipt settings simply specify the next receipt number.
To Set Next Receipt Number:
1. In the Configuration Module select Site > Next Receipt number.
2. Enter receipt number.
3. Click <OK>.

Appointment Types
Define all available appointments for scheduling in the Front Counter module. Select
<Add> to add a new appointment type, or highlight an existing one and select <Change>.
Type in a description for the new appointment, and select a foreground and background
color scheme for easy identification.
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To Set Appointment Types:
1.

In the Configuration Module, select Site > Appointment Types from the file menu.

2.

Click <ADD>.

3.

Enter description for the appointment.

4.

Use the pull-down arrows to choose foreground & background colors.

5.

Click <OK>.
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ACCOUNTING
The accounting menu allows you to customize the program to meet your accounting and
reporting requirements.

Billing Categories
The Billing Catagories section of the Configuration module allows you to set up the various
billing partitions within the accounts receivable system. You may wish to set up a billing
catagory for membership dues, NSF/declines, and POS charges. This will allow you to
perform EFT billing for membership dues while creating mailed statements for ProShop
charges. In this case, you would set up a billing catagory for “Membership Dues” and one
for “ProShop” allowing you to bill separately for those charges. Set up the number of
billing partitions that are needed that will allow you to select the appropriate invoices during
your billing process.

Set Income/Expense Accounts
The Configuration menu contains a menu selection called “Income and Expense accounts”
that must be set up prior to using the software. These settings are important for establishing
income and expense accounts as well as default accounts for certain invoice processes.
The Set Accounts option allows you to establish income and expense accounts as well as the
GL code required for export to certain accounting packages.
An expense account should be set up to pay off delinquent, uncollectable member accounts,
such as “Bad Debt.” Another expense account is needed when providing a “discount” at the
time of payment, such as “Discount.” This is a general discount function used when applying payments to invoices and acts like a non-cash, pseudo-payment. This function will
“pay” on the invoice, but is charged to this expense account.
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Income accounts should be set up that partition the sales items for profit tracking. An
account for Membership Dues might be used to accumulate sales of member contracts. Other
income accounts should be established to separate sales of Pro Shop or Juice Bar items.
The retail inventory database consists of information such as description, price, and other
pertinent information regarding the retail item. It is often convenient to separate the retail
inventory into groups for purposes of business analysis. Aphelion allows the manager to
select names for the different inventory income accounts. In addition, the program will use
these income accounts for management business reports.
IMPORTANT: When an income account is changed, all of the database items with the old
income account name will be changed to the new income account name. For example, if you
should change the CLOTHING income account to MISC (miscellaneous) after you have set
many items to the CLOTHING income account, all of the CLOTHING products will become
MISC products. Clearly, you should exercise caution when changing income account
names.

Account Defaults
Although changeable at the time of sale, default values of the income account and billing
categories that apply to certain invoices can be established (Configuration > Accounting >
Account Defaults).
When using the Contracts module for selling membership contracts, an income account and
a billing category must be assigned to the sale. Select from the user-configured list of
income accounts the account that tracks membership sales (e.g. Membership Dues, or
similar). Also, select from the Billing category list to set the billing account for Contract
sales. A similar process is followed when creating an invoice in the member screen in the
Data Entry module.
If a sale using the POS is completed and placed on the member’s account, a billing category
must be specified for the sale. (This is necessary to separate billing activities between
member dues and POS charges.) Billing categories can be established for Pro Shop and/or
Juice Bar invoices to assist in on-account billing of items purchased in these areas of your
facility. The Billing categories are only used for identifying the proper invoices for billing
and are not credited with sales (payments received during billing are credited to the original
invoice items’ income accounts).
The POS system is capable of selling items that are not entered into the retail inventory
database. These items are considered “Miscellaneous” items. Sales from this type of item
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must be assigned an income account since the information is not stored elsewhere in the
computer. Establishing an income account such as “Misc.” is recommended for this purpose.
Credit Memos can be created against an existing invoice. The effect of a Credit Memo is to
reduce accrual sales by applying a negative invoice amount. Credit Memos can be used to
reduce (to zero if necessary) the amount of an invoice. Therefore, when a Credit Memo is
created, it must be attached to an existing invoice. This operation is performed from the
Account Status screen in Data Entry.
When creating the Credit Memo, an account must be specified. This account can either be an
income account or an expense account. An income account is used when the Credit Memo
reduces the amount of an invoice and you wish to subtract the credit amount from the income
account sales.
For instance, if a member owes $100.00 on his membership contract and you have agreed to
reduce it by $25.00. A Credit Memo can be issued with an income account of “Membership
Dues” specified. Accrual sales reports will reduce the amount in the income account for
Membership Dues by the $25.00 contained in the Credit Memo. Alternately, an expense
account, such as “Bad Debt,” can be used as a means of “paying off” uncollectable charges.
In this case, the amount reflected on the Credit Memo adds a positive value to the Bad Debt
account. The account attached to the Credit Memo is set at the time it is created; however,
the default value is set up in this configuration setting.
Credit Memos act on the invoice side of the accounting system. On the cash side, a “Discount” function is available that creates a pseudo-payment against an invoice. The “Discount” function is accessible from the “Get Payments” window on the Account Summary
screen. The “Discount” is generally used to zero a member’s account balance when small
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residual amounts exist after payments have been received. The Discounts only effect the
cash method reporting and are not reflected in accrual reports.
Typically, the account used by the “Discount” will be an expense account, such as “Discounts.” This expense account is set up under this configuration setting and is not changeable at the time of applying the Discount function.
Declines received after completing a billing process must be entered into the accounting
system. These can be performed manually through the “Debit” function available through
the Data Entry module or, if received electronically, processed automatically. The manual
process will allow you set the Billing and Income accounts for the NSF fees, however, if the
process is automatic the account information is retrieved from the configuration settings. In
this area of configuration, set the Billing and Income accounts to be used to apply NSF/late
charges (declines) to the member’s account. (Late charges are extra service fees associate
with returned check-type items and can be set during the automatic import of the declines
file.)

Credit Cards
Up to 5 different credit card forms of payment can be entered by the manager into this section
of configure.
If you are doing any type of credit card billing, you must enter your merchant ID in the space
provided. The merchant ID field is used when you print your credit cards, or during the
generation of electronic credit card billing.
It is suggested you retain the order that is provided in the description for Visa, Master Card,
American Express, and Discover. This will insure the Front Counter icons match the credit
card descriptions.
To Set Credit Card Types:
1.

In the Configuration Module, select Accounting > Credit Cards from the menu bar.

2.

Enter the names of the credit cards accepted by your club.

3.

Click <OK>.
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Billing Cycles
The Billing Cycles represent the repeat frequency of your billing activities such as Monthly
1st, Monthly 15th, Quarterly, Yearly, etc. These values are used when setting up the billing
system for automated processing of your accounts receivable.
To conduct Billing, use the Billing module. This module can be used to filter your members
by different billing cycles. You may have members that are billed at different times of the
year (i.e. monthly, quarterly, yearly, etc.) and need to process these payments at different
times. Enter up to 20 different billing cycles in this configure option.
It is important to set the number of months in each billing cycle. When you conduct billing
of your members, this information is used to update the “next billing date” for each member.
You can have up to 20 billing cycles. As an example, your billing cycles (and the months in
the cycle) might be as follows: MONTHLY FIRST (1 month in cycle), MONTHLY FIFTEENTH (1 month in cycle), QUARTERLY (3 months in cycle), SEMI ANNUAL (6
months in cycle), YEARLY (12 months in cycle), SPECIAL (0 months in cycle). Note that

with the “Special” category set up as above (with 0 months in the cycle), the next billing
date will not be updated for members in this cycle.
Note that the names that you enter correspond to a cycle. It is the number of the months in
the cycle that affect the billing, not the name of the cycle. To illustrate this point, you can
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name the first cycle “blueberries” instead of “monthly first”, and set the number of months in
the cycle to 1. When you assign a member to the “blueberry” cycle, and then subsequently
bill the member, the program will operate on a monthly billing cycle, incrementing the bill
date by one month. The cycle name is for your convenience only, whereas the number of
months in the cycle is the information the software uses in the billing.

To Set Billing Cycles
1.

In the Configuration Module select Accounting > Billing Cycles from the menu bar.

2.

Click <ADD>.

3.

Enter billing cycle in “Description” field.

4.

Click up/down arrows to select number in “Billed every” field.

5.

Choose “Weeks” or “Months” in “Frequency.”

6.

Click <OK>.

7.

Repeat steps 1 thru 5 until all billing cycles are entered.
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Payment Schedules
The Payment Schedules section of the Configuration module (is used to tell the system how
many payments the member will be making to the total invoice.) allows you to set up
various payment schedules for membership dues and fees. Some examples include: Paid in
full; Biweekly for a year; Monthly for 3 months; Monthly for a year; etc.

To Set Payment Schedules
1.

In the Configuration Module select Accounting > Payment Schedules from the
menu bar.

2.

Click <ADD>.

3.

Enter name of payment schedule in “Description” field. (i.e. Paid in full, Biweekly
for a year).

4.

Click arrow keys to select number of payments and payment spacing.

5.

Click arrow key to select “Months.”

6.

Click <OK>.

Configuring POS Discount Levels
Point of sale discount levels are set in the Configuration Module. The “Set POS Discount
levels” screen allows you to categorize discount levels. Discounts can be applied by membership type. Assign a discount to a membership type, then apply the membership type to
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the member. For example you can set a discount level for all club employees, corporate
discounts, or preferred clients.
To Configure Discount Levels:
1.

In the Configuration Module select Accounting > Discount levels from the menu
bar.

2.

In the “Set POS Discount levels” window click <ADD>.

3.

In the “Description” field, enter name of discount.

4.

In “Discount” field use arrow keys to enter discount amount.

5.

Click <OK>.

6.

Repeat steps 2 thru 5 until all club discounts are entered.

Membership Discount Levels
Varying Discount Levels, redeemable at the Point of Sale, can be assigned to specified
Membership Types. The discounts are automatically applied to qualifying inventory items
sold through the Front Counter. In addition, during a Point of Sale transaction, you can
access this list of Discount Levels and apply one to a specific line item or total invoice.
To attach a Discount Level to a Membership Type (Configuration):
1.

In the Configuration module, select Member > Membership Type

2.

Select an existing Membership Type or create a new one

3.

The Point of Sale Discount is located on the last line of the “Update Membership
Types” window

4.

Select an existing Discount or create a new one

To apply a Discount Level during a Point of Sale transaction (Front Counter):
1.

Before totalling a transaction, select the “Discnt” button

2.

Select which dicount level to apply and how to apply it.

Decline Reasons
Each billing company uses a unique set of decline codes for returned items. Enter the decline
codes and descriptions in the Configuration module using the list provided by your check
processor. Several of our transaction partners are setup already.
To Configure Decline Reasons:
1.

In the Configuration Module select Accounting > Decline Reasons from the menu
bar.

2.

Click <ADD> to enter return code and description.

3.

Check “Apply Status Change to Member” to activate remaining fields and enter
appropriate information.

4.

Enter NSF fee amount if applicable.

5.

Click<OK>.
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Closeout
The account closeout screen is used to insure that transactions on or before a specified date
cannot be modified. This includes voiding invoices and canceling and unapplying payments.

To Set Account Closeout Date:
1.

In the Configuration Module, select Accounting > Closeout from the menu bar.

2.

Enter the date and click <OK>.

MEMBER
The Member menu selection allows you to setup terms to describe your members and
memberships that are familiar to you.

Member Types
It is often convenient to separate your members into groups or types for billing purposes (for
instance multiple membership types), or for reporting purposes. The program allows the
manager to select names for the different membership types. Aphelion will use these types
for management business reports and dues payment.
When you select this menu option, a list of up to forty member types will be displayed.
The order that you enter types is important. Enter the type names on the screen in the order
they are most used. As you select types in the data entry areas of the program, they will be
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displayed in the order that they are entered on this Configuration display. It is recommended
that you enter the most used types first to minimize keystrokes later.
IMPORTANT: When a type is changed, all of the items with the old type name will be
changed to the new type name. For example, certain members might be in the LADIES
membership type, if you change the category name from LADIES to COED, all of the
previous LADIES members will now be categorized as COED members. Clearly, you should
exercise caution when changing type names.
If your gym’s particular configuration does not require multiple types for members, you must
enter at least one name for the member type.

To Configure Membership Types:
1.

From the file menu select Member > Membership Types

2.

Click <ADD> in “Set Membership Types” window.

3.

Enter type of membership in “Description” field.

4.

Click on “Prospect,” “Member,” or “Both.”

5.

Click <Day & Time> and choose appropriate options to set access restrictions.

6.

Click <OK>.

7.

Click <Services> and then choose applicable boxes.

8.

Click <OK>.

9.

Click <Clubs> and choose either “All Clubs” or “Selected Clubs” from the pulldown menu.

10. Click <OK>.
11. Click on pull-down menu for “Point of Sale discount.”
12. Click on description and then click <SELECT>.
13. Click <ADD>
14. Enter discount level description.
15. Click <OK>
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Set Restricted Time
After entering the interval times, use the mouse to click the fields that correspond to the time
intervals and the days of the week. If you wish to NOT allow the member of this category to
be admitted during a specific interval, switch the Allow field off by clicking. A check mark
indicates the member will be allowed during the time interval.
As an example, you may wish to set up a Non Prime membership. The member will only be
allowed to check-in early in the morning or late at night. The member can enter before 8 AM
or after 7 PM.
Sequentially turn off the check mark that indicates a member is allowed to enter during the
time frame of 8 AM to 7 PM. Use the mouse to toggle the checkmark.
When you are done, all items in the middle column should be unchecked, signifying the
member is not allowed to check-in in this time frame.
Note that you can also restrict the days of the week that a member can enter the facility. By
“Allowing” all times on Monday through Friday, and “Disallowing” all times on Saturday
and Sunday, you can effectively create a membership that cannot attend on weekends.

Set Allowed Services
Once activated, a table of allowable services is displayed.
(Note that you must have previously setup the services. If your services are not displayed in
the window, setup your services in the Services menu. Refer to menu item (Members/
Services).
The services shown reflect all the available services that you have configured.
Use the mouse to choose the fields that correspond to the member services. If you wish to
NOT allow the member of this category to be admitted for a highlighted service, switch the
field “off” by clicking with the mouse.
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Member Status
Similar entry methods can be used to configure the member status messages. These status
messages can be used to categorize members by membership status. Additionally, the status
can alert the operator of special conditions when a member is checked-in. When a status is
defined, the user can specify whether the Check-in personnel are alerted at the time of
admission. If set to “alert” a warning message will be displayed on the Check-in screen. For
example, if the user wishes to be prompted at the time a member checks-in of a problem
member, a status message “BAD STANDING” might be entered in this configure option.
Whenever the problem member checks-in, the user will be alerted via a voice message and a
pop-up window containing the member status.
The first 4 types of Status messages are fixed, and cannot be changed by the user. In these
status entries, only the “alert at Check-in” selection can be changed.
“HAS MESSAGE” is used as a general message status, and can cause an alert upon check-in.
“FREEZE” and “TERMINATE” will also cause an alert to be displayed at check-in, and will
suspend the automatic billing of membership dues (not the on account). The “FREEZE” and
“TERMINATE” status operate similarly to each other, except members flagged as “TERMINATE” can be deleted from the database, all at one time, using a special Utility in the
Manager module. Members flagged as “FREEZE” can be thawed from the Utility menu in
the Manager module.

To Configure Member Status:
1.

From the file menu select Member > Member Statuses.

2.

In the “Browse Member Status” click <ADD>.

3.

Enter description of each member status appropriate for your club.

4.

Click “Alert on check-in” box if option is desired.

5.

Click <OK>.
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Note Actions
Whenever a note is entered in the member’s record, an “action” is assigned to the note.
“Actions” can be used to categorize membership notes, or to tag a note so its purpose is
evident. When you enter a note in the membership record, the “ Actions” menu will appear,
with your pre-defined Actions.
Since notes can be entered into the member’s record in several modules, you may want to
create actions that will be applicable to all of the types of notes you may enter. Notes can be
created for Prospects, Members, Collections, and Front Counter.

To Set Note Actions:
1.

In the Configuration Module select Member > Actions from the menu bar.

2.

Enter appropriate action notes.

3.

Click <OK>.

Sources
When a new member or prospect record is created, or when a membership contract is sold, the
program can track the discovery method. The discovery method is the way the new member
found out about your club.
You may want to track the method the new member found out about your club for statistical
purposes or to focus on the most effective method. Several reports are available for this
purpose.
Since every club utilizes different advertising methods, the Sources screen allows you to
track your promotions by defining them in this area.
The “Set Sources” option is used to allow you to select (and track) the method a member
finds out about your club. Suggested entries include walk-in, member referral, radio,
newspaper, mail, etc. Enter the methods that are appropriate for your club.
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To Set Sources:
1.

In the Configuration Module select Member > Sources from the menu bar.

2.

Click <ADD> and enter appropriate description of the source.

3.

Click <OK>.

Prospect Defaults
When entering a new prospect into the system, certain items can be defaulted to make the
data entry process faster and easier.
Every prospect is prioritized via a Priority number, with 1 being the highest and 9 the lowest.
You can set the default “call back” day as the number of days after the record is added. This
field is called “Days until call back”.
If you are using the Prospect module, the contact manager portion will expect you to set up a
“next action” for every new prospect. The default “next action” is defined in the “next
action” field.
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To Set Prospect Defaults:
1.

In the Configuration Module select Member > Prospect Defaults from the menu
bar.

2.

Use the up/down arrows to set defaults.

3.

Click <OK>.

Preset Check-in Notes
The program accommodates the entry of membership notes from the Front Counter. Since the
Front Counter area can be busy, and since many of the notes that the Front Counter personnel
will enter are routine, we have provided an area where you can setup standard notes.
The standard notes can be selected from a menu when the note is created at the Front
Counter, thus saving time if the note is concerning a routine item.
Enter the text of the note, and a Note Action for as many standard notes as you might need.
To Set Check-in Notes:
1.
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In the Configuration Module select Member > Preset Check-in Notes from the
menu bar.

2.

Click <ADD> and enter appropriate note.

3.

Choose an action from the pull-down arrow menu.

4.

Click <OK>.

Member Services
Services can be used to log usage in different areas of the facility, or to restrict access to these
different areas based upon membership category. Setup activities for those areas that you
wish to monitor usage, or for those areas that require restricted access.
If you want to track which service a member uses when he checks-in, select “Always prompt
for activity on regualr check-in under Check-in options (Configuration > Station > Check-in
Settings > Always prompt for activity on regular check-in). This feature allows tracking
member check-ins for services with an “A” (facility “area”) attribute.
Up to 16 different services may be configured. While setting-up the services, you can also
set default pricing for Visit sales. The default pricing is used when you sell a Visit for the
service from the ProShop.
Check-in to a particular service can be restricted by member type (Configuration > Member
> Type). For each membership type, any combination of services can be selected as an
allowed entry. If a member is not assigned to an allowable service, the Front Counter will be
alerted.
If activity tracking is enabled and if the Check-in screen is operating in Attended mode, the
complete set of activities with an “A” attribute will be displayed in a selection window
when a member checks in.
If tracking is disabled (uncheck the box “Always prompt for activity on regular checkin”
located in Configuration > Station > Check-in Options) all members will be checked into
the General Facilities area.
The configuration module lets the default service be selected for each terminal (Station >
Check-in Settings). In attended check-in mode this is the service that will be initially
highlighted in the selection window. In unattended check-in mode, the first service selected
for a membership type is the service the member will be checked into.
This “default” service allows a club with multiple terminals to better control entry to areas of
the facility. For instance, if a turnstile is set up by the pool area, the activity tracking can be
set up to restrict members from entering that area.
The Visit Price field is used to allow you to enter a default dollar value to be used when you
SELL a visit. Whenever you sell a visit from the ProShop screen, the value you enter here
will be used for the visit pricing. You can override this value from the Register screen.
To sell a visit to an activity, you must configure the ProShop POS screen in the Configure
module. This process is discussed later in this chapter. You can setup Quick Keys that are
assigned to the different activities, which will allow the sale of the activity to a member. As
these visits are used, the program keeps track of the remaining balance. This is discussed in
more detail in the ProShop chapter, and in this chapter Front Counter > POS buttons.

Member Services allow you to attach one or more recurring dues categories to a member
record. The recurring dues amount for a given service is set in the member record. For
example, two members can have the “General Dues” Service, but Member 1 pays $15 per
month while Member 2 pays $20 per month. In addition, multiple “Services” can be
attached to a member’s record making the total monthly recurring dues composed of individual “Services” the member has elected to use. For example, a member’s monthly dues
may consist of a “General Dues” service, a “Towel” service, and a “Wet Area” service.
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Finally, the term “Services” allows for a different amount to be charged for members with a
“Frozen” status.
Member Services can have any combination of these attributes: area, visits, or dues. These
attributes define how Services are used in your club. An “Area” allows the service to be
checked into by subscribing members. A “Visit” is a sold, metered service, and “Dues”
allows you to attach a recurring charge to a member’s record. In addition, a “Dues” service
has an “active” property. When this property is selected, the service becomes a default
service attached to all new member records.
If you used the “Recurring Dues” feature from Version 2, the upgrade process creates a
“General Dues” Service to represent it in Version 3. It then sets each dues amount in the
member records equal to the “Recurring Dues” amount from Version 2. In addition, each
Version 2 “Activity” is converted into a Service and tagged with “Area” and “Visit”
attributes. You can then upgrade each Service to include the “Dues” attribute if you wish to
charge as separate recurring dues.

To create a Member Service (Configuration):
1.

In the Configuration module, select Member > Services.

2.

Select the “Add” button.

3.

Under the “General” tab, assign a barcode ID, description, and income account.

4.

Set the attributes (visit costs and tax rates if applicable).

5.

Under the “Image” tab, set an icon image to be displayed during check-in (for
“area” type services).

6.

Under the “Commissions” tab, set any desired commissions information.

Set recurring dues for Member Services (Data Entry):
1.

In the Data Entry module, highlight a member record and select “Change”.

2.

Select the “Billing” tab.

3.

In the “Recurring Billing” box, place a check mark next to all desired services to
attach to the member record.

4.

Double-click the dollar amount associated with the desired service and enter an
amount. The “Dues” column is for active recurring dues, the “Freeze” column is
specific to the Member Status “Frozen”.

Batch adjustment of Recurring Dues amounts (Reports):
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1.

In the Reports module, select Utilities > Batch change Member dues.

2.

Select a member record filter type.

3.

Select the service to adjust from the drop down list

4.

Select which dues to adjust (Standard or Freeze)

5.

Enter the adjustment type and amount.

6.

If desired, set the service to “active” status

7.

Select OK to run.

Interests
Interests are used within the program to track each member’s interest within the club. Setup
Interests that correspond to your club.

To Configure Member Interests:
1.

In the Configuration Module select Member > Interests from the file menu.

2.

Enter interests that correspond to your club’s activities.

3.

Click <OK>.
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Custom Fields
Fitness Manager provides sixteen text fields, four numeric fields, and four date fields for
customized data tracking with each member record. This window is used to title each
available field.

To Configure Custom Fields:
1.

In the Configuration Module select Member > Custom Fields from the file menu.

2.

Enter titles based on club requirements.

3.

Click <OK>.

ID Number Assignment
The program can automatically assign ID numbers for Prospects and new Members. If you
want to assign numbers manually, uncheck the box labeled“Auto-generate”.
If you want the program to assign ID numbers automatically, place the beginning ID number
into the appropriate field. The next sequential number will be assigned the next time you add
a new record.
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If desired you can have each member and prospect record begin with a certain prefix. For
example, you may want all customer ID’s to begin with a “C”, while prospect ID’s may
begin with a “P”. While this is not recommended, it is available for those clubs that require
it.

Data Exchange ID Assignment
The Data Exchange ID is intended to be used as a unique identifier for exchanging data with
external data sources (i.e. billing companies or other clubs using Fitness Manager). The Data
Exchange ID field is numeric and must be a unique number within your member table.
Fitness Manager offers several options for initializing this field as you add new member
records.
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Options include:

•
•

Do not auto-generate value

•

Generate based on prefix and barcode (this option is used by some billing companies).

Generate based on club number and incremented number (ideal for Aphelion multi-club
replication).

To Set Data Exchange ID:
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1.

In the Configuration Module select Member > ID Assignments > Data Exchange ID
Assignment tab.

2.

Select one of the generation options.

3.

Click <OK>.

SECURITY
The Aphelion software can restrict access to the program modules as well as to various areas
within each module.
The protection system is based on a password. Passwords are used as a method to deny
access to users who are not authorized to view the protected areas of the program. Since
several types of users may have access to the program ranging from Front Counter clerks to
seasoned managers, each area of the program can be protected.
Some areas may contain sensitive information, so by using the password the owner or
manager can restrict access to these areas. Areas of the program, such as the databases, the
Configure section, Accounting functions, and the Reports can be protected. If an area is
protected, the employee must enter his password to view or access the information. The
system provides for virtually unlimited levels of password protection.
Every employee can be assigned a password. The areas of the program each employee can
access are defined in the employee’s record, in the Data Entry module. Each employee’s
record is tailored to allow or deny access to the various areas of the program. The process of
assigning the specific areas an employee can view is unique to each employee. Since you
may have several employees with similar access rights, templates can be created that contain
the access rights for a class of employee. Using the templates you create can speed the task
of assigning the access rights for each employee. The Security menu of the Configuration
module is used to create the security templates.
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Access Defaults
Select “Access defaults” to create, or change, the access templates. The access settings
browser window will be displayed.
Assigning access defaults is straightforward, and protection directly corresponds to the
selections listed. After adding or changing a template from the window, the password
protect selection window is displayed.
Three default templates are provided with the system. These three defaults are “Manager”,
“Personnel”, and “No Login”. If desired, the access settings for these areas can be modified,
or you can add your own templates in addition to the defaults.
To Set Access Defaults:
1.

In the Configuration Module select Security > Access Defaults from the menu bar.

2.

Click <ADD> to enter name of access level.

3.

Set restrictions for individual modules by clicking on the appropriate boxes.

4.

Click on the tabs at the top of the screen to set access restrictions for other areas
of the program.

5.

Click <OK>.

Protection
Individual modules plus various other areas of the program can be protected via access
restrictions. Select the different tabs to view the protected areas for each template. If the box
is not checked next to an item, the employee will not have access to that item when he logs
in. The manager or owner should have all the items checked, thus allowing access to all
areas of the program. The Front Counter personnel may only have several items checked on
the Front Counter tab, thus restricting him/her to the Front Counter activities.
In the event he/she must have access, an employee with the correct access rights must override the security restrictions.
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DATA ENTRY
Overview
The Data Entry module is an area that is used by the system to save member, prospect, Pro
Shop retail inventory, employee, bank, class, schedule, and group affiliation information.
The information is organized in separate data entry areas.
The computer’s file structure is similar to an office file drawer, containing eight file folders.
The eight file folders in our imaginary file drawer are analogous to the eight files within the
Data Entry area. These files are labeled Members, Items, Employees, Banks, Groups,
Classes, Personal Training, and Scheduling.
To view or enter data into an area, select the appropriate button from the top of the screen,
or select Data Entry from the menu. (If you allow the mouse to linger over any of the icons,
the tool tip will appear reminding you of the function of the icon).
To obtain information about the members, items, employees, banks, groups, classes,
personal training, or schedules, the appropriate area must be displayed. Select the area from
the menu or button.
Each data entry area contains all of the information about similar items. For example, the
“Members” data entry contains all the information about the members. The information
from the data entry area is displayed in a “browse” window.
The “browse” windows display a scrolling list of all the items in a data entry area. These
windows contain a list of the items: members, employees, retail inventory items, banks,
schedules, personal training, classes or groups. Each item in the list is called a “record”.
A record is like an index card in the file folder described earlier. Each of the index cards
(records) contains information about an individual member, employee, or inventory item
and is stored in their respective files.
Once you have selected a specific data entry area, you’ll see the “Browser” with the records
from the selected database displayed.

Database Browser
Once you have selected the desired data entry area from the menu, you’ll be ready to view
the records in the database.
The screen displays an alphabetical list of the records in the database. You can search for
any record that is not displayed by using the Search function. To search, enter as many or as
few characters as desired in the Search field. Press the <Tab> key to start the search. The
program will search the database and find the closest match to the name given.
The screen will be filled with the alphabetical records starting from the closest match. This
screen is called the “database browser”.
Buttons are displayed along the bottom of the browser consisting of options to make
changes to the database, and to show more information about a highlighted record.
The browser allows you to search for an alternate entry, to order the entries in numeric
rather than alphabetical order, and to add, delete or change each record.
The following commands are available while displaying any of the data entry browsers:
ADD, CHANGE, and DELETE. These commands are summarized below.
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Add:

Add a new member, employee, inventory, bank, class, personal training or
group.

Change:

Change a record after it has been previously entered.

Delete:

Remove a record from the file.

Close:

Exit from the database browser.

To add a new record, use the mouse or tab keys to position the cursor on the Add button.
To delete an existing record, use the mouse or up/down arrow keys to position the cursor on
the desired record, then select the DELETE button.
To modify an existing record, use
the mouse or up/down arrow keys
to position the cursor on the
desired record, then select the
CHANGE button.
Additionally, the Member database contains a <Convert> button. This button is used to
convert a prospect to a member, or a member to a prospect.
Some records are too large to display on one page, so they are divided into multiple screens
(other data entry records are displayed on one screen).
For records that contain more information than can fit on one page, the program groups the
data into several pages of information. These pages of information can be viewed by
selecting the appropriate “tab” button along the top or bottom of the display.

Record Searching
The system is designed to allow you to quickly find any record in the system.
To find any record in the database, position the cursor in the Search field, then type a partial
name or description. Once you have entered enough characters to find the record, press
<Tab>.
There may be multiple ways to search for a record in each browse window. For example, in
the member database you can select between the ID Number, Agreement Number, and Last
Name sort orders. To search for an ID number, be sure you are viewing the records in ID
number order. To search for a name alphabetically, make sure you are viewing the records
in alphabetical order.

Filtered Searches
Filtered searches allow you to view a subset of the database. Filtered searches reduce the
need for extra menus or additional database browsers.
Filtered searches are conducted by selecting the appropriate items from the Filter window.

Record Editing
Each record has been subdivided into smaller areas containing specific information. These
smaller areas are called fields. Fields are used throughout the program as areas for the user
to enter information into the system. The editor allows you to add or change the information within these fields. The editor allows you to move the cursor within an entry field, add
or change text, or move to the next field.
“Hot Keys” are setup for each field to facilitate easy navigation throughout the record. Each
field name has an underlined letter indicating the “hot key”.
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Use the <Alt> key along with the underlined letter to move directly to a field.
Alternately, use the mouse to go directly to the field.
New records can be added by selecting the Insert or Add function from the menu. The
following table is a summary of the methods that are available to change the record.
Note that the system utilizes the Windows conventions for moving between fields: the
<Tab> key is used to move between fields. The <Enter> key is used to save the record.

Editing Commands:
Up/Dn Arrow:

Move to the next field.

Tab:

Moves cursor to the next field.

Shift- Tab:

Moves cursor to the previous field.

Back Space:

Deletes the last character entered.

<ESC>:

Aborts and returns to the previous screen.

Insert:

Toggles Insert character, ON/OFF.

Del:

Deletes current character.

Enter:

Complete the data entry, save the record, and return to the
browser.

Tab selection:

Moves between different fields in the record.

Home:

Moves the cursor to the beginning of the field

End:

Moves the cursor to the end of the line

Saving Your Data
Data is entered into the record, one field at a time. After the desired data has been typed,
press the <Tab> key to advance the cursor to the next field. The data does NOT get stored
on the computer’s hard disk at this point in the process.
All data in the record is stored at one time. This occurs whenever the OK Button has been
selected.
If you don’t want to make changes to the record, press the <Esc> key.

Member Database
The member database holds all of the information associated with your members. The
member database also contains the optional Prospect tracking information. Access the
member database by selecting Data Entry | Members, from the menu, or by selecting the
<Members> button.
The database browser displays the records in the database. The browser displays members
in different colors to differentiate them from each other. Members who are in good standing
(“OK”) are displayed as green. Members who have been “Terminated” are displayed as
gray, and members who are in “Freeze” status are black. “Prospects” are displayed in blue,
and have a “P” displayed on the left side of the entry. Members with a status message are
displayed in red. Members in Collection status have a “C” displayed in the left column.
Additional commands that are not common to the other browsers are available on the
Member database browser. These additional commands will let you view a member’s
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account (ACCOUNT), convert a prospect record to a membership record (CONVERT), view
recent check-ins (Check-ins), and view family or secondary accounts (FAMILY).
Convert:

Convert a prospect record to a member record.

Form:

Selects a form letter to be sent to the member.

Account:

Displays account history for the member.

Family:

Displays family or secondary members.

Check-ins:

Displays up to 50 of the most recent check-ins.

Print:

Prints a summary of the record information.

Adding A Record
The <Add> function is used whenever you wish to add a new member (or Prospect) to the
database.

A small pop-up window will appear asking if you want to add an ACTIVE member, FAMILY member, or PROSPECT.
If you choose ACTIVE, a blank member record will be displayed for you to enter the
pertinent member information. Use the “Editor Commands” mentioned earlier to control
the cursor when entering the member data.
If you select PROSPECT, a blank prospect record will be displayed for you to enter the
pertinent prospect information.
The Prospect and Member databases are similar, except the Prospect record does not contain
billing information. The prospect record contains information related to call back and
prospect tracking, while the member record displays appropriate membership information.
The FAMILY option is used to add a secondary record for a family member. When you
press the Family Member button, this has the effect of using all of the information in the
member’s record that was highlighted when you pressed the <Add> button.
Depressing FAMILY button copies pertinent information from the highlighted record into a
new record to save time upon entering the new record. When you add a family record
(secondary account), the billing for the account will be handled by the primary account.
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Note that when entering the secondary account information, the Bill to ID, last name,
address, and other fields are defaulted to the Primary member’s information.
To Add a New Member To Your Database:
1.

In the Data Entry Module select Data Entry | Members.

2.

Click <ADD> and select type of member, and then click <OK>.

3.

Enter Barcode ID # (This can be set to automatically enter the next available number in the
Configuration Module. To do this select Member | Barcode ID Assignment).

4.

Enter “Agreement #” (This optional field is used to record the agreement number of the
member contract, if it is different from the customer ID).

5.

Enter member information in remaining fields.

6.

Click on the “General” tab at the top of the window and enter applicable member information.

7.

Click on “Billing” tab.

8.

Choose a billing cycle by clicking on the pull-down arrow.

9.

Set “Next Billing.” date.

11. Choose a form of payment by clicking on the pull-down arrow.
12. Select “Bank Name” from the pull-down menu.
13. Enter member information in remaining fields.
14. Click “Renewal” tab to enter “Join date”, “Contract Expire” date, and renewal fees.
15. If the member being added is not responsible for payment of dues, click the “Responsibility” tab to select responsible billing party.
16. Use the “Custom” tab to enter additional member information (optional).
17. Click on the “Notes” tab to enter additional member information in a free form note field.
18. Click on the “Picture” tab if you have Video Image Capture capabilities and want to take a
picture of a member.
To Add a member using “Quick Add”:
1.

From the Data Entry Module select Data Entry | Quick Add | Add Member.

2.

Enter the member information in the appropriate fields.

3.

Click <OK>.

Changing A Record
To change information in an existing member record, select the <Change> option. The
entry window showing the existing member information (for the highlighted member) will
be displayed.

Deleting A Record
The <Delete> option should be selected if you wish to remove the highlighted member from
the database. If you attempt to delete a member that has an account balance, a warning
window will be displayed. Select the proper Yes/No response to the warning and proceed.
Prior to deletion of a member, you will be asked to confirm the deletion. If you wish to
continue with the member deletion answer “Y” (Yes) to this prompt; otherwise select No.
Prior to deletion, the user will be asked if the member information should be printed such
that the information may be retained in a paper file. Again, select Yes if hardcopy is
desired, select No if the deletion is to proceed without printing the record information.

Convert Prospects to Members
As mentioned earlier, “Prospects” are displayed on this browse screen to identify potential
members. If a prospect purchases a membership, the <Convert> button will use the prospect
record information to construct a member record. The billing information, not available in
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the prospect record, will need to be updated by the user in the new member record to
complete the conversion process.
To Convert a Prospect to a Member:
1.

In the Data Entry Module select Data Entry | Members.

2.

Click on the guest/prospects name, and then click the <Convert> button.

3.

Choose “Member” and click <OK>.

Account
A member’s account records can be displayed from the member database browse window.
To view a history of account information of a member, highlight the member then press the
<Account> button. A window will be displayed that lists all account transactions for the
highlighted customer. A similar function can be activated from the Register screen. A
thorough description of the account history browse window is given in the Billing section.

Print
To make a hard copy of the member’s information record, select the Print function. This
function will print out the record field information for the highlighted member in the browse
window.

Check-In
To view all the times a member has checked into the club, select the <check-in > button.

Schedules
To view the scheduled appointments for a highlighted member, select the <Appointments>
button.

Member Database Fields
As mentioned earlier, information is entered into the database record in separate data fields.
These fields correspond to the information required to identify the member at the time of
transaction and ensure traceability if bad checks or other member problems arise.
The member database record is split into multiple tabs. The first tabs deal with personal
information regarding the member. This information includes items such as name and
address of the member. Other tabs contain information necessary to process dues billing or
drafting.
The Prospect database and the Member database share the first page of information. Since a
prospect does not need billing information, the billing tab is different for a Prospect. The
prospect fields are described later.
When completed with new member entry or existing member changes, press the OK button
to save all changes. Selecting OK completes and terminates the data entry procedure.
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Personal Tab
BARCODE ID: This is the ID number assigned to the member. This ID code can be any
combination of numbers up to a maximum of 10 characters long. It MUST be unique from
all other members in the database. Frequently, telephone, driver’s license, membership
contract number, or social security numbers are used. (Required entry field.) If you wish to
select a new ID, choose the <New> button located adjacent to the ID field.
AGREEMENT #: This optional field is used to record the agreement number of the
member contract, if it is different from the customer ID.
STATUS: The items in the list are entered initially in the Configuration program. Use the
“OK” status if no particular messages or warnings are associated with the member. If set in
the Configuration program, other status selections may cause alert messages to appear to the
user when the member checks in or attempts to purchase a retail product.

Additional selections for the member status include FREEZE and TERMINATE. Selection
of either of these options will suspend periodic billing of the member’s account. FREEZE
is designed to be used to temporarily suspend billing, while TERMINATE is designed to
permanently suspend billing. When you select FREEZE, a small window will appear asking
for the THAW date, and the next billing date. When you select Terminate, an extra field
will appear, displaying the terminated date.
If you select TERMINATE as the status, there is no need to delete the member’s record.
Batch deletion of members, whose status is set to TERMINATE, is handled under the Utility
menu. Batch THAWING of members whose status is set to FREEZE is also handled under
the Utility menu.
Note that a member must have enough FREEZES available to be able to set the status to
FREEZE. The number of freezes/thaw cycles that are available are set on the second page
(“General” Tab) of the member database. A default number of “freezes available” can be
set from the Configuration Site menu, though you can change the number when entering the
member’s record.
LAST NAME: Enter the member’s last name. A maximum of 25 letters can be used.
(Required entry field.)
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FIRST NAME: Enter the member’s first name. Usually this will be the legal name, or the
name on the member’s checking account or credit card. A maximum of 25 letters can be
used. (Required entry field.)
MIDDLE INITIAL: Enter the initial of the middle name of the member.
PREFERRED NAME: Enter the name or nickname preferred by the member. The name
typed in this field will appear on the Register screen when the member checks in or purchases retail products, and on all mailings sent to the member.
ADDRESS: Enter the member’s street address. A maximum of 30 characters is allowed.
CITY: Enter the member’s city of residence. A city can be entered into the configure
section (refer to Configuration section). This city is automatically displayed when entering
a new member.
STATE: Enter the two-digit abbreviation for the state.
ZIP CODE: This field supports the 9-digit zip code for the mailing address of the member.
The program uses this information to sort mail outs that are automatically organized to take
advantage of bulk mailing rates.
HOME PHONE: Enter the member’s telephone number and area code in this field.
WORK PHONE: Enter the telephone number of the member’s place of employment. If
there is no business telephone, enter a daytime telephone number in this field.
EXTENSION: Enter any extension required to contact the member at his work telephone.
EMERGENCY PHONE: Enter the telephone number to be used in case of emergency
concerning the member.
EMERGENCY CONTACT: Enter the name of the person to contact in case of an emergency. This name should correspond to the telephone number entered in the previous field.
GENERAL NOTES: Any comment regarding the member can be typed into this field. Use
this area for recording any notes you may need regarding the member. This field is printed,
along with the Status and Status Message, on reports.
HOME CLUB: This optional field is configured in the Configuration program. It can be
used in a multiple club organization to identify the “Home Club” of this individual member.
It can also be very useful for health and fitness centers utilizing reciprocal memberships, or
to ensure the data integrity among multiple club configurations.

General Tab
GROUP NAME: Frequently members belong to a group, such as a large corporation in the
area. To track these members as a group or a corporate affiliation, enter the name of the
group to which they belong.
You can select the group from the existing Group database. Type the name of the member’s
group, and then press <Tab>. If the Group doesn’t already exist, a window will be displayed that shows the Groups. Highlight the desired Group, then press OK. The group
information will be automatically transferred to the member’s database record. This
information includes the group name, address, city, state, and zip code. Keeping an up-todate group database will greatly assist in the entry of new members.
OCCUPATION: This field is used to track information about the occupation of a member.
This information is used in the report section.
INCOME: This function is used primarily to identify potential member prospects and
support the membership sales function.
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GENDER: This field is used to track the gender of your members.
DATE OF BIRTH: The Date of Birth for your member is stored here.
LAST VISIT: This date field stores the most recent date the member checked-in to the club.
The user cannot edit this field.
HEIGHT/WEIGHT: Enter the height and weight of the member. This information is
displayed on the check-in screen as a quick identification of the member (If no Video Image
Capture.)

MEDICAL RISK: Click next to this field if the member has a medical risk. This information is stored, alerted on check-in, and printed on reports.
MEDICAL NOTES: This note field can be used to store special notes about the member’s
medical record, or to enter additional member information.
REFERRALS: Enter a number corresponding to the number of referrals a member has
provided. This information can be used to motivate your members to provide referrals.
LOCKER/LOCKER EXPIRES: If you use lockers, enter the locker number and expiration
date in these two fields. This information is printed on reports.
INTERESTS: This data field is configured in the Configuration program. It is used to store
the activities or events that are of interest to this member. This information is useful for
selective mailings of particular Pro Shop sales items, or special class/event promotions.
Select all the “interests” for this particular member.
SOURCE: Select one of the choices originally set up in the Configuration section for the
method by which the prospect/member discovered your club. This is used to track the
effectiveness of various marketing techniques.
SALES PERSON ID: Enter the salesperson ID number. This allows the responsible employee the ability to track prospect follow-ups. Reports are printed and sorted by ID so
each employee can have a current callback sheet.
COUNSELOR ID: If the member is assigned a training counselor, enter the ID number of
that employee. Press F6 to select the ID number from the list of employees. Highlight the
desired employee then press <Enter> to select.
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THAWS ALLOWED: Since some clubs limit the number of times a member may Freeze his
membership, the system allows you to set a given number of THAWS. Each time a Freeze
is used, the number of Thaws available is counted down. When 0 Thaws are available, the
program will not allow you to freeze a member’s account.
LEVEL: This field can be used to designate different levels of participation or ability. A
number between 0 and 99 can be entered to separate member skill or fitness levels. For
example, the user may wish to designate “Beginning,” “Intermediate,” and “Advanced”
fitness levels. If you do not wish to utilize this feature, set this value to “0.”
Note the “Account” and “Invoice” buttons on the bottom of the “Browse Members” screen:
These buttons allow you to view the member’s Invoices, Invoice History, Invoice Detail,
Charges/Payments, Account Aging, and even allow you to create an Invoice for this member
from the Data Entry program.

Billing Tab
The Billing page of the member record pertains to the recurring billing (or drafting) of
members. A description of the entry fields for billing the member record follows:
BILLING CYCLE FOR DUES: Select the dues billing cycle for the member. Billing cycles
are initially entered for your site in the Configure section. The billing cycle that you enter
here will be used when the member billing occurs. (Required entry field.)
FORM OF PAYMENT FOR DUES: Select the desired form of payment for the member.
This field allows the user to select various payment options including automatic drafting,
invoice billing, or credit cards. (Required entry field.)
Note for EFT users only: If you select EFT as the form of payment, a prompt will appear.
This prompt will ask if you wish to send a pre-notification to the bank for the new entry.
Generally, all new entries should be pre-noted. In some cases this is a bank requirement.
Note that you are only “flagging” the member to be pre-noted. You must select “Billing”,
then “Pre-note” from the Billing menu to actually generate the Pre-note file for your new
members.
DUES AMOUNT: Enter the amount of the dues that corresponds to the billing cycle
selected above. This is the amount that will get used when performing the billing operation.
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Note that this amount is intended to be a recurring or cyclic billing amount (i.e. monthly,
quarterly, etc.). Do not add tax to the amount, as the tax rate is set in the Configure section
and automatically added to the billing amount.
APPLY CREDIT LIMIT OF: The software allows you to set a credit limit for each member
for “On Account” sales. This limit can be “overridden” by an authorized individual.
NEXT BILLING DATE: This field is allocated for the billing program to determine which
members need to be billed within a billing cycle. Only those members with a billing date
contained within the current billing month will be billed by this utility. Change this date to
start billing on a date in the future, or to temporarily suspend billing. Required entry for
members being billed.
LAST BILLING DATE: When the member account is billed, the date of billing (or drafting)
is automatically entered into this field by the billing/drafting program.
CONTRACT EXPIRATION: This date field stores the expiration date of any membership
contracts active for the member. Reports can be printed using this date, BUT automatic
billing does NOT cease when this date is passed. If the membership will not expire, check
the AUTO RENEW TO OPEN END. Checking this will cause the software to not alert on
the contract expiration date when checking members in at the Front Counter.
BILL TO ID: When performing the billing function, the program uses this field to bill to a
different member. If the member’s dues are to be paid by a third party, such as parents, the
ID of the person paying the account should be entered in this field. If a membership is
billed to another member, a number of the billing-related fields will be disabled, and set
from the master record.
If you enter any other member ID in this field, the record will be considered a “secondary” .
All secondary accounts are related to a primary account. Tthe primary account is the billing
account.
BILLING NAME: This data field identifies from whom a dues or on-account payment is to
be expected.
BANK ACCOUNT NUMBER: Enter the member’s account number for which all automatic
drafting will be directed.
BANK NAME: Enter the member’s bank name in this field. Select this number from the
existing bank database. Type the name of the member’s bank then press <Tab>. If the bank
is not already setup, you will be asked to setup the bank or choose from a list. Highlight or
select the desired bank then press <OK>. The bank information will be automatically
transferred to the member’s database record. This information includes the bank name,
address, city, state, and zip code. Keeping an up-to-date bank database will greatly assist in
the entry of new members.
SOCIAL SECURITY NUMBER: Enter the member’s SSN in this field.
DRIVER’S LICENSE: The member’s driver’s license number can be stored in this field.
CREDIT CARD NUMBER: This field contains the credit card number for the credit card
selected in the FORM OF PAYMENT FOR DUES field. If a credit card is selected as the
form of payment, this field requires a card number input. If other methods of payment are
specified (i.e. invoice billing), entry in this field is optional.
CARD SWIPE ON FILE: This box will be checked if the member’s card has been swiped.
Swiping a member’s credit card allows the program to store additional credit card information. This additional information is sent with the file that is generated when you perform
billing and can generally be used to obtain a lower processing rate. A configuration option
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is provided to alert the Front Counter if the card has not been swiped, thus allowing the
Front Counter personnel to swipe the card.
CREDIT CARD EXPIRATION DATE: Date of expiration for the card described in the
FORM OF PAYMENT FOR DUES and CREDIT CARD ACCOUNT NUMBER fields. This
field requires input if a credit card has been selected for the form of payment.

Renewal Tab
RENEWAL: This tab contains additional information about the member contract, specifically regarding the renewal rate. The screen contains the date the member joined the club
and the expiration date. In addition, it displays the dollar amounts needed to renew the
contract using various forms of payment (EFT, Statement, or Paid in Full).

Responsibility Tab
RESPONSIBILITY: This tab contains billing information when the member’s dues are to
be billed to someone other than the member. For example, the dues could be billed to a third
party such as the parents of the member.

Custom Tab
CUSTOM: This tab is used for additional member information such as name of physician
and insurance provider. These fields are setup in the Configuration module.

Notes Tab
NOTES: This field is a free form note field and can be used to enter any information
regarding the member that you choose.
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The following follow-up fields are also available: Priority, Last Contact, Next Action, and
Next Contact. These fields can be used for follow-up purposes, and are similar in nature to
the fields in the Prospect module.
If a note is created that you wish to display when the member is checking-in, check the box
labeled “alert at check-in”. If this box is checked, the note will be displayed when the
member checks-in.
Each note is color coded so you can determine the module where it was originally created.
Green bordered notes are created in the Prospect module. Blue bordered notes are created
in the Data Entry module. Yellow bordered notes are created from the Front Counter
module. Red bordered notes are created in the Collections module.

Picture Tab
PICTURE: This tab allows the “taking of a picture” of the member, providing the optional
Video Image Capture System is available. This area also permits the deletion of an existing
“picture” and replacement with an updated one. Just click on the “delete” button and then
“camera” button to enable this feature.

Prospect Database Fields
Prospect Tab
The prospect tab replaces the billing tabwhen viewing a prospects record. A description of
the entry fields that are different for the prospect record follows:
PRIORITY: Assign a priority from 1 to 9 for each prospect. Lower numbers indicate high
priority; higher numbers indicate low priority. Reports can provide a printout of prospects,
sorted by priority.
FIRST/LAST CONTACT: Enter the date that contact was first made with the prospect and
the date that you last spoke or visited with the prospect.
EXPIRE/DELETE DATE: Enter the date the offer for the prospect expires, or a date to
delete the prospect record. You can use the utility menu to automatically delete prospects
that have expired or are old.
TOUR DATE: This field can be used as a specific note for setting up appointments for the
prospect to see the club. Enter the date and time of the scheduled visit.
NEXT ACTION: The window displays a list of “next activity” selections. (Note that the
selections in this window are user set in the Configuration section.) Reports are generated,
and can be sorted by the “next activity” field.
NEXT CONTACT: Set this date to designate the date the action in the previous field should
be conducted.
To Add a Guest or Prospect to your Database from the Front Counter Module:
1.

From the Front Counter Module, select Areas | Add a Guest.

2.

In the “Add a Guest/ Prospect” window, enter the prospect’s information in the fields.

3.

Click on the “Followup” tab and use the pull-down arrows to choose a category, source,
call back date, etc.

4.

Click on the “Notes” tab to add any additional notes concerning the guest or prospect.

5.

To send a welcome letter, click on <Guest Letter>.

6.

Double click on the letters folder to choose a letter.

7.

Click on the printer icon.
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Inventory Database
The retail inventory database holds all of the information associated with a particular retail
item. Access the inventory database by selecting Data Entry | Inventory, from the menu, or
by selecting the <Browse Inventory> button.
In this display, the column headings include the ID code, product description, retail price,
discount percentage, and current price (includes discount).
From this display, several menu options are available. The “Search” function enables the
user to query the database to find a product not displayed in the current window. Using the
keyboard, just type the first few letters of the record you want to find. Searches are based
on the description field of the database record.
The highlighted cursor bar points to the active retail item in the inventory browse window.
Use the UP/DOWN arrow keys or mouse to move the cursor to the item of interest. Once
the cursor is highlighting the item of interest, any of the menu selections (described above)
can be used.
If an inventory stock is below the reorder threshold value, the item is highlighted to call
attention to the need to reorder these items.
To Enter inventory items into your database:
1.

In the Data Entry Module select Data Entry | Inventory

2.

In the “Browse Inventory” window click <ADD> and enter the ID number assigned to the
retail item. Note: If the UPC barcode label contains six numbers in length (instead of 10),
you should use the scanner to input the ID number. With the cursor in the “Barcode ID”
field, scan the package UPC label.

3.

Enter the description of the retail item.

4.

Click on the pull-down arrow; choose an income account and click <SELECT>.

5.

Enter the sales price in the “Price” field.

6.

Click the up/down arrow button to select a number in the “alert when below” field if you
want to be alerted when the inventory falls below a certain amount.

7.

Click on the “Discount Item” box to reduce the selling price by a specific percentage.

8.

Click on the applicable sales tax button. (Sales tax rates are entered in the Configuration
module under Configuration | Site). Note: If you select “None”, the item is tax exempt on
the POS screen.

9.

Click the box labeled “Skip restocking alert on POS” if you do not want to be alerted when
selling this item.

10. Click the box labeled “Apply membership discounts to this item” if applicable to this retail
item.
11. Click on the “Commissions” tab and enter the appropriate commission level.

Note: You may use one, two, or all three discount levels to compensate various levels of
management. To view the commission rate information, look up the employee record in the
database. To ensure proper tracking of employee commissions, be sure your employees
enter their ID number when selling an item on the register screen.
12. Click on the pull-down arrow to select a commission type and click <SELECT>.
13. Click <OK>.

Inventory Database Fields
Retail inventory database information is entered and stored in the database record in
separate data fields. These fields correspond to the information required to specify the
proper retail item at the time of transaction. In addition, inventory information may be
useful in making ordering reports or for reconciliation of stock inventories.
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Inventory database fields are accessed by highlighting an item in the browse window and
then, either “double click” on the item or, select the ADD, CHANGE, or DELETE buttons
located at the bottom of the display window. Note that there are two “tabs” corresponding to
the inventory database fields: GENERAL, and COMMISSION. The following sections
detail the data entry fields for the retail inventory database:

General Tab
BARCODE ID: This is the ID number assigned to the retail item. This ID code can be any
combination of numbers up to a maximum of 10 characters long. It MUST be unique from
all other retail inventory items in the database. It is recommended that you use the UPC
barcode label number as the ID number. Then, when selling this item you can use a bar
code scanner to read the ID number from the package. A word of caution: If the UPC
barcode label contains six numbers in length (instead of 10), you should use the scanner to
input the ID number. (With the cursor in the BARCODE ID field, scan the package UPC
label.) Some scanners will pad the six-digit UPC with imbedded zeros to yield a ten-digit
code. If you have the six-digit code in the database record and you scan the UPC on the
invoice, yielding a ten-digit code, the proper item will not be located in the database.
DESCRIPTION: Enter the description of the retail item in this field. It is recommended
that you do not use the manufacturer’s name as the first name in this field. Aphelion will
search alphabetically by this field when attempting to locate or display items in the retail
database. If the same manufacturer is on many records you will get an alphabetical list
based on the manufacturer and not on the item.
INCOME ACCOUNT: Select the income account (retail inventory income accounts are
entered in the Configuration section) you wish to assign to the retail item. After highlighting the proper income account, press <OK> to complete the selection. The selection
window will not display all of the income accounts at one time. Use the PgUp/PgDn keys
to display the other income accounts. The Up/Down arrow keys will allow you to scroll
down the complete list of retail inventory income accounts.
SELLING PRICE: Enter the item sales price into this field. When an item is sold from the
inventory database, the value in this field will be displayed in the amount column of the
invoice.
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TAXABLE ITEM: Sales tax will be charged whenever this item is purchased on the POS
screen. The sales tax charge will correspond to the tax rate 1, 2, or both (as is common in
Canadian provinces or larger metropolitan areas) which are entered in the Configuration
area (refer to Configuration | Site Information). A “NONE” selection means that the item is
tax exempt on the POS screen.
DISCOUNTED ITEM: If you wish to put a particular item on sale by reducing the selling
price by a specific percentage, click on the “Discount item” box. A pop-up window will
appear for you to enter the discount percentage. When sold on the invoice screen, the price
will reflect the value of the “Selling Price” field reduced by the percentage entered in this
field. Leaving the “Discount item” box without a check mark will cause the price to
reference the “Selling Price” field without applying any reduction.
ALERT WHEN BELOW: Enter the value into this field that indicates when reorder of item
is required. When the inventory level falls below this number, the operator will be warned
on the POS screen (when selling this item). Also, a report is available that lists all retail
items that have inventory quantities below this level.
ITEMS ON HAND: This value reflects the current number of this item in stock. When an
item is sold on the POS screen, the quantity sold is subtracted from this value to track
current stock status. This number is an automatically computed value.
Note the “Restock,” “Sales,” and “Locations” buttons at the bottom of the “Browse Items”
screen: These buttons allow you to add items to stock, view the History of item sales, and
set club locations for this inventory item.

Restock
To replenish your inventory items, use the <Restock> button. When you select <Restock>,
a browse window is displayed that shows the history of every addition you have made to
stock. This information is used to calculate the Cost of Goods Sold, and to provide accurate
reporting of profit margins.

Discount Coupons
Discount coupons, such as “$1 OFF”, can be accomplished by entering a part number ID
code (user designated) into the Inventory database. The description can be COUPON, and
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the price a negative number. The quantity of coupons issued can be entered into the
Inventory database to allow tracking of the number of coupons or the discounts offered and
redeemed.
Enter the description of any coupons you may offer into the Inventory database. You may
wish to enter an easy to remember code here. For instance, you might select “1000” for the
ID code. Enter other information in the appropriate fields, such as the total number of
coupons printed and a description. Enter a negative dollar amount for the sales price. This
(negative) price will be added to the Invoice when a “1000” coupon is sold (redeemed) on
the POS screen. As coupons are redeemed the inventory amount will be counted down,
allowing you to review the number of coupons that have been redeemed.
When a coupon is to be redeemed, select the item on the Register screen. Enter the ID code
you have selected. In this example, enter “1000” at the prompt for the ID code. This
automatically recalls the description and the negative price (discount) you have entered into
the Inventory database.

Commission Tab
COMMISSION SALES ITEM:
Note that there are three levels of commissions available for each Inventory Item providing
extreme flexibility for your compensation scheme. These levels of commission can be
selected based upon either a fixed dollar amount or a percentage of the sales price. You may
use one, two, or all three levels to compensate different levels of management. Whenever an
item is sold that is commissioned, the commission amount will be credited to the sales
person. To view the commission rate information, lookup the Employee Record in the
database. (To ensure proper tracking of employee commissions, be sure your employees
enter their Sales Person ID when selling an item on the Register screen.)
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FRONT COUNTER POS Button Configuration
The Data Entry menu selection is used to configure the Front Counter POS quick buttons.
The POS quick buttons are displayed on the Front Counter POS screen, and are used to
quickly sell an inventory item.
The POS quick keys are divided into two main areas: Departments and Items. The Item
buttons are specifically assigned to an inventory item. Pressing an Item button allows the
user to quickly sell the inventory item to which it is assigned. Department buttons are
groups of Item buttons. Department buttons are used to categorize the Item buttons, and
allow the user to select from different sets of Item buttons.
This section of the program will allow you to select icons for the Department buttons, and to
assign inventory to the Item buttons.

Pos Buttons
When you select POS Buttons from the Data Entry module, a window is displayed that will
allow you to assign icons to each department, and inventory items to the Item buttons.
You can create “Departments” icons, which will appear on the Front Counter POS screen.
For each “Department”, you can create “items” which will define the inventory products
that will be sold.
To begin setting up the POS system, decide which items you want to sell with the Quick
Keys. (Note that all items in the inventory can be sold via barcode scanning or the card
filelookup. The Quick Keys augment the barcode and lookup capabilities and allow the
selected inventory items to be sold with just “one touch”.
When you have decided which items you want to sell with the Quick Keys, group them into
Departments or groups of items. Each Department can contain any mix of item buttons-they need not be grouped by type. For example, your Juice Bar Department might contain
Items for juice, vitamins, and drinks.
Once you have defined the departments and the items that will be contained in each Department, you are ready to enter the information into the system.
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Departments
Each Department button can be assigned a descriptive label and an icon. The icon is
optional. The icons are selected for each Department using the icon entry field.
We have provided several icons that you may wish to choose from when designing your
ProShop departments. These icons are available in the \Fitness\icons subdirectory. Note
that you can also use your own icons. Icons are available from several sources-- notably the
internet, which is generally free, and commercial vendors.
The <Style> button is used to define a font style, color, and size for the Department description.
The description is displayed in two areas on the ProShop screen. The Department button
can display the description. The description will always be displayed above the Items as
each Department is selected.
If you choose not to display an icon on your Department button, the description that you
enter in the Label area will appear instead of the icon on the Department button. If you
want to display your description in color, you should choose the “Clear” icon. The “Clear”
icon is provided as one of the Aphelion standard icons.
If you are setting up several buttons in one work session, you may want to setup the default
font style, size, and color. The default is set up for each work session using the Setup >
Default Font menu selection.

Items
The Items that are associated with each Department are setup in the “Items” area of the
screen.
There are three types of items that can be assigned to an “Items” button. You can assign
Inventory, Visits, or Personal Training sessions to each button.
To assign an inventory item, select the item from the Inventory browser that appears when
you press the pulldown arrow button located next to the Item area. In a similar manner,
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choose a Personal Training session or Visit from the appropriate tab to assign one of these
items to the button.
To assign a Personal Training item to a button, you must first setup the Personal Training
items in the Data Entry module. Personal Training items must be setup before you can see
them on the Personal Training tab in this area.
To assign a Visit to a button, you must first setup the Visit in the Configuration module.
Visits are treated the same as services. Visits should be setup as services, using the Member
> Services menu as detailed earlier in this chapter.
Personal Training or visits can be sold to a member via the Quick Keys. They can also be
manually added directly to the member’s record in the Data Entry module.
Provision is made to provide discounted pricing for a group of items. A group of items
might include three training sessions, or four visits, etc. To provide discounted pricing for
quantity purchases, use the “extended pricing” area. This entry field allows you to sell
quantities of the selected item at a price of your choosing.
To Configure POS Buttons:
1.

In the Data Entry Module select Data Entry > POS Buttons.

2.

Enter a department name in the first “Label” field (e.g. Food).

3.

Click on <Style> to change font style, size, and color.

4.

Click on the “Folder” icon and choose an image file; then click <OPEN>.

5.

Enter item name in the second “Label” field (e.g. Burger).

6.

Click <Style> to change font style, size and color; then click <OK>.

7.

Click <Next Item>.

8.

Repeat steps 5 thru 8 until all department items are entered.

9.

Click <Next Dept>.

10. Repeat steps 2 thru 10 until all departments and items are entered.
11. Click <OK>.
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Employees
A database for employees is included in the Data Entry area. This option allows the
manager to keep records on club employees. The POS Register tracks the identification
number of the employee. Once an employee logs in, the program will retrieve the name of
the employee and display his/her name on the POS Register.

The menu selections available to the user upon entering the employee database Browse
window are: Add, Change, and Delete. There are four tabs (pages) available for entering
employee information: GENERAL, ADDITIONAL, CERTIFICATION, and NOTES.
An option is available to show only those employees that are active. This will allow you to
view employees that are currently working for you, and to filter out employees that are no
longer active.

General Tab
ASSIGNED ID: Enter the unique employee ID into this field. This ID number is used by
the system for reporting purposes. Login and logout are governed by the employee password, discussed later.
LAST (Name): Enter the employee’s last name.
FIRST (Name): Enter the employee’s first name.
MI: This field is reserved for entry of the initial of the employee’s middle name.
PREFERRED: If the employee uses a nickname or a shortened version of the first name,
that name can be entered into this field.
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ADDRESS: Enter the street address of the employee.
CITY: The employee’s city of residence can be entered into this field.
STATE: Enter the two-letter abbreviation for the state.
ZIP: Enter the zip code of the employee to complete the mailing address.
HOME PHONE: Enter the employee’s home telephone number.
EMERGENCY: Enter the telephone number of the person to contact in case of an emergency with the employee.
SOCIAL SECURITY: Enter the employee’s SSN into this field. This information is
recommended to manage tax records.

Additional Tab
START DATE: Enter the start date for employee in this field.
ACTIVE: If the employee is currently working for you, check the “active” box. When the
employee is terminated, uncheck the “active” box. This entry is used to determine which
employees are currently active in the club, and is helpful when viewing or filtering lists of
employees.
PASSWORD: Enter a unique “Alphanumeric” password for each employee. This password
will be used when logging into the system, and when using the employee timeclock. (See
Login Security section at the end of this section.)
HOURLY WAGE: Enter the hourly wage for this employee.
CLUB NUMBER: Enter the “Home Club” number for this employee.
COMMISSION LEVEL: Enter one of three Commissions levels available for inventory
items (See “Commission” tab in Browse Items area). As a commissionable inventory item is
sold at the POS Register screen, the commission amount will be automatically computed to
reflect the appropriate commission level for this employee.
To Enter Employee Information Into The Database:
1.

In the Data Entry Module select Data Entry | Employee and click <ADD>.

2.

On the “General” tab screen enter employee information.

3.

Click on <Access Settings>. Note: The <Default Access> button can be used to quickly
setup the access rights for each employee. Once the default is loaded for the type of
employee, you can tailor unique privileges by turning on or off individual selections.

4.

Click on the “ Additional” tab to enter additional employee information.

5.

Click on the pull down arrow and select the employee’s department.

6.

Click on the up/down arrow buttons to select the “Home Club” number.

7.

Use the arrow up/down buttons to enter the start date.

8.

Check the “Active” box if the employee is currently working for you.

9.

Enter a unique “Alphanumeric” password for the employee in the “Password” field.

10. Click the “Certification” tab to add employee’s certification information.
11. Click the “Notes” tab to add messages to the employee’s file. Check the alert box to alert
the employee upon log-in or clock-in.

Certification Tab
Certification: Enter the name, starting date, and expiration of each certification held by the
employee.
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Notes Tab
Enter information that you want communicated to an employee. Check the toggle box if
you wish the employee to be alerted at front counter log-in/clock-in.

Login Security
Every module can be protected to insure only the appropriate employees have access to the
system. The login security can be implemented in a variety of methods depending on the

type of club. The system can be configured to operate with little access control, with
maximum control, or to varying degrees between these extremes. You should analyze your
club to determine how much access control you need. Don’t implement more than you
need, as you’ll be constantly typing in access codes.
The security is implemented at the employee level. Each employee is assigned a password,
along with access to designated areas of the system. When an employee logs-in by typing
his/her security code, the system will only allow access to those screens, areas and modules
for which he has privileges. Since access control is determined at an employee level, every
employee can have independent access authorization.
For those modules where this feature is enabled, an employee will be asked to enter a login
ID whenever they attempt to start one of the modules. (Access control can be “turned off”
at the module level.). If the employee has access authorization, he will be allowed to
continue.
Depending on the employee’s access privileges, many screens within the modules may not
be available to him/her. Some “windows” may be displayed with a simplified view preventing the employee from accessing “information sensitive” detail views. Alternately, a
function may be depicted on the screen without the employee having authorization to
perform that function.
The Login Security system allows “authorized access” to the programs for a particular
employee to be “configured dynamically” based upon “privileges.” Furthermore the employee may be granted limited access to certain modules and be given specific authorization
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to perform certain tasks (functions) within those modules. The Manager or System Administrator can setup unlimited “templates” (Defaults) for their employees, and then customize
those templates for each individual.
To access the Login Security system select Browse Employees | Access Settings. The
resulting screen display contains tabs that correspond to the various modules and to areas of
authorization
within the program: Modules,
Front Counter,
POS, Reporting,
Contracts, Data
Entry, Member
Editing, and
Accounting.
Access to the
different software
modules is
controlled via the
Module tab. In
each of the other
tabs there are
functions related to the tab title that are selectable within each tab.
At the bottom of the Modules tab note the <Default Settings> button. Selecting this button
will show the default access settings (or “templates”) in the system (defaults are created in
the Configure module). The default access templates can be used to quickly setup the
access rights for each employee. Once the default is loaded for the type of employee, you
can tailor unique privileges by turning on or off individual selections.
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Banks
The bank database holds the information associated with a bank used by a member. The
purpose of storing this information is its usefulness when entering banking information into
a member’s account. A typical site will contain relatively few banks when compared to the
total number of members. Keeping a bank database, and using it to enter banking information into the member database on the accounting screen will simplify entering the banking
data.

Bank Database Fields
As mentioned earlier, information is entered into the database record in separate data fields.
These fields correspond to the
information required to identify the
bank for reports and sales tracking.
BANK NAME: Enter the member’s
bank name in this field.
BANK ADDRESS: Enter the street
address for the member’s bank in
this field.
BANK CITY: Enter the city in
which the member’s bank is located
in this field.
BANK STATE: Enter the state in
which the member’s bank is located
in this field.
BANK ZIP: Enter the mailing zip
code for the member’s bank in this
field.
PHONE: Enter the bank officer’s
telephone number.
OFFICER: Enter the name of the
person you contact when calling the bank for questions or services.
To Enter Banking Information Into Your Database:
1.

In the Data Entry module select Data Entry | Banks.

2.

In the “Browse Banks” windows click <ADD>.

3.

Enter the banking information in the appropriate fields and click <OK>.
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Groups
The group database tracks the organizations or companies that purchase memberships for
their employees. The group is used to track which members belong to a company or
organization.
The purpose of storing the group information is twofold. First, it is useful when entering
group information into a member’s account. A typical site will contain relatively few
groups when compared against the total number of members. Keeping a group database,
and using it to enter grouping information into the member database will simplify entering
the group data.
Perhaps more important is the ability to track which groups are active, how many members
are in a group, and the facility usage. The group tracking capability will provide this
information.

Group Database Fields
As mentioned earlier, information is entered into the database record in separate data fields.
These fields correspond to the information required to identify the group for reports and
sales tracking.
GROUP NUMBER: This is the ID number assigned to the group. This number can represent your own internal numbering scheme, or the program can assign an ID.
GROUP NAME: Enter the group name into this field.
ADDRESS: Enter the group street address.
CITY: Enter the group city of business.
STATE: Enter the two-digit abbreviation for the state.
ZIP CODE: The 9-digit Zip Code is entered into this field. If only the first 5 digits are
known, enter these digits.
PHONE: Enter the group telephone number. This number will be displayed on the initial
group browse window.
CONTACT: Enter the name of the person you contact when calling the group for questions
or services.
To Enter Group Information Into Your Database:
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1.

In the Data Entry module select Data Entry | Groups.

2.

In the “Browse Groups” window click <ADD>.

3.

Enter the group information in the appropriate fields. Click <OK>. Note: The group
database tracks the organizations or companies that purchase memberships for their
employees. The group is used to track which members belong to a company or organization.

Classes
Classes can be used to track enrollment, class capacity, attendance and standby lists. As
with previous databases, add classes with the <Add> button.
Enter information for capacity, name of the class, instructor, and start and stop times. You
will also need to enter the days of the week the class is conducted.
Instructors are assigned for each class using the employee names that have been entered in
the employee database. Access this list by clicking on the pull-down menu next to the
instructor field.
Members can be “enrolled” in a class. Depending on the class capacity, each member is
assigned an “enrolled” or “standby” status. Members enrolling before the capacity is
reached are assigned an “enrolled” status. Members enrolling after capacity is reached are
assigned a “standby” status.
Once information is entered into the Class database, the members can be enrolled from the
Front Counter module.
The defaulted value of the enrollment status is based on the current class enrollment when
the member is enrolled. The class and enrollment capacity is displayed from the main
database area and from the Front Counter screen.
To view the enrollment, press the <Enrollment> button. A browser will be displayed
showing all members that have enrolled for the class.
To Enter Class Information Into Your database:
1.

In the Data Entry module select Data Entry | Classes.

2.

In the “Browse Classes” click <ADD>.

3.

In the “Update Class” window, click on the “General” tab.

4.

Enter the information for your club’s classes and click <OK>.

5.

Click on the “Sales” tab to enter sales price and sales tax amount if applicable.

6.

Click on the “Commissions” tab to enter commission level and type.

7.

Click <OK>.
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Personal Training
Personal Training is handled in the software in a manner similar to Visits. That is, you can
sell Personal Training sessions, and then count down the sessions as they are used. The
fundamental difference between Personal Training and the Visits is that Personal Training
allows you to track commissions when the session is used. By default, the instructor that is
assigned when you setup the Personal Training session is shown on the check-in screen, but
you can change this if the specified instructor is not available.
Personal Training is sold via the Front Counter POS screen. (Note that the Configuration
section must be used to setup the POS Quick Keys, thus enabling the user to sell Personal
Training sessions.
The personal training browser operates in a similar fashion to the other browsers. The
browser contains a description of the classes, a list of the assigned instructors, and the sales
prices. When you highlight and select a class, two tabs (pages) of information are presented:
GENERAL and COMMISSIONS.
The “General” tab contains a Description field, Instructor field, Sales Price, and Income
Account fields, as well as the Sales Tax option fields.
The “Commission” tab contains information pertaining to sales commissions to be computed based upon a fixed dollar amount or a percentage of the sale price. It also contains a
field for Instructor Commission.
To Enter Personal Training Information Into Your Database:
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1.

In the Data Entry module select Data Entry | Personal Training from the menu bar.

2.

In the “Personal Training Items” window click <ADD>.

3.

Enter the personal training information in the appropriate fields.

4.

Click on the “Commissions” tab.

5.

Note: You may use one, two, or all three levels to compensate different levels of management. To view the commission rate information, look up the Employee Record in the
database. (To ensure proper tracking of employee commissions, be sure your employees
enter their Sales Person ID when selling an item on the Register screen.)

Scheduling
The schedule browser operates in a similar fashion to other browsers. A list of the scheduled groups that you have created is displayed, along with the start time, ending time, and
the duration of each time slot that is to be scheduled.
When you get ready to add appointments to the individual scheduling calendars, you’ll use
the Register screen. The individual scheduling calendars are displayed on the Register
screen when you touch the Calendar Icon.
There are several tiers associated with the calendars. These tiers are as follows: scheduling
groups ( each containing one or more), and scheduling calendars ( each containing one or
more appointments).
Scheduling calendars are sorted according to type. For example, you may wish to view your
courts combined, but your staff separately. The program handles this by sorting each
schedule in a group. These groups are called “Schedule Groups”. A Schedule Group can
contain any number of scheduling calendars, but only the first 10 can be displayed on the
Register Quick Key buttons.
A Schedule Group contains a common starting time, stopping time, and scheduling interval
for all the calendars within the group.
Each group has a tab that displays the individual calendars that are in the group. When you
touch the schedule tab, another browser is displayed that shows the individual scheduling
calendars. Each of these calendars can be named for easy identification.
To Enter Schedules Into Your Database:
1.

In the Data Entry module select Data Entry | Schedules.

2.

In the “Schedule groups” window click <ADD>.

3.

Enter the schedule description (e.g. Tennis Courts).

4.

Enter the start time, interval, and end time by clicking on the up/down arrow buttons.

5.

Click <OK>.

6.

Continue steps 2 thru 5 until all schedules are added.

7.

Click <Close>.
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MARKETING
One of the most effective ways to grow your club is via a systematic approach to marketing.
Effective sales marketing can pull thousands of dollars and plenty of new members into your
club, over and over again, each month.
Systematic prospecting is one of the simplest ways to generate new members, yet it is one
of the least used methods of club marketing. Why? Because the skills necessary to be
effective at prospecting are hard to come by. Plus, the overhead and paperwork are usually
burdensome.

This prospect tracking program provides a proven method to track prospects. It reduces the
time and paperwork necessary to be effective at prospect marketing.
This program is a comprehensive approach to marketing developed by one of the most
successful groups in the country. The effectiveness of this marketing system will pay
dividends in new members, higher retention, and increased cash flow.
Now, before we discuss the system, let’s define what we mean by “marketing”. Sales
marketing is the process by which salespeople identify potential sales prospects, initiate
contact with them, qualify the prospect as to their level of interest, and then follow up.
Several factors distinguish the marketing process from other activities such as “advertising”
and “selling.” Marketing is an active process, and is very personalized. “Advertising” is
usually done on a very broad scale, to a mass market, with the intention of generating
prospects. “Selling” in health clubs is usually done in a one-on-one situation, and usually in
response to a Prospect expressing interest in the club.
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The key is to generate more Prospects! You probably have many qualified Prospects that
you lose track due to lack of an effective process to track these leads.
For maximum success, you should follow a systematic strategy. Here is the system as used
by successful clubs. You can use this system to log your prospects, keep detailed notes of
every call, track follow-up dates, and call back when you say you will.
When you use this system, you’ll find it provides a process to set a call back date for every
Prospect. You can run call back reports each day to find which Prospects need to be called
back. By viewing the notes from each record, you’ll be reminded of prior conversations and
know how to escalate the Prospect to the next level.
Effective Prospect tracking is a system. By effective tracking and follow-up of your
Prospects, you’ll see your sales increasing. This program provides the framework for an
effective system. Use it and you’ll find your membership sales multiplying.

Communications
The Marketing module can utilize the workstation’s modem to perform automated dialing of
prospective members. Modem parameters must be configured to utilize this functionality.
Set the COM port number, initialization string, dialing prefix, and hang-up string used by
the modem. It may be necessary to check manufacturer documentation for these values.
Standard settings are: COM port = 2, initialization string = ATDT, dialing prefix is the
number dialed for outside line, hang-up string = ATH.

104

How to Track Your Prospects
The Marketing module is a specialized Contact Manager software package. The system is
uniquely designed to track prospects in the Health and Fitness industry.
The program will track every guest and prospect that expresses interest in your club or
services. Your salespeople can track phone calls and visits, and make a note of each call’s
results. Designed to allow quick entry of each call, the tracking screen allows you to track
all contact information, including name, address, interest, suggested call back date, salesperson, and the notes for every phone call or visit.
This specialized contact manager is designed to provide the type of reports, tracking, and
analysis you need to manage your club.
When you start the Marketing Module, the opening screen displays the Configuration
options on the left side of the screen, the Report options on the right side of the screen, and
the Marketing icon in the middle.
These buttons and icons are menu shortcuts. The menu along the top of the screen provides
all of these options, plus a few more. You should explore the menu to see all of the capabilities of the program.
By this time, you have probably used the Configure module to setup different membership
types, activities, and discovery methods. If you have not configured your software already,
you will need to setup the program before you can use it.
To start marketing, press the Marketing icon at the top left side of the screen.

The “New Prospect” screen is displayed. The five tabs at the top of the screen (Info,
Followup, Marketing, Personal, and Picture) take you to additional screens where more
prospect information can be entered.
When you enter a new note at the Followup tab, a screen is displayed that will ask for the
note-taker and the note action. The note action will serve to remind and categorize the
types of notes you are adding. Actions and salespeople can be configured.
Set the call back date field to the day you wish to be reminded to call or contact the prospect. There are two date fields that you can use to conduct analysis of the performance of
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your salespeople. The Tour Date and Tour Completed dates are used in the reporting area to
compute the ratio of calls to scheduled tours, and the ratio of scheduled tours to completed
tours. These ratios are used in the reports to compute salesperson performance.

Print Call Back Lists
The software will print a variety of useful reports. Each report provides important information to your salespeople.
Each day you can print lists of prospects that need to be called. These lists can be sorted by
sales priority, call back date, action required, and salesperson. The call back lists include all
the information needed to contact and sell your prospects.
Or, display a list of call backs on the screen. A comprehensive list of the calls that need to
be made can be printed. Each salesperson using these reports will have the tools needed to
effectively manage their prospects.

Simplify Follow-up
Every time a prospect is contacted, place a detailed note in the prospects’ record. Each note
is tagged with the date, the salesperson, and an action item. With unlimited notes, you’ll
have a comprehensive record of each call, which salesperson spoke to the prospect, and the
result of the call. These notes remind your salespeople of the results of the last call, and
provide a sophisticated, quality image to your call. A detailed record of each conversation
allows you to escalate each call to the next sales level.

Track Performance
Tracking performance of your salespeople is important. By analyzing the results of every
call a salesperson makes, the program provides comprehensive information regarding a
salesperson’s accomplishments.
Salesperson performance can be monitored by tracking the number of calls a salesperson
makes, along with the number of appointments, the number of prospects that visit as a result
of appointments, and the number of prospects that turn into sales. Though most good
managers can quickly determine if a salesperson is effective, this tool provides the hard
facts.
Display call performance by number of calls, tour efficiency by number of completed tours,
and sales efficiency by number of completed sales. To use these reports, be sure to complete the Tour Scheduled and Tour Completed date fields.
The report will give a good snapshot of salesperson performance and plot trends.

Analyze Demographics
Tracking the source of your prospects makes good business sense. The Prospect tracking
software will track the source of every guest or prospect and provide a concise image of
where the leads are coming from.
Be sure to setup and use the Source fields. Every time you add a new prospect, set the
Source field so that it matches the way the prospect found out about your club.
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Later, you can print reports that describe the source of your leads, and the number of sales
as a result of the source. You’ll quickly determine the best source for leads, and the best
source for sales.
To Add New Prospects:
1.

In the Marketing Module select Prospects > Add.

2.

Enter the appropriate prospect information in the fields of the “New Prospect” screen.

3.

Click on the tabs at the top of the “New Prospect” screen to add additional prospect
information (Info, Followup, Marketing, Personal, Picture).

To Browse Prospects:
1.

In the Marketing Module select Prospects > Browse.

2.

The “Browse Prospects” screen will pop up. This screen allows you to add, change, delete
and convert prospects.

To Change Prospect Information:
1.

In the Marketing Module select Prospects > Browse.

2.

Click on the name of the prospect that you want to change.

3.

Make appropriate changes to the information contained on each screen by clicking on the
tabs at the top of the screen (Info, Followup, Marketing, Personal, Picture).
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CONTRACT SALES
The contract sales module is used to sell memberships. One method of entering members
into a system is to use a process that is called data entry. Each member’s information is
entered into the data entry area, along with contract payment amounts, expiration dates,
renewal amounts, membership type, and various other information. Another, easier, method
is to setup a contract for a type of membership one time, and then use that information over
and over again when selling memberships. This is the concept behind the Contract Sales
module.
A contract template is created for each type of membership. When you sell a contract, the
information that is associated with the template gets transferred to the member’s record
when you “Approve” the contract. You enter the payment types, expiration dates, renewal
amounts, etc. in the Contract template only one time. When you sell a specific type of
contract, the information is transferred automatically into the membership record. The
Contracts module is divided into three broad areas, represented by the icons on the opening
screen. The <Sell> icon is used in the day to day selling of the plans. This is where you
will select the plan to be sold. The <Contracts> icon allows you to view the membership
contracts that have been sold. These plans are categorized as “approved” or “unapproved”.
Approved plans have been reviewed by management staff, while unapproved plans have not
been reviewed. The <Plans> icon allows you to create contract templates. These templates
are used when selling a membership.
These areas will be discussed in detail further in this chapter.
The Aphelion Sales Maker software is designed to be placed in a salesperson’s office and to
be used as a tool during the sales process. Alternately, the module can be used as a tool to
quickly enter new contracts instead of using the Data Entry module.
Once you setup each contract template, the software displays all of your membership plans
in a browse window. Each contract, and additional information about each plan, is available
to assign to a new member.
Salespersons can use the system to display details of each plan, and quickly provide
payment options to the prospect.
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Plans
The <Plans> icon allows you to create contract templates. These templates will be used
when you select the <New> icon.
To setup your own plans, use the PLANS menu selection to view the contracts. Then, select
ADD to add a new plan. If you have many plans that are similar, use the COPY icon to
duplicate an existing plan and then make minor changes.
Contracts can be broadly divided into those that are for new members and those that are for
renewal members. Filtering tabs are provided if you wish to view membership contracts
grouped by the terms of the contact.
The Sales Maker module will store all of your membership plans. You setup different types
of membership plans, and select which variable terms can be changed by the salesperson. If
enabled, a salesperson can change the downpayment, discount amount, and number of
payments in the plan. The payments are automatically calculated and displayed.

General

The contract template allows you to setup the membership contract defaults. The information is available on several tabs. The General tab is used to categorize the membership, and
default the form of payment.
A contract can be printed every time a membership is sold. The contract can use merge
fields from the software, creating a custom printed contract for each member. Errors on the
contracts can be minimized in this fashion. To use this capability, you must first create a
contract that corresponds to the specific type of membership you are setting up. All of your
contracts may be similar, or you can create a different contract for each type of membership.
Use the word processing capability, described in the Form Letter section, to create your
contracts.
Once you have created a Microsoft Word (contract) document, specify the name of the
document in the field titled “Printed contract file name”. This document will be printed,
along with the merge fields during the sales process.
A similar capability is provided to produce temporary membership cards, club rules,
welcome letter, etc. A Word document can be created with this type of information and can

109

be printed in a similar manner as the membership contract at the time of sale. This document is designated in the field titled “Printed letter file name”.

Payments
The payments tab is used to enter the basic information about the cost of the contract,
including down payment, taxes, and finance rates. The minimum down payment is used to
allow the salesperson leeway during the sales process to discount the membership. If the
minimum down is set to the same amount as the standard down payment, no discounts are
allowed. If the minimum down payment is set to an amount less than the standard down
payment, discounts will be allowed up to that amount during the sales process.
The enforceable payments are used to create an Account Receivable when the membership
is sold. Using this area, you can create an enforceable payment schedule for the membership. Changing the number of months for the contract in this area will cause the program to
use the base cost information to calculate the monthly payments.
The Debit description field is used when adding charges to the member’s record. It provides
a description of the type of charge, and is used in the account browsers or printed statements.

Services/Fees
Select the <Add> icon to add availability of a service or fee to this plan.
Note that these services and fees are initially setup in the Configuration module. Upon
selection the ‘Browse Services/Fees’ window will appear. Choose an item by highlighting it
and clicking the <Select> icon. A ‘Plan service/fee add-on’ window will appear.
Select the Add-on Type, Apply charge, and Number of visits (if V checked).
If Terms, select the Schedule for payments (Note that Payment Schedules are also setup in
the Configuration module) to be used for this add-on. Also assign the pricing to be used
depending upon form of payment (EFT, Statement, or PIF), enter the maximum discount (if
any) permitted by sales persons for selling this plan and renewal pricing (if desired).
If Dues, enter the pricing to be used for EFT Dues and Statement Dues. They may be
different, or the same, as you desire to set them up. If the ‘Per member’ apply charge
(method) is selected, another tab of information must be completed. This tab is labeled,
‘Family member’.
Complete the information in the same manner as in the ‘Primary member’ tab. The service/
fee pricing reflected in this page of information is for each additional family member added
to the Plan.

Notes
Freeform notes can be added to a membership plan for the purpose of clarifying items
unique to a plan or to aid the sales team in their membership sales efforts. During the sales
process, as each plan is highlighted, the pertinent notes will appear in the display window.

Word Documents
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The membership agreement can be printed during the sales process using Microsoft Word.
You must setup the membership agreement document for the printed contract or contract
letters.
In every plan, you can define a Word document template and style files for both the plan and
the contract.
In the template, the user can add useful fields into the document. All the available fields are
stored in \fitness\letters\RptField.ini file. They are grouped in several categories such as:
‘Member’, ‘Contract’, ‘Plan’, ‘Lists’ etc.
The “Browse Membership Plan” window is divided into six tabs (General, Payments,
Services/Fees, Note, and Word Document). The General tab is used to categorize the
membership and default the form of payment.
To Create Contract Templates:
1.

From the Sales Module select Plans | Browse Membership Plans and click <ADD>.

2.

Select a plan type (Open-ended, Terms, or Terms w. Roll-over), and click <OK>.

3.

While at the General tab screen enter the plan description (i.e. Charter Membership,
Executive Membership, etc.).

4.

Use the pulldown arrow keys to choose the default membership type.

5.

Click on the form of payment available with this contract.

6.

Click on the up/down arrows to set the effective starting and ending dates of the contract.

7.

Click on the box if you want to require the salesperson to enter billing information.

8.

Click on the <Available Locations> button to choose club locations where this type of
contract is available.

9.

Click on the “Payments” tab and click on the pulldown arrow to choose a billing account.

10. Click on the up/down arrow keys to set the finance charge amount.
11. Choose one of the following options: “Use Proration,” “Move Billing Date Only,” and
“Proration Fee.”
12. Click on “Use Proration” if you want to charge for a portion until the next billing period.
13. Click on “Move Billing Data Only” if you want to prorate the billing date only--no charges
for the prorated days.
14. Click on “Proration Fee” if you want to prorate the fee.
15. In the “Dues” section, click the pulldown arrow to choose a billing cycle.
16. Click on the “Services/Fees” tab and then click <ADD>.
17. In the “Browse Services/Fees” window, click on the Services tab or the Fees tab depending
on which fee you want to add.
18. Choose a service or fee by clicking on it, then click on <SELECT>. The “Plan Service/Fee
Add-on” window will display. At this point you can review the charges for the service/fee
and click <OK> or make the necessary changes to the fields.
19. Click on the “Note” tab if you want to attach a note to the membership plan. (e.g. “This is a
Charter Membership. This plan can only be sold during pre-sale.”)
20. Click on the “Word Document” tab if you want to print a plan or contract.

Selling Membership Plans
A unique capability is the ability to view each plan, and offer the prospect different payment
options. With the proper authority, the salesperson can provide discounts, change down
payments, and alter the number of months in the plan. When you setup each plan, you
decide which options are to be changed during the sales process. For instance, you may
want the maximum discount to be $100, or the minimum down payment to be $50. These
and other plan options are setup when you create your plans.
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During the sales process, the salesperson can change these parameters, and an affordable
monthly payment can be quickly computed. The system automatically computes finance
charges, down payments, and contract terms when any parameter is changed.
When a member agrees to a plan, the salesperson only has to enter the member’s name,
address and other appropriate information onto the screen form. The system will calculate
all dollar amounts, tender and reconcile cash, check and charge, and automatically print a
legally binding contract. This system reduces errors, miscalculations, and contract problems
by printing the contract automatically.
The system can be setup to print an exact copy of the contract you are using now. You can
setup the program to print a different type of contract, with different terms, for every type of
contract you sell.

Signature Capture
The members’ signature can be captured when viewing the General tab. The program will
automatically capture the member’s signature when a new contract is sold. The system will
store the signature and a copy of the contract. A legally binding contract can be printed,
complete with the member signature. This system will reduce the amount of storage, and
allows you to quickly find a copy of every contract issued. Check with your legal advisor to
be sure that your contracts can be legally binding if the signature is captured electronically.
The <Contracts> icon is used to display the list of membership contracts.
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To Sell a Membership Plan:
1.

In the Contracts module select Contracts | Sell Contract from the menu bar.

2.

Select a membership plan by clicking on it. (View all plans by clicking on the “All Plans”
tab at lower left-hand side of screen.)

3.

Use the up/down arrow keys of the “Add-ons” field to automatically compute the charges of
the membership plan if additional family members were added to the plan. Set the number
of additional members, click on <Show plans/resfresh pricing>. (Notice that the fee totals
change when you click the refresh button.)

4.

Once you have chosen the membership plan to sell, click on <SELECT>. (You will be given
the option to continue by choosing <YES> or you may choose <NO> if you want to go back
and select a different membership plan.)

5.

When you choose <YES> a “New Contract” window displays.

6.

Click on the card deck to choose the prospect’s name.

7.

Click on the prospect’s name, then click <SELECT>.

8.

Choose a “Form of Payment” (FOP) by clicking on EFT, Statement, or PIF.

9.

If the member wants to add a family member to this contract, click on the <+Family> button,
enter the family member’s name, click <OK>.

10. If you want to add services/fees to the contract, click on the <+Service/Fee> button and
choose the appropriate options(s).
11. Enter the contract sales date and effective date.
12. Enter number of free extension months if applicable.
13. Enter the “Dues First Due Date”.
14. Enter additional down payment if applicable.
15. Click on <Sold by> button to enter sales commission percentages.
16. Click <OK>.

Approve Sold Plans
On a case by case or daily basis, the manager can view the plans that were sold. A special
screen shows membership contracts, which can be filtered to show just the new plans.
These new plans are called “unapproved”. Though the membership information is stored
when a contract is sold, each plan must be “approved” before the information is transferred
into the system.
The approval process is used to validate the sale. After the manager has checked that the
appropriate information has been entered into the contract, the contract can be approved.
This process reduces the mistakes made during the data entry process. When the contract is
approved, the system automatically places all the information about the member into the
billing system.
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Using the Approve button, the manager approves each plan. The approval process is used to
validate the sale. The manager should check that the appropriate information has been
entered into the contract. When you place a check box in the “authorization” field, the
system automatically places the information about the member into the billing system.
This process reduces the mistakes made during the data entry process. Best of all, the
billing information gets entered exactly the right way for every member, every time!
Salespersons can display details of each plan and quickly provide payment options to the
prospect in the Contracts module.
To Browse Membership Plans:
1.

In the Contracts module, select Plans | Browse Membership Plans from the menu bar.

2.

Use this window to add a membership plan. You may also change, delete, copy, or print
information in the membership plans from this window.

To Approve a Membership Plan:
1.

In the Sales Module select Contracts | Approve Contracts.

2.

In the “Select Contract for Approval” window, click on the member you wish to approve.

3.

After viewing the contract for correctness, click on the “Contract Approved” box, then click
<OK>.

Contract Add-ons & Upgrades
The Add-on Contract option permits adding services to an active (approved) contract. The
existing add-ons cannot be changed or deleted. The new add-ons will not be effective until
“Approved”. Original add-ons will still be active.
To Add-on a Contract:
1.

In the Contracts module, select Contracts | Add-on contract.

2.

Select the member contract to be added to and click <SELECT>.

3.

Click on <+Services/Fee> to choose additional services.

4.

Click on the additional service(s) required and then click <SELECT>.

Active, Voided, and Expired contracts can be upgraded. A new plan must be selected for the
new “Upgrade” contract. The basic (required) and default plan service add-ons will
automatically be added to the upgraded contract in the same way as for selling a new
contract. Other add-ons in the previous contract will be added too if that add-on is available
in the new plan.
When an upgraded contract is approved, the previous contract will be marked as upgraded
(not active any more). The new upgraded contract will remain as the only active contract.
The user can choose to create a credit memo against the unpaid invoices.
In an upgraded contract, the primary member is not allowed to be changed (lookup button is
disabled).
To Upgrade a Contract:
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1.

In the Sales Module select Contracts | Upgrade contracts.

2.

Click on a member’s name and click <SELECT>.

3.

Make any necessary changes to the membership plan, then click <OK>.

4.

Click on a payment option, then click <OK>.

To View Existing Contracts:
1.

In the Sales Module select Contracts | Browse contracts.

2.

In the “Member Contracts” window you can use the tabs to view contracts by type. (Active,
Voided, Expired, Upgraded, Unapproved, Rejected, All Contracts).

3.

Choose a member by clicking on a name, and then click <View>.

4.

After viewing the member contract, click <OK> to close the window.

Contract History
The history can be ordered by member name, bar code ID, or by Agreement number. There
are six tabs of information, which can be viewed for any member: All Contracts; Unapproved; Active Upgraded; Expired, and Voided. Additional information is viewable by
selecting the <$ Customer> and <$Contract> icons located at the bottom of the screen for
account status information and contract sale information.
To View Member Contract History:
1.

In the Sales Module select the <History> icon at the top of the screen to view the contract
history for any member.
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FRONT COUNTER
The front counter module will provide the functions necessary to automate the front counter.
The following sections will describe the module in detail.
To start the program from the Aphelion Club Management Program Group, double click on
the Front Counter icon.

Overview
There are six major areas within this module, represented by icons at the top of the screen.
These areas are the Check-in Screen, Point of Sale, Prospect Tracking, Class Enrollment,
Class Scheduling, and Timeclock. The Login icon is available in all modules. These icons
are visible along the top of the screen at all times. You can quickly switch from one screen
to another at any time by clicking the appropriate icon.

Taken in order from left to right, the icons are for the Check-in screen, the POS screen, the
Prospect and Guest tracking, Class enrollment, Scheduling, and employee Timeclock. If you
allow the mouse to linger over any icon, the tool tip will describe the function.
If you want to check members into the club, use the Check-in icon. A check-in window will
be displayed.
You do not have to exit one window to view another. For example, you can view the POS
screen by touching the POS icon. When you touch the Check-in icon, you are returned to
the check-in screen exactly where you left. In this manner, you can easily switch between
front counter operations.

Information Windows
Many of the front counter screens have similar capabilities, including searching for more
information about your members. If you want more information about a member, a screen
is available that provides a snapshot of most of the member information. This screen is
available from several areas in the Front Counter module.

116

The member information screen shows a snapshot of the member record, including all of the
member’s accounting transactions and account balance, a list with the most recent checkins, a video image of the member, and any secondary accounts as part of the membership.
To view this information, click the mouse (or touch) anywhere on a member’s name. You
can touch a name for more information on the member history screen, and in the area where
you enter a member’s ID. When you do, a pop-up screen will be displayed that will show
additional member information.
If a name is not visible, you can use the card deck icon to search for the member. Use the
<Card Deck> icon to view additional information.

Check-In Basics
Select Check-in by clicking on the check-in icon.
When you select the Check-in icon, the program will display the check-in window. The
system is then ready for you to enter the ID number of the member. There are several
methods to enter the ID number in the highlighted field. The simplest method is to type the
ID from the keyboard, then press <Enter>. Alternately, you can use a barcode reader to
electronically read a member’s bar-coded ID card. Or, you can search for a member by last
name by clicking the Card deck Icon located next to the ID input field.
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To Check-in Members:
In the Front Counter Module, select Areas > Check-in from the menu bar.
Using barcode ID #’s for member check-in:
1.

Type in the member number in the ID field and press <Enter>.

2.

If the alert is minor, press the green traffic light icon to complete the member
check-in.

3.

If the alert is substantial, press the red traffic light icon to log-in the member having a
problem.

Checking in Members without the ID #:
1.

Click on the card deck icon.

2.

Click on the member’s name and click <SELECT>.

3.

Click on the green traffic light icon to admit the member into the club.

When you check a member into the club, the system automatically checks the member
status, several user set alerts, and several internal program alerts.
If the member has any alert flags associated with his record, such as an expired contract,
account balance due, membership due to expire, etc., the alert message will be displayed,
along with a red and green traffic light icon.
If the alert is minor, press the Green Traffic light icon to complete the member check-in. If
the alert is substantial, press the Red Traffic light icon to log the member having a problem.
When you check-in a member, the program checks the member’s status. The software will
look for account balance, a user message, several user set status flags, expiration date,
contract information, and several internal alerts. If the member has any problems, the
message will appear on the check-in screen.
When a member is checked-in, the name is added to the history window. The history
window will be discussed later in this section.
The CHECK-IN window will remain visible waiting for you to enter the next member ID
for check-in.
When an alert appears, click on any of the alert icons for more information. For example, if
a member has an account balance, the Account Balance icon will appear. When you click
on the Account Balance icon, the member’s accounting information is displayed.
Several additional capabilities are available from the check-in screen to allow you to
determine more information about a member.
When you want more information about a member, click on the member’s name. A window
will pop-up that allows you to view more member information.
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The More Information window will let you see additional member information. You can
zoom in to a specific area of interest by clicking an icon on the screen. The icons located
along the bottom of the screen will show, in order from left to right:
•

Account information

•

Recent check-ins (including date, time and status)

•

Personal training sessions (remaining and used)

•

Class enrollment

•
•

Scheduled appointments
Family members
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Monitored Check-In
In many cases, it may be desirable for each member to check themselves into the club.
There may be an attendant near the counter to monitor the check-ins, however the clerk may
be attending to other duties, and not be right at the computer screen.
In this circumstance, you should use the monitored check-in mode. When configured for
monitored check-in, the display will not pause when there is a status problem with a
member’s account. The display will allow the check-in to proceed, however the member’s
account will be flagged, and the screen will display an alert, if appropriate, for a short
period of time. The Front Counter attendant can visually monitor the check-in, without
having to touch the computer.
This can be useful if the front desk attendant is called away temporarily, or the front desk is
not attended due to a slow time of day. If you have the audio messaging enabled, a voice
message will announce if there is a problem.
The unattended mode is also useful if a turnstile is configured, as the turnstile will not open
if there is a problem with the account. If you wish to configure the system to permanently
startup in unattended check-in mode, use the Unattended Mode option found in the Configuration module.

Browsing Member Notes
Frequently it will be necessary to view the notes that are associated with a member from the
Front Counter.
The Note Browser screen allows you to view the notes that have been attached to the
member’s record. Press the <Next> <Previous> buttons to page through the notes.
An icon is available to <Add a Note>, which will cause the software to display a screen that
allows you to add a new note to the member record.
Since member notes can be specially flagged to display an alert and the message when a
member checks-in, the alert flag can be cleared when viewing the notes. Clearing the alert
flag will prevent the message from displaying when the member checks-in. To clear the
alert flag, and prevent the note from displaying when a member checks-in, select the <Clear
Alert Status> button.
If a member has many notes that are selected to alert upon check-in, you can view only
those notes by selecting the <Display only alerted notes> check box. This will allow you to
view only those notes that are alerted for Front Counter check-in.
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Adding Notes to Member Records
Frequently, a member will have a status problem or issue of some sort when checking-in.
An easy way to let the back office know of the problem or issue is to attach a note to the
member’s record. The <Memo> icon will allow you to attach a note to a member’s record
so the back office or manager can review it.
When you select the <Memo> icon, you can add a free form note. The note is permanently
attached to the member record. All of the notes that are entered from the front counter can
be viewed from the back office at a later date.
To enter a memo, simply type the note in the New Note area. Select <OK> when you are
finished. A “note type” can be
associated with a note. This will
allow easy differentiation of the
notes later. For example, you can
tag a note as a problem, referral,
status, etc. When you run reports,
the information can be filtered to
show only the notes of a specific
status.
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Because many of the issues and problems that are seen at the Front Counter are similar in
nature, you can create “standard notes”. Standard notes can be used instead of typing a free
form note. (Standard notes are setup using the Configuration module). The standard notes
allow the front counter to select a note, rather than having to type it in. As an example,
many members may say their dues have already been paid, when the system alerts that they
haven’t paid. The Front Counter personnel will typically allow the member into the club,
but should send a message to the back for someone to check on the dispute.

To Add a Note to a Member’s Record:
1.

In the Front Counter Module select Areas > Check-in from the menu bar.

2.

After checking in the member, click on the note icon.

3.

Type the message in the “New Note” area.

4.

Click <OK>.

5.

Select a “note type” by clicking on the pulldown arrow on the “action” field.

6.

Select a “standard note” by clicking on one of the options.

7.

Click <OK>.

Browse Member Information
Member information can be obtained at the front counter for any member. To view member
information, select the <Card Deck> icon.
When the Member Browser screen appears, you can check-in a member by clicking on
<Select>, or view more information about the member by
clicking on <INFO>. Additionally, you can change the sort order
to help you find a member by
selecting the appropriate tab
below the list of members.

Member Status History
The Member Status History
function records all status changes
to a member’s record. This
feature is accessible through both
the Data Entry and Front Counter modules. From the “Status History” window, you can add
a new status, change the existing status, or delete a previous status. When adding or editing,
select an available status, attach a reason for the status, define an effective date range, and
attach any desired comments.

To access the Status History window (Data Entry):
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1.

In the Data Entry module, select a member from the “Browse Members” window.

2.

Under the “Personal” tab, select “Status History” in the Status box.

3.

Add, Edit, or Delete desired status.

To access the Status History window (Front Counter):
1.

Open the Front Counter and select a checked-in member.

2.

From the “Member Information” window, select the “Status” button.

3.

Add, Edit, or Delete desired status.

Note regarding Member Status History: if a member status is changed using the “Edit”
button, the selected status is replaced by the edited one. The effect is the edited status is no
longer available in the Member Status History. To record the change of a member status, it
is necessary to select “New.”

Check-In History
The main check-in screen shows a list of all members that have recently checked-in. To
filter the list to show only those members that had alerts, click the tab labeled “ALERTED”,
which is located directly below
the check-in list. This is helpful
to show those members that had
problems. The check-in problem
is listed next to the member’s
name, in order of priority.
To filter the list to show those
members that were denied entry,
click the tab labeled “DENIED”,
which is located directly below
the check-in list. This is helpful
to show those members that were
denied entry.
To show a graphical representation of the number of check-ins, click the “graphics” icon
above the check-in list. This will toggle the screen to show a graphical representation of
check-ins by member category, check-in by hour, or a history list. Once a graphical screen
is displayed, click on the graph to show several different types of graphical information
screens.

Status Date Ranges
This feature allows the status of a member to be set to a specified range of dates in the
future. For example, you can set a member’s status to “Freeze” beginning one week from
the initial date entered and automatically thaw after a three-week period. There is no end
date with a “Terminated” status.

To set the status date range (Data Entry):
1.

Select a member record from the “Browse Members” window.

2.

Select the “New Status” button on the “Personal” tab.

3.

Select a new status and enter effective and ending dates.
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To set the status date range (Front Counter):
1.

Open the “Member Information” window of a checked-in member.

2.

Select the “Status” button.

3.

Select “New”.

4.

Select a new status and enter effective and ending datesAudio Alerts.

Audio alerts are available to alert the front desk clerk if a member has a status problem.
When a member checks-in, the system will announce one of several different announcements, depending on the status of the membership.

Audio Alerts
Audio alerts are available to alert the front desk clerk if a member has a status proglem.
When a member checks-in, the system will announce one of several different announcements depending on the status of the membership.
You can choose which message the type of status announces. Alerts are setup in the
Configuration module.
Voice annunciation is available for:
Account Balance
Scheduled appointment today
Membership status
Birthday
Expiring soon or expired membership
Welcome to the club
See the manager
Rescan your card
Frozen, terminated, or time restricted memberships
And several more . . .

Depending on your club, you may want to use the full compliment of audio alerts or only a
few. If your Front Counter is always attended, you may want to replace the different types
of alerts with one general alert that notifies the front desk clerk.
The system is configured with standard voice announcements that we have recorded in our
Houston facility. You can record your own using a Windows or Windows 95 sound card.

Video Check-In
If you have purchased the video image option, the member picture will be displayed on the
check-in screen. You must first configure the system for your graphics adapter and monitor.
Use the Configure module to setup your system to display the pictures.
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Once the camera is setup and working, three methods of capturing an image of your
members are available. One method is to use the utility available from the Aphelion Club
Management Program Group. This is referred to as the picture capture utility.
Another method is to click the camera icon that shows on the check-in screen. The camera
icon will be displayed as a member checks-in, and on several pop-up information screens.
The third method is to view the member using the Data Entry module. A tab is provided to
display and retake a member photo from this area.
The picture capture utility, available from the Aphelion Club Management Program Group,
is the best method to take all of the pictures of the club members. The database of members
is displayed so it is easy to match the member to his/her picture.
Once you are using the system, it will be more convenient to use the camera icon from the
check-in or data entry modules.
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Advanced Check-in Options
The system will perform additional tracking in addition to just checking member’s status
during the check-in process. The system can track Punchcard Visits, Classes, and Personal
Training sessions available. The default mode, whether on or off, is setup in the Configure
module, but a manual over-ride is available on the Front Counter screen.
During check-in, the system can monitor a member’s account, and notify the clerk if the
member has personal training sessions, visits, or is enrolled in a class. If an activity is
found, a screen is displayed allowing the operator to decrement an activity, check-in the
member to a class, or use a personal training session.

The system can be setup to always show the activity selection screen, never to show it, or
only show it if a member has an activity.
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An icon is provided on the Front Counter screen that will allow you to toggle to any of the
three modes. The icon is a three position switch, and will allow either On, Off, or Next.
During busy times of the day, it may be preferable not to delay all of the check-ins to
display the member activities. If
you don’t want to display activities, choose the OFF mode, which
is selected by clicking the icon
until it shows OFF.
During slow times of the day, you may wish to check every member as they arrive to see if
they have activities, and to ask if they would like to use one when they check-in. This mode
is referred to as the “smart” mode. To choose smart mode, toggle the icon until it shows the
check mark. In this mode, the program will check every member as they are checked-in,
and display activities if they are available.
During busy times, it may be necessary to toggle to the activity mode from time to time. To
do this, toggle the icon until Next is displayed. The activity display will only show for the
next check-in. This will be helpful, for example, if a member alerts you that he wants to use
a personal training session, or count down a visit he has purchased. Toggle to the Next
mode, then check-in the member. The activity screen will only display for the member,
then revert back to the Off mode.

ACTIVITY TRACKING
If you want to track which service a member uses during check-in, turn on the “use activity
tracking” selection in the Configuration module. This feature allows tracking member
check-ins on an activity basis. (Services are defined in the Configuration module.)
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When this mode is selected, the Regular mode check-in will require a service to be selected.
This allows you to monitor which services within the club are utilized. Additionally, you
can restrict access to certain services, based on membership types.

When operating in “Attended Mode”, and if tracking is enabled, the complete set of
services are automatically displayed in a selection window once the membership ID is
entered into the check-in window.
“Allowed” services, based on the membership type, are shown with a Yes in a Pop-up
window. Choose the service with the Up/Dn arrow keys, and then press <Enter>. If a
restricted service is selected, the operator is prompted with by an alert that says that a
restricted service is selected. He should decide whether to continue the check-in. For each
membership type , any combination of services can be selected as an allowed entry. If a
member is not assigned to an allowable service, his check-in is denied.
The configuration modulewill let you assign the defaulted service by workstation. The
default service is setup in the Configuration module. If a terminal is usually used for a
specific service, then you should set that service as the default so you don’t have to use the
up/down arrow keys to find the proper selection each time a member is checked-in.
If tracking is disabled, all members are checked into the “General Facilities” area. If the
activity tracking is configured “off” in the Configuration module, the service filter is
skipped.

To Turn On Activity Tracking:
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1.

In the Configuration Module select Station > Checkin Settings from the menu bar.

2.

Choose “always prompt for activity” and/or “always prompt for classes.”

3.

Click <OK>.

Punchcard Check-In
Punchcard check-in is used to check-in members when they have purchased a certain
number of visits to an activity. This type of check-in will be useful for tanning beds, Apex,
court time, or special memberships where facility usage is limited. This type of countdown
is called Punchcard or Visit Units because the system will count down visits.
(VISIT UNITS are sold to a member from the ProShop.
Each member can purchase a number of visits to club services. This visit account is then
decremented when the member checks in to an activity. The number of visit units required
for entry will be compared to the number of visit counts remaining in the member’s visit
account to verify a sufficient balance. To add visit units to a member account, use the VISIT
function key available on the POS screen. Refer to the POS Register for more information.

Personal Training Tracking
Personal Training sessions are very similar to the Punchcard capability, whereby a member
purchases sessions from the ProShop, and uses them as he/she checks-in to the club. A
distinct difference is the capability to track and pay commissions for training since training
is normally commissioned and the instructor is tracked. Reports can be run to determine
commission levels. Commissions can be paid when Personal Training is sold, reflecting the
individual who conducted the training.
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Every member can purchase any number of Personal Training sessions. The program
manages the account, keeps track of sessions remaining, and sessions used. When a session
is used, the software tracks who conducted the training, type, and time.
When you initially setup the Personal Training session to be sold, you specify an instructor.
When a Personal Training session is used, the instructor is defaulted to the instructor that
was originally setup. Since this instructor is not always available, you can change the
instructor by clicking on the <Card Deck> icon.
To add Personal Training sessions to a member’s account, Sell a Personal Training session
from the POS screen. Refer to the POS Register section to learn how to sell Personal
Training.
To add Personal Training sessions so they are available for sale, add training sessions in the
Database module. Use the Configuration module to setup the quick buttons on the POS
screen so the sessions can be sold.

Personal Training / Visit History and Adjustment
The “Personal Training / Visit” window displays a history of purchase/usage dates and
remaining credit for a selected member. This window is accessible from both the Data
Entry and Front Counter modules. In the Data Entry module, the “Personal Training/Visits”
window allows you to adjust a member’s credit without creating an invoice. Personal
Training and Visits credits cannot be manually adjusted from the Front Counter module.
Automatic adjustment of member credits is performed through the Front Counter Point of
Sale (to increase total) and a visit tracking enabled check-in (to deduct).

To access the Personal Training / Visits window (Data Entry):
1.

From the “Browse Members” window, highlight the desired member.

2.

Select the “View Training / Visit” icon.

3.

Use the “Adjust” button to add or remove visits and/or training.

To access the Personal Training / Visits window (Front Counter):
1.

Open the “Member Information” window by selecting a checked-in member.

2.

Select the “Personal Training” icon to view the history window.

Personal Training and Visit Expiration
Set expiration dates for sold or adjusted Personal Training or Visit credits. Expiration dates
are set during the Point of Sale or by adjusting a member’s Personal Training and Visit
credit in Data Entry (see above). To apply an expiration date to existing training or visit
credits, it is necessary to add new credits (with expiration dates), then adjust the account
with the appropriate amount of negative credits to balance the account.
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To set an expiration date at the Point of Sale (Front Counter):
1.

Select a Visit or Personal Training item to sell in the Front Counter Register

2.

Click the displayed item in the “Receipt” window to display transaction details

3.

Locate the “Expires on” field and set the date

Batch adjustment of member Visits credits and Expiration Dates (Reports):
1.

In the Reports module, select Utilities > Batch change Visit counts

2.

Select a member record filter type

3.

Place a check next to the visit service(s) to update

4.

Select how you wish to modify the existing visit count

5.

Enter the modifying number

6.

Enter new expiration date

7.

Select OK

Class Tracking
If you always want to track which class a member attends when he checks-in, turn on the
“use activity tracking” selection in the Configure menu. This feature allows tracking
member check-ins on a class basis. If you want to track classes on an occasional basis, use
the <Tracking> icon to turn on tracking as needed.
Classes are first setup in the Database area of the program. Check-in to a particular class
can be restricted by prior enrollment in the class. If a member is not enrolled in a class, his
check-in is alerted. Choose the class by scrolling in the class list. If a member is not
enrolled in the class selected, the operator is prompted with an alert, and should decide
whether to continue the check-in.
When operating in “Attended Mode”, and if tracking is enabled, the Class Attendance
choice is automatically highlighted in a selection window once the membership ID is
entered into the system.
Classes are shown for the day only. If a class doesn’t appear, it may be because it is not
held on today’s date. A provision is made to check-in to a prior class by changing the date.
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Check-In Alerts
Alert messages are used by the program to inform the user of special situations when a
member checks-in. These messages are displayed on the screen and are enunciated by a
beep from the computer. If you have a sound board in the PC, voice messages can be
played to enunciate various check-in alerts.
Various alerts are available. For instance, incorrectly scanning a member’s ID number will
cause the message “Please re-scan your card” to be played. Other types of alert messages
warn the operator of an unusual status regarding a member.
As an icon is displayed, click on the alert icons to find more information about the alert.
For example, the Account Balance icon will alert if a member has an outstanding balance.
Click on the alert icon to see the account transactions.
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Account Balance
If a member owes money from previous charges or membership dues, the program will alert
the user at the time of the transaction. The window displayed includes a message that there
is an outstanding balance, and shows the balance and 30-60-90-120 day aging Status Alert
If a member’s status is not OK, an alert will be displayed. You can set the Alert names for
the alert messages in the Configure section.You can set each member’s status in the
Member’s record in the Data Entry module or from the PopUp window in the Front Counter
module. Status changes can be accomplished by choosing a different status in the “Status”
field of the member database record.
The member status can be used to alert employees to take specific action with regard to
certain members (i.e. do not accept personal checks from the member, etc.). Also, members
that need to update their member information can be singled out for operator prompting.
The message that you entered into the Status Message field in the Member’s record (in the
Data Entry area) is also displayed at the time of check-in.

Restricted Times Or Restricted Activity
An alert window will appear if the member checks-in during restricted hours. The restricted
hours are setup in the Configure section as part of the Member Category. Each membership
category can have hours that are allowed and disallowed. When a member checks-in during
disallowed hours, the alert screen will appear.

Insufficient Visits
The Insufficient Visit alert will appear if an attempt is made to check-in a member requiring
more visits than are available in the member account.

Expired Membership
If the member’s contract expiration date has been passed, an alert will appear on the screen
when the member attempts to check-in. The expiration date of the contract will be displayed. Members can be set to “open end” contracts if you wish this alert to be avoided.

Expiring Soon
When a member’s contract expiration date is within a preset number of days of the current
date, an alert is displayed on the screen when the member attempts to check-in. This alert is
used as a member retention reminder, and can be used as a signal to sell the member a new
contract.
The number of advance days can be set from the Configure section, under the Site menu. A
field is displayed allowing you to set the number of advance days to be alerted of impending
contract expiration.
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Other Alerts
Various other alerts are provided for other types of status messages.
When a member checks in to the club, and it occurs on the member’s birthday, an icon of a
birthday cake is displayed.
For those members that have an expired Credit Card on file when they check-in, the icon
that is displayed resembles a credit card sliced in half.
When a Membership has been put on hold, or is on Freeze status, the icon is an ice cube.
When a potential member(Prospect) checks-in, the system will display a welcome mat icon.
For those members that have a locker that will expire or has expired, the status icon is a
lock.
When a member tries to check-in more than one time in a day, we show the dual check-in
icon (note that this can be configured so that the program will not check for dual check-ins).
Terminated members display an icon that resembles a headstone.
And for those members that haven’t been in for awhile an icon of a couch potato is displayed.

134

Point of Sale & Cash Register
The Register screen serves as the major focus for the Pro Shop sales. All ProShop sales are
handled on the Register screen. The Register screen will conduct sales transactions,
calculate sales charges, sales tax and change. Information on the display is used to update
the databases (the area where all information is kept) and to store the transaction for record
keeping purposes.

The information that is required to complete the Register is entered into areas of the
Register called fields. A field is an area for data entry. When a field is available for
modification or data entry, it will be highlighted and the cursor will be positioned within the
highlighted field. Enter the desired information into the field via the keyboard then press
the <Enter> key to move to the next field.
The Register screen is separated into distinct areas on the display. These areas divide the
screen in a logical fashion and separate the different areas of use. The Register is graphically displayed as a receipt portion on the lower left, department buttons in the middle of
the screen, items within a department on the right side, and a manual item entry area at the
top right.
Information pertaining to the member is displayed on the top left portion of the screen
display. Tracking the member Information is optional, and displayed in this area to support
the transaction.
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Register Operation
The Register has several ways that can be used to sell an inventory item. The software is
designed so that you can sell items with different methods, depending on the circumstances.
To sell an item, you can:
Scan the UPC code
Manually enter a barcode ID
Use the “quick keys” that you set up with your most sold items
Lookup items in the database browser if the barcode is missing

Selling Inventory
The program is designed to read UPC barcodes using a barcode reader or laser scanner.

To sell an item by scanning the UPC code:
1.

In the Front Counter Module select Areas > Register.

2.

Enter the UPC code by scanning the barcode ID. (When you scan the UPC code, the item is
displayed in the Receipt area of the screen.)

3.

Press <TOTAL>.

4.

Press the form of payment button.

To sell an item without a scanner:
1.

Enter the item ID in the ID field.

2.

Press <Enter>. (When you manually enter the ID code, the item is displayed in the Receipt
area of the screen.)

3.

Press <TOTAL>.

4.

Press the form of payment button.

To sell an item without item ID #:
1.

Press on the card deck icon. (A brows window will be displayed allowing you to see the
entire inventory of the ProShop.)

2.

Press on the item and press <SELECT>. (When you find the ID code in this manner, the
item is displayed in the Receipt area of the screen.)

3.

Press <TOTAL>.

4.

Press the form of payment button.

The fastest method to sell an item is to use the Quick Key departments and Items. (Each
Quick Key is linked to specific inventory items that you have in your ProShop. Use the
Configure module to setup these keys for your facility).

To sell an item using the Quick Keys:
1.

Select a department Quick Key by pressing on it. (When you select the inventory item in
this fashion, the item is displayed in the Receipt area of the screen.)

2.

Press on an item Quick Key.

3.

Press <TOTAL>.

4.

Press a payment button.

As you sell items, the Receipt area scrolls to show each item. As you sell items, you are
creating an Invoice to handle the transaction. If you enter a member’s name on the Invoice,
it will be logged and tracked by member ID. If a member’s name is not recorded, the
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Invoice will be tracked as a cash sale. There is no limit to the number of items you can sell
on one Invoice.
When using the Card Deck icon you may see a keyboard icon. This icon is for those users
that have a touchscreen and do not have a keyboard. The keyboard can be used instead of a
keyboard

Once the product code has been entered, Aphelion software will supply the description of
the product in the receipt area of the Register.

Changing Prices, Quantities, And Discounts
To change the quantities or pricing, click on the item description in the Receipt area. When
you click or touch on the item description, a window appears that will allow you to edit the
transaction. You can change the quantity of the item (default value is 1), add a discount, or
change the price. The sales price, which is obtained from the inventory database record,
shows the total dollar amount for that particular item.
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You can control the ability of your front counter personnel to edit the pricing on the Register
screen by turning on password protection for pricing changes.

To Change Prices, Quanities, and Discounts from the Register:
1.

In the Front Counter Module select Areas | Register from the menu bar.

2.

Press a Department quick key, then press an item key.

3.

Press on the selected item in the receipt window (this will bring up the “Edit Inventory
Transaction” screen).

4.

Enter the necessary changes and press <OK>.

Miscellaneous Sales
If the item does not have a code or the code is not available, the clerk may wish to not enter
any code. The “Miscellaneous item” function will allow you to sell any item, and the user
can change the description as necessary by typing a descriptive phrase. Any sales transactions that do not have product ID numbers are stored as miscellaneous sales items.
If the operator wishes to sell an item that has not been entered into the inventory database,
the procedure is as follows: Press <Enter> with the cursor positioned on the ID field, with
no ID number entered. Change the description, price, quantity, and tax status of the item in
the Miscellaneous sale window. Press OK when finished editing the item. Sales transactions of this type are tracked, for accounting purposes, as miscellaneous inventory sales.

To Sell an inventory item by scanning the UPC code:
1.

In the Front Counter Module select Areas | Register from the menu bar.

2.

Enter the UPC code by scanning the barcode or manually enter the barcode ID and press
enter. (When you scan the UPC code, the item is displayed in the Receipt area of the
screen.)

3.

Press <TOTAL>.

4.

Press payment button.

Low Inventory Quantity
When you sell an item that is low stock, an Inventory alert will appear indicating the
inventory quantity of an item is below the reorder threshold. This will remind the user to
reorder the item before it’s stock is depleted. Reorder thresholds are setup when you enter
your inventory. Reorder reports can be produced that will list all items that are below the
reorder threshold.
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Completing The Sale - Total Key
The Total key directs the program to complete the Invoice. The Total key does more than
add the amounts on the Register. This key directs the system to store the information
contained on the display in the computer and to update the database with this new information. The Total key is displayed only after an item appears on the Receipt area of the
screen. The transaction is not complete until the Total key has been pressed.
When you press Total, the screen changes to display the form of payment-cash, check credit
cards, or the member’s account. You can also choose from several quick cash keys. When
you choose the form of payment, all items that have been sold are added together. The
program calculates the subtotal, adds tax, and then computes the total.

Form of Payment
The form of payment information is tracked separately and is displayed in the cash reconciliation report.
Once you select the form of payment, you will be prompted to enter the amount tendered.
The default value that appears in this field is the amount due. If an amount is entered into
this field that is different from the amount due, change will be automatically calculated and
the transaction will be completed. A receipt will be printed and the cash drawer will open
when the transaction is complete.
The Payment screen for cash, check and credit cards are similar. The payment screen for a
check includes a field to add a reference number, such as the check number. The payment
screen for the credit card includes a similar field.
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If you are transmitting your credit card payments electronically to the bank, a second
window will appear when selecting credit card as the form of payment. This will allow you
to swipe the credit card and transmit the transaction to the bank

If you enter a credit card that is invalid, the program will alert you that you may have an
invalid credit card.

On-Account
All sales that are conducted from the Front Counter can be placed on a member’s account.
To place a sale on the member’s account, select the <On Account> button as a Form of
Payment.
The <On Account> button will not be available unless you have entered a member on the
screen.
If <On Account> is selected as Form of Payment, the account debit window will be displayed. This window will show the member’s current account balance (prior to the current
transaction) and the total amount due on the current invoice. The operator is prompted to
enter any changes and a due date.

140

When the Account Debit screen is displayed, there may be an option to change the number
of payments and the due date between payments. This option will be displayed if you have
the appropriate security level. If you don’t have the proper security level, you will not be
able to change the number of payments or the time between payments.

A default Billing Account is also displayed. Again, if you have the appropriate security, you
will be able to change the Billing Account. If you don’t have the proper security level, you
will not be able to change the Billing Account.
When you sell an item on a member’s account, the program checks to see that you have not
exceeded the credit limit that you have specified for the member. If you have exceeded the
credit limit, and if you don’t have the proper security level, the program will alert you and
not allow you to proceed. If you have the appropriate security level, you can override the
credit limit.

To Sell Inventory Items On Account:
1.

Press on the card deck icon to select a member.

2.

Press on a member’s name and press <SELECT>.

3.

Select an inventory item for sale and press <Total>.

4.

Select the <On Account> button as the form of payment. (This will bring up the “Account
Debit” screen for the member.)

5.

Press <OK>.

Split Tender
Split Tenders are necessary when the customer wants to pay for the purchase with more than
one type of payment. For example, he may wish to place $25 of the purchase price on a
credit card, and the balance to be paid by check.

141

When you select Split, the system prompts you to enter the first form of payment, then the
second form of payment. When you have selected the payment types, the “Receive”
payment screen is displayed and allows you to enter the amounts for each type of payment.
The transaction is completed normally at this point.

To Enter Split Tender Sales:
1.

In the Front Counter Module select Areas > Register from the menu bar.

2.

Select an inventory item for sale and press <Total>.

3.

Select the <Split> button.

4.

Press payment #1 button.

5.

Press payment #2 button and enter payment amount.

Returns
It may be necessary to return an item previously sold to the customer.
To return merchandise, scan the item, enter the ID, or touch (click) the item in the Quick
Key area. The item will appear in the Receipt area as if you were selling it.
Press the <Return> key. A message will appear asking if you want to return the item to
stock. If you press <Yes>, the program will add the item back to the stock, and increment
the inventory quantity for the returned item. If you select <No> at this prompt, it will cause
the program to assume the merchandise is defective and not add it to the existing inventory.
The item will show as red on the receipt area. Complete the transaction by pressing the
<Total> key. Select the Form of Payment to return to the customer. The Receive payment
screen will be shown, but the amounts will be negative, indicating you should return the
appropriate amount to the customer. The cash reconciliation will be updated accordingly.
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Cash Out
To track cash removed from the cash drawer, sell a Miscellaneous item. Modify the
description of the transaction, change the tax status to None, and enter the dollar amount.
Enter any descriptive note in the DESCRIPTION field. Enter the cash payout amount
(positive value) in the PRICE area.
Now, press the Return function. The AMOUNT field will show the negative amount
reflecting cash removed from the system.

Clear
Use the <Clear> button to erase all lines entered on the receipt. The Clear command allows
the user to remove all of the transaction lines on the Receipt, and start over with a blank
Register screen.
If you wish to cancel the one transaction line, click on the item. A screen will appear
allowing you to modify the transaction, including deleting it altogether.

Payments
The PAYMENTS key is used to record payments to a member’s account. This is useful to
track walk-in payments for each member, handle checks, or accept payments for a member’s
account.
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In order for the Payment key to be visible, you must have a member visible on the screen.
If a member is not on the screen, enter a member ID. The Payment icon should now be
visible.
The Payment key is used to accept a payment for the member’s account.
When you press the Payment key, the Receive Payment window is displayed.

Depending on your access level, you will see either a detailed entry screen or a simple entry
screen. The screen that is displayed is based on your access level. The simple access screen
will not allow you to apply a discount, or to apply payments to a specific charge, only as an
open payment. The detailed access screen allows discounts, and payments to be applied to a
specific charge.
Typically, you will provide access to the simple screen for your front counter personnel,
while the manager may have access to the detailed screen.
The simple access screen only allows payments to be made against the account, and does
not allow you to designate which charge the payment is for.
After entry of the dollar value of the payment, the user is asked to enter the effective date
(usually this will be the current date which is already shown in the field).
A “Memo” field is provided for the user to enter any special notes regarding the transaction.
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Discounts
When selling a ProShop item, you may wish to provide a discount to your member. The
discount function allows you to quickly discount the selling price by a fixed percentage, or
by a dollar amount.
To discount the selling price when you are selling a ProShop item, double click on the item
on the Receipt area of the screen. The “Edit Transaction” window will appear.
Enter the desired percent discount (when entering the discount percentage use 10 for a 10%
discount, not 0.10).
If the password protection is enabled to limit price changes, the user will be required to
enter a password before he can apply a discount.

Seller
The program automatically tracks which salesperson has conducted each transaction. Each
salesperson is assigned an employee ID number in the employee database. When you login
to the Front Counter, the program assumes that this is the employee that is conducting the
sale. A record of the transaction is made that includes the employee’s ID number.
This field may be used to trace which salesperson completed a particular transaction, or to
track productivity of the sales personnel. All sales by a particular salesperson, as well as
commissionable sales can be tracked and commissions paid on selected items. This function allows tracking of which salesperson completed a transaction.

Selling A Membership From The Point Of Sale
Some clubs will sell a membership from the front counter. One advantage of this process is
that the sale is processed as an inventory item. The payment or partial down payment can
be collected and processed as all other inventory sales. Selling a membership in this fashion
is very quick, however much of the data that can be captured with a membership sale is lost,
as the program is really only selling an inventory item called “membership”.
To sell a membership from the Front Counter, you must have a name in the “sold to” area of
the POS screen. If the new member has been previously entered into the system as a
prospect, enter the prospect ID. If the new member has not been entered into the system
previously, you must first place some information about the new member into the system.
To add a new member record from the Front Counter, touch the blank area of the POS
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screen that normally contains member information. A screen will appear to add a minimum
amount of member information.
Now that you have a prospect or new member in the “sold to” area of the POS screen, you
can complete the transaction by selling a membership inventory item. Prior to this step, you
should have entered several of your membership types into the inventory area to allow you
to sell these items. When you sell a membership from the POS system, it will have the
effect of processing the membership as an inventory item, and allow tracking and reporting
of the membership sale later by using the POS transaction reporting.
As you complete the transaction, choose the SPLIT function for form of payment. Split the
membership into an “On Account” portion, and a cash, check, or credit card portion
(depending on how the down payment is paid). The split will allow you to put part of the
membership on the (new) member’s account, and to accept the down payment as cash,
check or charge.
When the transaction is complete, a receipt is printed, and the future membership payments
will appear in the member’s account.
Later, you will use the Data Entry program to convert the new Prospect into a Member, or to
add additional information to the new member’s record. You can add the rest of the membership information, such as billing information, account numbers, etc.

To Sell A Membership From Front Counter POS Register:
1.

While in the Front Counter Module POS screen select Areas | Register from the menu bar.

2.

Click in the upper left-hand area of the screen where member information usually appears.
(The cursor will change to crosshairs.)

3.

The “Member Will Be Added” screen will pop up. Type in the appropriate new member
information.

4.

Click <OK>.

5.

Click the card deck icon in the “Choose Item” area of the screen.

6.

Select a membership type and click <SELECT>.

7.

Click on a form of payment button.

Selling Visits and Personal Training
Visits and Personal Training units are similar in that they operate similar to a “punchcard”
that is punched each time a member uses his card. The member purchases visits to a club
service or personal training and the system counts down each usage until all purchases are
used. The “punchcard” in this case is electronic, and the system keeps track of many
“punchcards” for each member.
Visits and Personal Training sessions are sold from the ProShop screen and decement each
time the member is checked-in for a particular session at the Front Counter.
When you sell a Visit or Personal Training session to a member, the system will add the
appropriate amount of visits or personal training sessions to the member’s record. The Visits
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are then used to track the number of times a member can attend different club services or
obtain Personal Training.
Members can purchase a certain number of visits to each service in the club. This is useful
for selling usage of your tanning beds, nursery visits, or special memberships where facility
usage is limited.
Members can purchase a certain number of Personal Training sessions also. This is useful
for selling and commissioning the Personal Training segment of your club.
One fundamental difference between visits and personal training is that the personal training
is tracked by instructor so commissions can be paid. Visits are to areas of the club, and are
not tracked by instructor.
Visits and Personal Training are sold to a member, and then counted down when the
member is checked-in. The number of visit units required for entry will be compared to the
number of visit counts remaining in the member database. If the member has enough visits
remaining, the check-in will proceed. If the member does not have enough visits, an alert
screen will be displayed.
Before you can sell Personal Training, you must have your Personal Training sessions
defined. Personal Training sessions are setup using the Data Entry module.
Before you can sell Visits, you must have different services defined. You sell visits to the
different services that you have setup for your club. Services are setup in the Configuration
module.
To sell Personal Training, setup the training items in the Data Entry module, then setup the
POS buttons in the Configuration module.
To sell Visits, setup your club services in the Configuration module and then setup the POS
buttons in the Configuration module.
Before you can sell Visits or Personal Training, you must configure the POS buttons for
each Visit or Training item. To setup the POS buttons for visits or training, use the Configure module.

To sell a Visit or Personal Training session from the Front Counter:
1.

In the Front Counter module select Areas > Register.

2.

Select the Quick Key icon for the appropriate item. (To sell multiple sessions or visits,
simply change the quantity or touch the Quick Key again to add another item to the
Receipt).
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3.

Enter the member’s ID number and press <OK> or press on the card deck icon, click on the
member’s name and press <SELECT>.

4.

Press <TOTAL> and then press a payment key.

If a member is not selected in the “Sold To” area of the screen, the system will prompt you
for a member’s ID. A member must be selected to sell Visits or Personal Training sessions.
When the transaction is completed, the member’s account will reflect the total number of
visits that were credited to his account.
To check a member in using either the Visit or Personal Training sessions, be sure the
check-in screen is set to display the Visits or Personal Training mode. You can manually set
the check-in screen to display Activities and Personal Training by selecting the <Next> icon
prior to each check-in. Alternately, turn the system to smart mode, whereby it only displays
the activity or Personal Training if a member has purchased these units.

Commissions
When creating and editing inventory, personal training, classes, and services, you will notice
a new “Commission Type” field on the “Commissions” tab. This field communicates with
the Commissions module only. Other commissions-related fields are used in the same
manner as in Version 2. The available reports for commissions systems not using the
Commissions module are (from the Reports module): Instructor Commissions (under the
Training menu) and Sales by Salesperson – both Cash and Accrual (under the Employee
menu).

Split Sales Credit
For commissions purposes, up to three employees can split a single invoice total by percentages.

To split sales credit (Front Counter):
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1.

At the Point of Sale, select the “Sold By” button before payment is tendered.

2.

Enter the Employee numbers of the salespeople to be split

3.

Set percentages of credit for the individual salespeople

Sell Classes
Class attendance can be sold through the Point of Sale. In addition, you can set commissions information regarding it’s sale. To take advantage of this feature, it is necessary to set
the sales information for each class in the Data Entry module.

To set sales / commissions information for classes:
1.

In the Data Entry module, select the “Classes” icon

2.

Select a desired class and “Change”

3.

Under the “Sales” tab, enter a sales price, tax information, and income account

4.

Under the “Commissions” tab, enter commission levels and type

Z-Out
The Z-OUT function provides a method to zero the cash reconciliation for each shift that is
working the front counter. The Z-OUT function does not affect the cash reconciliation for
the day or the system total.
To Z-OUT, click the <Z-Out> button. The station cash reconciliation will be zeroed, and
ready for the next shift.
Z-OUT will be password protected if you have selected in the Configure section.

Invoice History And Void
The Invoice History screen is provided to view, void, or reprint prior Invoices. When you
press the <History> button, a window is displayed that contains a list of today’s Invoices.
Each Invoice is sequentially listed in the window on the left, while the details of the Invoice
that is highlighted are shown on the window on the right. If the member’s name was
recorded during the transaction, the member’s name is shown in the window at the left. If
the member’s name was not recorded during the transaction, the Invoice is recorded as a
Cash Sale.
To view the details of a specific Invoice, highlight the desired Invoice in the left window.
The details will be displayed on the right window.
As you scroll through the Invoices, additional information is displayed relative to each
Invoice, including the transaction details, salesperson, which workstation completed the
transactions, the subtotal, tax, and total.
If you wish to Void an Invoice, highlight the Invoice, then select the <Void> button.
If you need to reprint an Invoice, highlight the Invoice, then select the <Print> button.
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Prospect and Guest Tracking
Guest or club Prospects can be entered into the system to track potential new members.
Prospects are tracked similarly to members, but are shown and tracked separately in the data
browsers.
Prospects entered at the front counter will be visible in all other modules, including the
Marketing module.
Our icon for guest tracking is a prospector mining for gold, as every guest is a potential
member. Select the GUEST / PROSPECT icon; a screen with several tabs will be displayed
to enter tracking information. As you add a new Prospect, you can enter only a minimum
amount of information, such as name and address. Or, you can enter more details, such as
follow-up information. The program will automatically assign an ID number. (These ID
numbers can be numbered separately from the member ID numbers, and are defined in the
Configure module).
Once a Prospect has been entered into the system, the Prospect can be checked-in to the
front counter in a fashion similar to members.
If a prospect purchases a membership, the information that has been entered can be automatically transferred to the membership record. The “CONVERT” button in the Data
Entry module and the lookup icon in the Contract Sales module will utilize the prospect
record information to construct a member record. The billing information, not available in
the prospect record, will need to be updated by the user in the new member record to
complete the conversion process.

To Add a Guest or Prospect to your Database:
1.

In the Front Counter Module select Areas | Add a Guest.

2.

In the “Add a Guest/ Prospect” window, enter the prospect’s information in the fields.

3.

Press on the “Followup” tab and use the pull-down arrows to choose a category, source,
call back date, etc.

4.

Press on the “Notes” tab to add any additional notes concerning the guest or prospect.

If you have a laser printer, you can print a Guest Letter when you have completed entering
the Prospect or Guest.

To Send a Welcome Letter:
1.

Press on the <Guest Letter> icon after entering the guest/prospects information.

When you press on the <Guest Letter> icon, the program will print a predefined welcome
letter for the guest you just entered.

To Convert a Prospect to a Member:
1.
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In the Data Entry Module select Data | Members.

2.

Press on the guest/prospects name, then press on the <Convert> button.

3.

Choose “Member” and then press <OK>.

The Welcome letter capability uses Microsoft Word, and merges fields from the prospect
record to produce the Welcome letter. We provide a sample letter called “welcome.doc”,
located in the \Fitness\Letters directory. You can use this letter to produce a temporary
membership card with barcode, coupons for your ProShop, or membership rules.
You should use Microsoft Word to edit or change this document so it fits your club’s
requirements. While the content can change, the program requires the name to remain
welcome.doc, unless the file name is changed in the Configure section.
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Scheduling
Select the Schedule icon to make an appointment for a member.
Schedules are maintained in groups. These groups are setup in the Data Entry module.
Groups should be similar for the types of schedules, such as a group for tanning beds, or a
group for the managers.
To examine the various schedules maintained by the program, select the schedule group on
the left side of the screen. As you select the group from the left side of the screen, the right
side displays all of the schedules within the group. Select the specific schedule from the
right side.

Depending on what type of schedule you are selecting, you may want to see all of the
schedules at one time, or only 1 specific schedule. If you are looking for an open tanning
bed, for example, you will probably want to see all of the beds at one time to search for an
open time. If you are looking at a manager’s schedule, you will probably want to see only
the manager’s schedule, not all the employees within the group. To handle these cases, you
can choose to view a specific schedule or all schedules at the same time. Choose the
schedule of interest, or choose the ALL button to view all schedules of the same type.
A window will be displayed that lists all of the schedules of the same type, or the specific
schedule you have selected. (You set up the schedules in the Data Entry module.)
If you choose a single schedule, a calendar of the current month will be displayed with
today’s date highlighted. The appointments are listed along the right side of the window.
If you choose ALL calendars, all calendars of the same type will be displayed for today’s
date. Move to the selected calendar and time before making an appointment. As you move
the cursor, the appointments and appointment notes are shown in the right side of the
window.
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To Add a New Appointment:
1.

From the Front Counter Module select Areas | Appointments.

2.

Select the schedule group on the left side of the screen.

3.

Select the specific schedule from the right side of the screen by pressing on it.

4.

Select <New>.

5.

Make any necessary date and time changes.

6.

Press <OK>.

If you would like to attach a special note to the appointment, be sure to enter a note as you
make the appointment. The note will be displayed when the appointment is viewed.
To print a calendar, be sure you are viewing an individual calendar rather that the group as
shown above. Use the <Print> button located on the bottom of the window. Alternately,
you can print a calendar from the report module, or from the data entry module. When you
use either of these approaches, you are offered several print formats for the calendar.
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Time Clock
The time clock function operates similar to a mechanical punch clock. Provision is made to
track the time an employee works, by logging the check-in and check-out time.
When you click the timeclock icon, a window will appear prompting for the employee’s
password. Enter the password for the employee, using the keyboard or touchscreen.
To complete the “clock in” or “clock out” operation, select the in or out option, and a record
will be made of the time along with the employee’s ID number. To modify the date and/or
time that is displayed on the check-in/check-out screen, the manager’s password is required.
If for example an employee forgot to clock-in, you will need to change the time. Enter the
password that has appropriate access, and then change the time. Then, remove your
password and replace it with the employee’s password, then continue to clock in or out.
The manager can exercise complete control over the timeclock records from the Manager /
Reports module.
To obtain a list of employee hours worked, and in/out times, select the appropriate report
from the report module.
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WORKOUT PARTNER

The Workout Partner software is designed to be placed on the workout floor, and to be used
by the members to track their workouts.
The software displays every member’s workout, and can take the place of workout cards.

Members can use the system to print-out each days daily workout. A list of each exercise,
along with the number of sets/reps is displayed. Once the workout is complete, the member
records their workout into the system so the information can be tracked and graphed. A PIN
number can be assigned to each member to protect the confidentiality of the information.
A touchscreen monitor can be used to simplify the data entry process on the club floor. The
touchscreen monitor provides utmost simplicity and quickest training time. Members just
touch the screen to work the system.
Each member can easily log his or her daily exercises and personal information by touching
the screen. The mouse and keyboard are not necessary!
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Workout Prescriptions
The software will provide workout prescriptions for your members. Your trainer pre-designs
the workouts using a template. When a member joins, the trainer chooses the best workout
plan for the member. When assigning a workout, each prescription can be individually
modified to tailor the workout to the exact needs of the member. This allows each member
to receive a custom plan built just for him or her.

Setting Up the System
The Workout Partner module will store different muscles, exercises, and workouts. You
should initially setup each muscle group that you will be tracking. This information is
provided as default, but you can modify or add more muscles.
Once the muscles are setup, you create exercises. Each exercise you create uses the muscles
that you setup in the Muscle area.
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Now, you are ready to create Workouts. Workouts are created using the exercises that were
setup in the prior step. An unlimited number of workout types can be created and saved.
The program allows you to define every muscle group in the body. Using the muscles, you
define different exercises. And, using these exercises, you’ll group them together to form a
workout.
When you add a member, you assign a workout. Every member will get a workout. Each
workout can be easily changed to provide a custom workout for each member.

Plotting Workouts
On a daily basis, members will use the system to print their workout for that day, and track
their daily progress. The system will save workout information and personal information,
including height, weight, measurements, and medical information. Once several days
workouts are saved, the software will print and graph trends and the progress for each
member, including their exercises, and personal characteristics.
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BILLING & ACCOUNTING
Overview
The accounting system within the Fitness Manager program provides flexibility for cash or
accrual reporting. The data structure takes advantage of the technology in PC mass storage
components that allow for fast retrieval of large amounts of data.
The model used in the development of the accounting system closely resembles that of
many commercial accounting packages, including Quickbooks. Matching these data
structures improves the fidelity of the data exported to these programs and subsequent
reporting and analysis.
The accounting system provides a method to track the Accounts Receivable for each
member, and allows you to bill the members for amounts that are due.

Structure
The fundamental structure of the accounting system is comprised of “Invoices” (which
document sales), “Charges” (that schedule payments), and “Payments” (against charges).
The following diagram shows the flow for the basic structure of the accounting system.

An Invoice is created whenever a sale is completed. A sale can be made through a POS
transaction or as a membership contract in the “Contracts” module. An Invoice can also be
created directly through the Member Data Entry screen. The Invoice data is composed of
information regarding the purchaser, date of sale, form of payment, and detail records of the
individual items sold.
To support the accounts receivable character of a membership sale, a list of “charges” is
created. This will record the schedule of obligated payments. For example, a 1-year
membership contract of $480 may be split into 12 equal “charges” of $40. In this example,
an Invoice will be created for $480 to record the membership sale and 12 “charges” will be
associated with the Invoice to schedule the payment obligations. The charges show the
amount of the obligation along with a due date for the corresponding payment.
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When a member pays an amount that is due, a payment is created. In each case, payments
are applied to the charges, not to the Invoice directly.
In the case of POS transactions that are paid at the time of sale (referred to as “cash” sale), a
single charge that is due on the same day is created. The payment received at the time of
sale is tied directly to the charge and indirectly to the invoice (via the charge record). It is
within the capabilities of the software to schedule the payment that is due for any sale in the
future by setting a due date. This capability supports “house” charges for Pro Shop items
where payment is not due until the end of the month or another date.
As payments are received, either through automatic EFT or Credit Card methods or by the
member providing some form of payment (check, cash, charge), the user will designate the
charge(s) to which the payment is to be applied. Attaching the payment to a specific charge
indirectly associates a payment with a particular invoice (since charges are linked to
invoices). The software can be set to either automatically apply payments to the oldest
outstanding charge or provide the user with the ability to assign the payment to a specific
charge.
If you manually apply the payments, each payment can be applied to a single or multiple
charges. Each payment can be applied to a charge as partial or full payment. The flexibility
to selectively attach payments to charges provides the capability to separate Pro Shop
charges/payments from member dues payments. Also, this system provides a more accurate
depiction of accounts receivable aging.
Although payments that are received are normally applied to the outstanding charges,
payments can be entered into a member’s account without being applied to a charge. These
payments are referred to as “unapplied” or “open” payments and are reflected in the account
summaries. Unapplied payments can be received into a member’s account by front counter
employees and later applied to the appropriate charges by management level personnel.
There are two secondary data components to the accounting system: credit memos and
discounts. Creating a credit memo allows the user to provide credit to a member’s account.
The credit memo documents a reduction in account balance and is reflected in accrual
reports. Since it only affects accrual reporting, the credit memo can be thought of as a
negative valued invoice. The discount provides a means for reducing the amount of a
charge. Discounts are a non-cash payment and are reflected in “cash” accounting reports.
The discount is used when a payment may leave a small residual account value that you
wish to nullify.

Cash versus Accrual
Throughout this manual, we will discuss the “cash” reporting capability and the “accrual”
reporting capability of the system. The software supports either type to produce reports for
your club.
When you run a cash report, the figures reported are based on income. This type of report
uses the payment information that has been entered into the system to determine the income
that has been received. Reports will reflect only the amount of money that has been
received regardless of the amount of sales. A cash report for a membership sold over a 12
month period will only display the actual payments that were received for the membership,
while ignoring income that has not been received.
When you run an accrual report, the figures reported are based on invoices. This type of
report uses the invoice information that has been entered into the system to determine the
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sales that have been completed. An accrual report for a membership sold over a 12 month
period will utilize the payments that are scheduled when the report is produced.
Your accountant can tell you which system is preferable for your club.

Billing Accounts and Income/Expense Accounts
The program uses Income and Expense Accounts to track the income (and expenses) that is
generated by sales. The program uses Billing Accounts to differentiate between different
types of charges.
Income accounts are used to track sales of your inventory and memberships by account. As
the items are sold, whether they are membership contracts or retail inventory, the Income
account will reflect the sale. The Income accounts are defined by the user in the Configuration module of the software system. The Income accounts, once defined, are associated with
the inventory items in the Database module. When an item is sold, either through the POS
or Contracts program, the income account is credited.
Expense accounts behave in a similar manner to Income accounts, except they are used to
track discounts or credits that are applied to a member’s account.
Billing accounts are defined by the user in the Configuration module of the software system.
The Billing accounts are used to differentiate charges when billing is performed. A Billing
account is associated with each Invoice as it is created. When billing your members, you
can select the Billing account, therefore billing only for charges associated with that
account. The default Billing account is defined in the Configuration module.
It may be necessary to separate billing activities. For instance, you may conduct EFT
billing for membership dues, but want to send statements to the member for Pro Shop or
Juice Bar charges. Or, you may wish to bill separately for the NSF Declines. The Billing
accounts are used as a “filter” that allows the software to perform billing against specific
types of invoices. A billing account is established for each invoice that is placed on the
member’s account. (Cash sales are not included since they represent paid invoices and are
not part of the billing process).
Income accounts are used to track sales.
Expense accounts are used to track discounts and credit memos.
Billing accounts can be established to allow billing for a particular type of charge (i.e.
membership dues, NSF fees, Pro Shop sales, etc.).
Each invoice can have only one Billing account associated with it. An invoice may contain
items of various income accounts, such as juice and clothing. Since only one Billing
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account can be selected for an Invoice, you can select the Billing account at the time of sale.
If an Invoice is placed on the member’s account (i.e. by selecting “On-account” as the form
of payment) the user can specify the Billing account that will be used by the billing system
to collect the outstanding charge. Billing accounts are specified in the Configuration
module in a separate list from the income/expense accounts. Default Billing accounts are
also specified in the Configuration module. This allows the system to default to the most
used Billing account, and prevents the front desk personnel from having to change the
Billing account.

Member Account Summary
The previous sections described the automatic actions taken on a member’s account when
performing different operations within the software. The following sections describe the
manual interfaces that can be used to interact directly with the accounting system and the
member’s account specifically.
The Account Summary screen is available from the Front Counter, Data Entry, and Collections modules as part of the information selection buttons for a member. Clicking on the
member’s name in the check-in box on the Front Counter module provides a summary of the
member information with options to select from additional sources of information. One of
these data sources is the member’s account summary. The icon is shown at the right.
Selecting this option will display the Account Summary screen. In addition, when an
outstanding account balance is detected during check-in an alert is issued to the operator.
Selecting the account icon from the alert list will also display this window.

The Account Summary window includes a complete aging analysis with total amount due.
The total value of the members account is shown that includes the outstanding balance,
minus any unapplied payments, plus the total of future scheduled payments. Other information regarding the member is also included in this screen. The contract expiration date, the
date of last contract renewal (if any), and the amount of the renewal contract can be seen in
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this window. If the member is billed on an open-ended, recurring dues basis, the dues
amount along with the next and last billing dates are shown.
The account aging summary is shown to indicate delinquent payments. All debits in a
member’s account in which the due date has passed are sorted into one of five aging
categories (Current, Past 30, Past 60, Past 90, Past 120 days) based on the difference
between the current date and the due date. Each aging category is individually summed to
show the amounts past due by the days reflected in the category (i.e. 60 days). The Total due
field is the sum of all outstanding balances. In other words, the sum of all aged account
balances from the Current through the 120 days.
Additional information is available by selecting the “Details” button from the displayed
options. (This button can be protected by the password security system.) Once this option is
selected, the summary screen is expanded to display the complete schedule of unpaid
charges.
To see all account charges, including those that have been paid, click on the check box to
de-select the “Show unpaid charges only” option. The browser will display every charge
that has been made on the member’s account.
To View Member Account Summary:
1.

From the Front Counter, Data Entry, or Collections modules click on the card deck icon.

2.

Select a member’s name and click <SELECT>.

3.

Click on the member’s name in the check-in box at the upper left-hand side of the screen.

4.

Click on the account status icon.

The “Description” displayed with each charge is taken from the first line of the associated
Invoice.
Once the summary screen has been expanded, the user can select the “Credit Memo” button
to apply a credit to the member’s account. (The Credit Memo feature is not available in the
Front Counter module for security purposes.)
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The “Invoices,” “Payment,” and “Get Payment” windows are also available from this screen.
These items will be described next.

Invoices
The Invoice History screen is available through the Account Summary screen. The purpose
of this screen is to provide a detailed view of all sales activity for the member. This is
achieved through the Invoice browse window (top portion of the window). From this
window each Invoice that was created from membership or POS sales activity is shown.
Once a specific Invoice is highlighted in the upper window, it will cause the details of the
Invoice to appear in the window below. Items purchased on a specific Invoice, and the
charges and payments for the Invoice will be shown in the lower window.

When you highlight an Invoice, the items that were sold on the selected Invoice will be
displayed in the lower window on the “Invoice Details” tab. To view the items that were
sold on any Invoice, select the Invoice in the upper window. The Invoice details will appear
in the “Invoice Details” tab below.
The “Charges/Payments” tab can be selected to view the payment history for the Invoice.
The Charges reflect the schedule of expected payments for the account. If payments have
been made they are shown in the Charges/Payments list.
To View Member Invoice History:
1.

From the Front Counter or POS screen click on the card deck icon.

2.

Select members name and click <SELECT>.

3.

Click on the member’s name in the check-in box at the upper left-hand side of the screen.
(This opens the “Member Information” screen.)

4.

Click on the account status icon (Member “Account Status” screen opens).

5.

Click on <Invoices> to view “Invoice History” screen.

Payments
The Payments button provides a list of all payments made by the member to his account.
Payments are listed in the order of the “Post Date” and include the amount of the payment
as well as the amount applied to invoice charges. This window provides the functionality to
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apply a payment, unapply a payment (and apply it to a different Invoice charge), or remove
the payment altogether. If a payment is removed inadvertently, a new payment must be
created and applied to the proper Invoice.
The payments window does not normally display payments made to cash transactions such
as Pro Shop POS -type sales. In these cases, the payment is automatically applied at the
time of sale and, therefore, is not normally re-applied to another invoice. If you wish to see
the cash payments in the payments browse window, click on the “include payments for cash
transactions” box. With this box checked, all payments made by the member will be
displayed.
Cancelled Payments
To cancel a payment, highlight the payment, and then click the <Unapply> button.
If a payment is cancelled/removed that was associated with a POS sale, the billing account
is automatically applied to the resulting open Invoice that is specified in the Configuration
module. This setting is established in the Accounting section of Configuration under “Sales
accounts defaults.” Within this configuration option, the item labeled “Default billing
account for on-account retail sales” is used to set the proper billing account. When the
payment is removed from a completed POS transaction, the corresponding Invoice reverts to
an “on-account” type of payment. Payment for this Invoice can then be collected during the
next billing cycle by including the default retail sales billing account when specifying the
billing operation. This can occur if a member purchases a Pro Shop item and pays by
check. If the check is returned (i.e. NSF, etc.) the payment should be removed. Doing so
will leave the corresponding invoice open until it is paid through another payment or
collected during the billing process. When a payment is “removed,” the computer retains
the payment for security purposes. A list of these “removed” payments can be made in the
Management module.
Payments made at the time of POS sales may be removed (cancelled) through the “Payments” window of the Account Summary screen. This may be necessary if a member
purchases an item with a check that subsequently is returned for NSF or other reasons.
Removing the payment will cause the original invoice to become “open” (unpaid). In this
case, the billing account that is entered into the Configuration module for retail sales is
automatically assigned to the invoice. With the billing account set, this invoice is eligible
for collection as part of the billing process. Of course, if the member provides a direct
payment, the new payment can be attached to the invoice (i.e. using the Get Payments
window on the Account Summary screen). The Invoice will then be “paid” and will not be
included in future billing activity.
Changing the Payment Application to a Different Invoice Charge
If a payment is displayed that has not been applied to an Invoice charge, highlight the
payment and click on the <Apply> button. The “Get Payment” screen will be displayed and
allow you to apply the payment to an invoice charge. If you wish to change the charge to
which a payment was applied, you must first “Unapply” the payment. The amount “Applied” for the highlighted payment will be turned to $0.00 and the corresponding invoice
charge will be “unpaid.” With the same payment highlighted, press the <Apply> button.
The “Get Payment” window will be displayed with the amount that you unapplied shown in
the “Apply Existing Credits of” field. Click on the “Manually apply amounts” and the
“Apply Existing Credits of” boxes. The “Unapplied amount” and the “Total to Apply”
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values will reflect the amount of the unapplied payment. Double-click on the desired
invoice charge to apply the payment.
Get Payments
The Get Payments screen is available from the Account Summary window. The purpose of
this screen is to manually receive payments from a member. If the member responds to your
mailed account statement or is paying for an outstanding balance, the payment must be
entered into his account through this screen.
There are two versions of this screen based on the security privileges extended to the
operator. The simple payment entry screen is designed for employees that have entry
responsibilities, but not account editing privileges. With this screen, front counter personnel
can receive the payment into the account, but not assign it to a specific charge. This action
places the payment in an “unapplied” status for later attachment to a charge. The complete
payment entry window is designed for management level use and provides the ability to
apply the payments to specific charges when the payment is received. In the Management
module, a report can be generated that lists all “unapplied” payments. This list can be used
when applying payments to charges.
The simplified payment entry screen (Front Counter) allows the user to enter the amount of
the payment received and the form of the payment (e.g. cash, check, or charge). A memo
field is used to describe the payment in the account. A reference number is available to
record a tracking value such as check number. The date field provides the date that the
payment will be posted to the account. The lower section of this window shows the list of

outstanding charges with the posted and due dates, a description, and the amount. Only the
unpaid charges are visible in this window. Past due amounts are shown in red, amounts
currently due are in black, and future charges are in green. The originating invoice for any
of the charges shown in the browse window is visible by highlighting the charge and
clicking on the “Go to” button. The individual items sold on the originating invoice are
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displayed in the invoice details browse window. Selecting the “Charges/Payments” tab will
display the charges associated with the invoice and any payments made against those
charges.
To receive a payment in the simplified window, the user enters the amount of the payment
received, selects the form of payment, enters a description in the memo field, and clicks on
the OK button. This will record the payment to account, but it will be left in an unapplied
status. These unapplied amounts are shown in the “Unapplied Credits” field of the Account
Summary screen. The unapplied payments will need to be applied to the appropriate
charges at a later time by management level personnel.
The complete payment entry screen is similar to the simplified screen, but includes additional capabilities for applying the payment to the list of charges. In this screen, the
payment amount, form of payment, and description are entered in the same fashion as the
simplified screen; however, when the amount is entered (and the Tab key is pressed), the
payment is automatically applied to the oldest charge. If the user wishes to apply the
payment to a different charge, click the “Manually apply amounts” box. With this box
checked, the payment that was placed against the oldest charge can be removed by double
clicking on the charge line. This will remove the payment that was applied and place the
payment in the “Unapplied amount” field. Double click on another charge and the amount
will be applied to the new charge. If previous payments were received, but not applied to a
charge, the amount of those payments will be reflected in the “Apply existing credits” field.
Click the box next to this field to apply those previously received payments.
The Discount field provides the user with the ability to create a discount for an Invoice. The
discount amount is applied in a similar fashion as the payment and can be used to negate
residual amounts on the member’s account. The amount entered into the discount field acts
as a “cash” input and is not reflected in accrual reports. Cash-basis reports will reflect the
discount amounts along with the other payments applied to the Invoice charges.
The default view of charges in the browse window includes only unpaid charges. To view
the complete member account, click on the box for “Show unpaid charges only” to remove
the checkmark in the box. The charge browse window will show all of the charges and
payments in the account. As with the simplified screen, the originating invoice and its
charges as well as the applied payments can be viewed by selecting the Invoice button.
Access to the simplified interface or the full interface is determined by the access privileges
that are assigned to the employee. Access privileges are assigned to each employee, in the
Data Entry module.
Credit Memo
The Credit Memo is used to reduce the amount of an invoice. A Credit Memo can be issued
if you wish to reduce the amount outstanding on a member’s account. Also, if a member
moves from the local area and quits paying, you may want to credit the member’s account.
The importance of the Credit Memo is in accrual reports. In accrual reports, invoices are
used to determine sales. A Credit Memo is used during accrual reporting to act as a “negative” invoice, therefore, reducing the amount of the original sale. This allows adjustments
to the member’s account without affecting any cash-side accounting.
A Credit Memo can be created from the “Credit Memo” button displayed on the Account
Summary screen. A list of invoices, associated with the member, is displayed in a browse
window format. To create the Credit Memo, highlight the desired invoice, select the
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account from the “Apply against account” field, set the amount of the Credit Memo in the
“Amount” field, type a description (purpose for the Credit Memo), and set the date.
Selecting the proper account is necessary for proper recording of credits against sales. If
you are crediting a membership sales invoice, select the income account used when the
membership contract was sold. Selecting an income account causes the Credit Memo to
record a negative value against the account. The effect of this Credit Memo would be to
reduce the amount shown in accrual sales reports. Alternately, an expense account such as
“Bad Debt” may be selected. In this case, a positive value is added to the expense account
as a means for tracking the credit against the invoice. This approach can be used in cases
where unsuccessful collection activity results in an outstanding balance in the member’s
account. Accrual sales reports will reflect the total amount of invoiced sales, but the Bad
Debt account must be subtracted to reflect the taxable sales amount.
Details of the individual item sales associated with the invoice are displayed by selecting
the “Details” button. Reviewing the items sold on an invoice through the “Details” button is
useful when selecting the account used for the Credit Memo. A complete history of all
charges and payments against this invoice are available through the “Charges/Payments”
tab.
Account Transactions from POS
When conducting a simple POS transaction (e.g. purchase of a Pro Shop item), an invoice is
stored by the computer that contains all of the information regarding the sale. A single
charge, that is due immediately, is created that is associated with the Invoice. As payment is
received at the time of sale, the payment is applied against the charge (and indirectly, the
corresponding invoice).
When a POS sale is made and a portion or all of the sales amount is placed on the member’s
account, a schedule of charges is created. The charges are based on the total amount of the
sale and the number of payments. The income account that will be credited at the time of
collected payment is also specified.
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All invoices, charges, and payments are reflected in the individual member’s account. This
provides a complete history of all sales and payment activity for each member that includes
membership contracts and POS-type sales.
Account Transactions from Membership Contracts
The “Contracts” module provides a powerful method for defining and selling membership
contracts. When the membership sale (new member or renewal) is completed and approved,
an invoice is created with the number of associated charges that are defined in the contract.
For example, if a one-year contract is sold with 12 scheduled monthly payments, a single
invoice is created for the full amount of the sale and 12 monthly charges are assigned. The
creation of the invoice and charges is similar to the POS transactions. However, the charges
are not created until the management approves the contract.
When the membership contract is sold by the salesperson, the contract is stored as “unapproved.” The contract remains in this status until the assigned management personnel
review and approve the contract. At the time of approval, the corresponding sales invoice
and schedule of account charges are created in the member’s account. A payment that
documents the downpayment/initiation fee is also created at the time of the contract
approval.
Manually adding a Charge to a member’s account

To manually add a charge to a member’s record, you must use the Data Entry module. The
member Data Entry module provides complete member data management for your members, including viewing and modifying the account. The Data Entry module will be
discussed in detail in later sections of this manual.
While in the Data Entry module, highlight the member in the member database browse
window. The member highlighted in the browse window can be explored by selecting the
Account information icon, shown at the right. As discussed previously, when you select the
<Account > button, the screen will display the Account summary screen complete with
aging and other account information.
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To add charges to a member’s account, double click on the member of interest in the browse
window. Alternately, select the <Change> button from the menu below the list of member
names.
Once you are viewing the member’s record, select the <Invoice> button to manually add an
invoice.
A manual invoice/charge entry might be used if your membership sales process produces a
paper contract that hasn’t been entered into the computer. In this case, the membership sale
and the schedule of payments may be entered directly into the member’s account. This
manual entry system to add Invoices may also be useful for adding Invoices during startup,
or restoring invoices that were inadvertently deleted, credited, or otherwise removed from
the computer.
To perform the manual entry, highlight the member in the browse window and select the
“Change” option. From the entry form, the <Invoice> button is available. After clicking on
this button, a “Create Invoice” entry window is displayed. Enter the total amount of the
debit and a description into this form. Set the due date for the first charge associated with
the Invoice.
Next, set the number of payments and the calendar spacing for scheduling the charges. The
Billing account and the Income account must also be set. Select the applicable tax rates
associated with this Invoice and click on the <OK> button to complete the debit entry.
This will create an Invoice and a schedule of charges (as defined in the entry form) in the
member’s account. This operation is similar to an on-account sale to the member from the
ProShop.

Setting Up Member Billing
A fundamental component of the system is the ability to automatically keep track of each
member’s dues and account balances.
The system will effortlessly handle EFT and credit card transfers. The program will print
credit card vouchers, invoices, and bank drafts. This section outlines the different standards
supported by the program, and methods for performing billing of your members.
To conduct member billing, select Billing from the Aphelion Program Group.
There are two main types of billing for your members:

•

On Account

•

Dues Payments.

The mechanism for billing your members is the same for both types. The program recognizes two types of billing to give you flexibility when you bill your members.
On Account billing is associated with charges created when a member purchases an inventory item or membership, and obligates the payment. These charges have a unique dollar
amount and a due date. On Account billing refers to your accounts receivable. The On
Account is ideally suited for Enforceable Contracts, ProShop charges, initiation fees, or just
a few payments.
The Dues Payments area uses a single dollar amount and a recurring billing cycle. Dues
billing is associated with a recurring fee. This fee is collectable in a cyclical pattern,
usually monthly, but it can be weekly, every 2 weeks, quarterly, semi-annually, yearly, etc.
The Dues billing typically can be cancelled by the member with appropriate notice. Dues
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Payments area is ideally suited for recurring charges of the same amount, or when a contract
is complete and rolls over into monthly billing.
While the program has the flexibility to bill your members separately for the Account
charges and the Dues payments, most clubs choose to bill for both at the same time.
We’ll discuss the differences in the following sections.

Dues Payments
DUES PAYMENTS is used to conduct recurring billing. The recurring billing uses a dues
payment (dollar amount), and repeatedly bills the member for this amount. How often the
member gets billed for the Dues Amount is a function of his billing cycle (weekly, monthly,
quarterly, annually, etc.).
Dues Payments are recurring billing amounts designed to be conducted on a set billing cycle
(such as monthly).
There are several methods used to setup a member for the Dues Payments type of billing.
Dues payments can be created when you sell a member a contract via the Contract Sales
module, or you make an entry directly on the billing page of the member Data Entry
module.
In either case, the (recurring) dollar amount to be billed is shown in the DUES PAYMENT
field in the Member database, on the billing page. Since this is a recurring cycle, the billing
will be the same amount each cycle.
You can separate your members into different groups for billing purposes. Separating your
members allows you to conduct billing for each group separately. Several fields are
available to separate your members. These fields include the membership category, the
billing cycle, and the “next payment date”.
One method to separate your members is to use different billing types. The billing type
(referred to as Form of Payment, FOP) determines how the program will process the billing.
Choose from EFT, Invoice, or Credit Card types.
Dues Payments billing uses the Category, Billing cycle, and next payment date to determine
which members will be billed.
Other methods to separate your members include the membership category and billing
cycle. When you are ready to conduct the billing for your members, the program searches
for the member category, billing cycle, and “next payment date” that you select. Those
members that match these three criteria are what the program uses to determine which
members will be billed.
When you use the Dues Payments billing method, the program uses the next billing date to
determine which members get billed. The Dues Payments function is cycle sensitive.
If you wish to bill certain members on the first of the month and others on the fifteenth of
the month, you should set these members up in different Billing Cycles or different membership Categories.

On Account
ON ACCOUNT is designed around non-recurring charges, i.e. charges with a specific dollar
amount and a due date. This will accommodate members wishing to pay for membership
over the course of a few months or ProShop sales. Use this type of billing to bill members
with an enforceable account balance.
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On Account billing is ideally suited for members that are on a fixed or enforceable contract.
The On Account billing method keeps track of every payment due date, all credits to a
member account, and will compute the remaining balance for a contract. Additionally, the
On Account will keep a record of every transaction made to or from a member’s account.
ON ACCOUNT billing uses account entries for its billing source, and does not use the Dues
information that has been entered into the member database.
On Account billing uses the Type, Billing cycle, and information in the accounting area to
determine which members will be billed.
When you get ready to bill your members, the program searches for the membership type,
billing cycle, and due date of each charge for each member, just like it does for Dues
Payments. Those members that match these three criteria are what the program uses to
determine which members will be billed, but the program uses the information in the
accounting area instead of the dues payment amount.
Each member’s account is available via a pop-up window. You can view the accounting
transaction entries from various areas in the system.
The most basic method of adding charges to a member’s account is from the Data Entry
area. See the previous chapter: Adding charges to a member’s account.

Automatic Accounting Entries
Charges and Payments are recorded in the member’s account. Charges and Payments can be
added manually by the user, or automatically by the program.
A manual entry is made when charges are added into the member’s account, for example:
when you sell an item from the ProShop and you select “On Account” as the form of
payment. Manual entries are also made, for example, when you sell a membership contract
(from the Contract module) that has been setup for account payments.
Automatic account entries are made when you run the Billing program. The Billing module
will update the member’s account automatically when you perform certain types of member
billing.
When you bill your members for Dues Payments, the program will add a paired charge and
a payment to each member that pays automatically (EFT or credit card). For Dues Payments that are invoiced, the program only adds the charge record, thus enabling you to keep
track of the receivable. For Invoiced members, you must record each payment manually
when the member pays you.
When you bill your members for On Account charges, the program will automatically add a
payment for each member that pays via EFT or credit card. For On Account billing via an
Invoice, you must manually record each payment when the member pays his Invoice.

Selling A Membership From the Point of Sale
Now that you have an understanding of the relationships between Account billing and
Recurring Dues billing, lets discuss how to sell a membership. Generally, there are three
different choices that you will have to enter a new member for billing:
Sell a membership from the front counter, using the ProShop.
Sell a membership from the sales office, using the Contract program.
Process a membership from the management office, using the data entry module.

171

Sell A Membership From The Front Counter
Some clubs will sell a membership from the front counter. One advantage of this process is
that the sale is processed as an inventory item. The payment or partial down payment can be
collected and processed as all other inventory sales. Selling a membership in this fashion is
very quick, however much of the data that could be captured with a membership sale is
lost, as the program is really only selling an inventory item called “membership”.
To sell a membership from the Front Counter, you must have a name in the “sold to” area of
the POS screen. If the new member has been previously entered into the system as a
prospect, enter the prospect ID. If the new member has not been entered into the system
previously, you must first place some information about the new member into the system.
To add a new member record from the Front Counter, touch the blank area of the POS
screen that normally contains member information. A screen will appear to add a minimum
amount of member information.
Now that you have a prospect or new member in the “sold to” area of the POS screen, you
can complete the transaction by selling a membership inventory item. Prior to this step, you
should have entered several of your membership types into the inventory area to allow you
to sell these items. When you sell a membership from the POS system, it will have the effect
of processing the membership as an inventory item, and allow tracking and reporting of the
membership sale later by using the POS transaction reporting.
As you complete the transaction, choose the SPLIT function for form of payment. Split the
membership into an “On Account” portion, and a cash, check, or credit card portion
(depending on how the downpayment is paid). The split will allow you to put part of the
membership on the (new) member’s account, and to accept the down payment as cash,
check or charge.
When the transaction is complete, a receipt is printed, and the future membership payments
will appear in the member’s account. Later, you will use the Data Entry program to convert
the new Prospect into a Member, or to add additional information, such as billing information, account number, etc.
To Sell A Membership From POS Register:
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1.

While in the Front Counter Module/POS screen, select Areas >Register from the menu bar.

2.

Click in the upper left-hand area of the screen where member information usually appears.
(The cursor will change to crosshairs.)

3.

The “Member Will Be Added” screen will pop up. Type in the appropriate new member
information.

4.

Click <OK>.

5.

Click the card deck icon in the “Choose Item” area of the screen.

6.

Select a membership type and click <SELECT>.

7.

Click on a form of payment button.

Sell A Membership From the Sales Office
To sell a membership from the sales office, you will be using the Contract sales module.
This process uses the Contract program to find an appropriate membership contract for a
prospect, including duration and price. The program creates the contract electronically,
laser prints the contract, displays the contract for review by the manager, then places the
information into the data entry area.
For a full discussion of this module, please refer to the Contract Sales chapter in this
manual.

Process A Membership From The Management Office
Many clubs will conduct a paper transaction with new members, then enter the membership
information into the system from the back office. This process essentially involves entering
the new member information directly into the Data Entry module.
When you enter a member using this process, you will ADD a new member to the member
database, then add account information related to the membership type and duration.
For a full discussion of the data entry process for a member, please refer to the Data Entry
chapter in this manual.
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Configuring the Billing Module

Billing your members is designed to be straightforward. The design of the Billing module is
to “configure” a template that is used to select which of your members are to be billed.
Billing information is stored in the member’s database record and individual account. The
billing program searches each member record to determine which members need to be
billed.
You configure different billing templates to determine which members you want billed with
the Setup key. Thereafter, you simply “run” the billing for each type you have created.
<Setup> is used to configure different billing templates. You may want to bill one type of
member on the first of the month, while billing other types of members on the 15th. The
<Setup> button is used to filter your members by billing types, membership categories, form
of payment, etc. You can create and name a billing type using the <Setup> key.
When you press the <Setup> key, you will see a series of screens that allow you to filter
which members to bill, and the type of billing to perform. You will name and save your
settings. To actually perform the billing that you have created, use the <Billing> button
from the main menu. To change a Billing type that already exists, select the Setup | Edit
button. To create a new billing type, select the Setup | New button.
We’ll discuss the different pages (tabs) you can use to filter your billing types in the next
few sections.

TYPE
Complete the settings on this screen to determine which form of payment you wish to
produce and to name the billing type for future use.
Be sure to enter a description for the type of billing you are creating, such as EFT Monthly
1st, or Quarterly Credit Cards.
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You should create
and name a
template for each
type of billing you
will conduct. For
example, if you
want to bill
members on the
1st and 15th via
credit card, you
will create two
billing profiles.
Each profile will
bill for credit
cards, but one will
be on the 1st, and
the 2nd will be on
the 15th.
As you select a type of billing, the selections on the other tabs may change depending on
the selection you make on the Type page. For instance, it is not appropriate to select an
output file if you choose to print Statements, so that selection (on the Output section) will
not be visible if Statement is selected on the Type section.
Note that as you select the type of billing, the bottom of the page displays the form of
payment that you have selected. The form of payment display is gray, and cannot be
changed for all billing types other than Statement. If you select Statement billing, you can
override the default to send a statement to those members that are normally billed via credit
card or bank draft. The Statement that is produced will reflect the recurring dues amount
that has been entered into the member database record, along with any account balance.
If you select Credit Card or EFT, the program will produce an electronic file to be used to
send to a clearing house or bank. If you are exporting the data electronically, you should
contact your bank for the proper communication link.
If the member is set up for automatic drafting from his/her account for dues payment, you
have the option of printing a bank draft for the member. Printing checks requires the use of
a special printer for producing the Magnetic Ink Character Recognition (MICR) font for the
bank.
If you are transmitting EFT files to your bank or clearing house, select the EFT option. The
EFT option produces an electronic data file consistent with bank standards for data processing. Special arrangements should be made with your bank or the Aphelion clearing house
prior to using this method of dues collection.
During the course of adding new EFT members, it is necessary to conduct a test transaction
with the bank to verify that the transit, routing and account numbers are correct. This test
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transaction is called prenotification, and must be conducted before you transmit the EFT
files.
Before you can bill your members using EFT, you must prenote each member. The prenote
process sends a test transaction to the bank to verify the information. A prenote is a test
transaction with the bank to verify that the transit, routing and account numbers are correct.
As new members are added to the database, the program “flags” the member, automatically
recording the need to be prenoted. The prenote process creates a zero dollar amount
transaction to test the information in the database. Once the prenote process has been
completed, the “flag” on individual records signifying the need for a prenote is automatically cleared.

RECURRING DUES
When performing recurring dues billing (open-ended cyclic billing - i.e. fixed amount each
month) an invoice, charge, and payment is created for the amount of the recurring dues
value due on the billing date (refer to the Billing tab in the Member Data Entry form).
Billing performed for account balances operates on an existing set of invoices and charges
that were created at the time of contract or POS sale. During the billing process, payments
are created for the charges (that match the income accounts selected) that are due. These
payments are automatically applied to each charge used to compute the amount billed.

Since there are two main methods to bill your members, Recurring Dues and Account
Balances, the Billing configuration program allows you to select which method to use. For
most billing situations, you should make one template that includes both types of billing.
This will insure that any recurring dues and account balances get billed in one step. If you
have a unique club requirement, or just wish to create separate templates, you can disable
either the Recurring Dues or Account Balances on the template. Selecting both types will
combine account and recurring dues into one billing transaction.
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If you want to conduct billing for Recurring dues and Account Balances separately, toggle
only one selection on for each template.
When using the “dues payments” menu selection, the “Match on Next Billing Date” is used
to calculate which members will be billed. The month is compared against the “next billing
date” in the member database, and only those members with a match will be billed.
The “Billing Description” is used to describe the charge transaction in the member’s
account. The “Payment Description” is used to describe the payment transaction in the
member’s account. Both are useful when you view a member’s account history.
The “income account” field is used to allocate income to the appropriate income category.
Income from the billing is displayed on reconciliation reports.
The “Dues Payment Description” field is used to specify the descriptive entry that is
automatically made in the member’s account.

ACCOUNT BALANCES
The primary function of the billing process is to collect payments for outstanding balances
and membership dues. To determine if a payment is due from a member, two methods are
used. The first method examines the recurring dues information in the Billing tab of the
member data entry forms. If an appropriate match of the billing criteria is made, the
amount recorded on the “Billing” tab is processed for billing. This method was discussed in
the previous section. The second method involves a query of the accounting system to
determine if any charges are due for a specific member. When assessing a member’s
account balance for billing payments, only the income accounts specified are queried. For
example, if you wish to only perform EFT billing for the membership dues you will select
the “Membership Dues” (or similar) income account in the billing settings screen.

177

Selecting the income accounts for billing provides the flexibility to perform EFT billing for
membership dues followed by the mailing of statements to members for Pro Shop charges.
Alternately, if all income accounts are selected, an assessment of all amounts due are
computed and billed collectively.
When conducting the On Account billing, you’ll need to tell the program what date to
search for accounting transactions. The date you enter will be used as the program searches
through the accounting database. If a transaction is due before the date you enter, it will be
used in calculating the member’s balance. (You may want to refer to the prior discussion
regarding the On Account transactions.)
Select a day and month for the field labeled “Account Balance Through Day”. This is the
day the program uses to determine if a member owes you money.
For Statement billing, the screen will display a start and stop date for details. These dates
are used to display account details on the statement. This date does not change the amount
due. With the “Details From” date and “Details To” date, a range is created to display the
account transactions on the statement. This technique produces a statement similar to a
credit card statement, which shows prior balance, current details, and ending balance.A
“prior balance” line will be printed for the sum of all transactions due before the range you
selected.
If you select billing via EFT or Credit Card, a slightly different screen will appear for
Account Balances. This screen allows you to describe the Payment that is automatically
added to the members account when billing is conducted.
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OPEN PAYMENTS
During the course of accepting payments from your members, you may accept a payment
and not apply the payment against specific charges. Accepting payments into the member
account without applying it to a specific charge will create on “open payment”, that is, a
payment made on a member’s account that has not been placed against a specific charge.
These payments are categorized as “open” payments. Open payments can occur when the
Front Counter accepts a payment without applying it against a specific charge, or if you
allow a member to keep a credit balance in their account for ProShop purchases.

The Open Payments screen allows you to use the member’s “open payment” against
Recurring Dues charges, or against a specific Billing Account.
To allow a member to charge in the ProShop against a credit balance, apply the credit as an
“open payment”. Setup this screen to apply the balance only to Billing Accounts for the
ProShop, such as the ProShop billing account. Do not apply the “open payment” to Billing
Accounts such as Recurring Dues, or Membership Dues.

FILTERS
Filters are used to select members of a certain status, membership category, billing cycle
and club. The default is for all cycles, clubs, status, and membership categories to be billed.
However, you may wish to selectively bill certain types of members. Use the Filter page to
limit the members being billed.
The “cycle” selection is used to filter your member billing cycles. For most billing situations, you should probably select the default, ALL CYCLES. Selecting the default, ALL
cycles, will not restrict the members getting billed. Generally, the default selections of ALL
CYCLES need not be changed, unless you want to separately bill your members by different
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cycles. The cycles shown in the pop-up window reflect all available cycles. If you wish to
NOT allow the member of a specific billing cycle to be billed, switch the selection “off” by
UN-checking the cycle.
The “category” selection is used to filter your member categories. For most billing situations, you should probably select the default, ALL CATEGORIES. Selecting the default,
ALL categories, will not restrict the members getting billed.

Generally, the default selections of ALL CATEGORIES need not be changed, unless you
want to separately bill your members by different categories.
The categories shown in the pop-up window reflect all available categories.
If you wish to NOT allow the member of this billing category to be billed, switch the
selection “off” by using the mouse to click on the category.
Generally, the default selections of ALL Status should not be changed, unless you want to
separately bill your members by different membership status.
The “Status” selection is used to filter your members by status. For most billing situations,
you should probably select the default, ALL STATUS. Selecting the default, ALL status,
will not restrict the members getting billed.
The “club” selection is used to filter your members by club. When conducting EFT or
Credit Card billing, club banking information is included in the file that is produced. If you
select more than one club, the club banking information will be obtained from the home
club configuration. If you select only one specific club, the banking information will be
included for the club selected.
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OUTPUT
Output formats vary, and will range from a File or specialized output for one of the electronic formats.
The choices on the Output screen will change depending on the type of billing you have
selected on the “Type” screen.
Statement billing (which generally is printed on white paper) will provide options for the
statements, while Credit Card billing (which has many types of outputs) provides a larger
selection list.
For Statements, the “Date on Statement”, “Courtesy Message” and “Due Message” are
printed on the forms for information only, and have no effect on the billing.

Electronic Credit Card
There are over 50 major credit card processors, and dozens of secondary credit card processors. Unlike the EFT, which is governed by the Federal Reserve, there is not a standard for
credit card transfer.
The program supports many types of electronic credit card formats. These formats include
Tele*Money, Transnet, MDI PC Batch, Mapp, Personal Ticket Capture, Batch Pro, 4 Sure,
Fast Batch, and others. If your bank utilizes one of these credit card processors, the program will format the credit card information in a format that can be read electronically, and
sent directly to your bank.
If your bank cannot accommodate one of the preformatted transactions, Aphelion has made
arrangement to translate your electronic credit card transactions to the format your processor uses. Aphelion utilizes a 3rd party program that is designed to interface with almost
every credit card format. This program is called ICVERIFY. The Aphelion program will
format the credit card information in a format that can be read by the ICVERIFY translating
program, which in turn will work with most of the credit card processing agents. Aphelion
is not affiliated with ICVERIFY. However we can provide information to you on the
system.
If you are performing credit card billing, and your processor is not listed on the “output”
screen, choose the ICVERIFY format.

EFT
When conducting an EFT transaction, you must send the file to the clearing house or
processor before it is due to be deducted from the member’s bank accounts.
The effective date is the bank processing date, and should be at least 3 business days later
than today’s date to allow the bank time to send the file to the Federal Reserve.
Aphelion can provide information on a national EFT processor that is independent of your
bank. EFT transactions are transferred to your bank on the business day following their
receipt.
The EFT output produces an electronic data file consistent with bank standards for data
processing. Special arrangements should be made with your bank or the Aphelion clearing
house prior to using this method of dues collection.
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Billing Members
To bill your members, select the
Billing icon from the Aphelion
Club Management Group. Select
the Billing button from the menu
to perform the billing for your
members.
You should have configured
several billing types in the
previous chapter. To perform the
billing: select one of the billing
types from the choices, then click
Run.
When you select a billing type
and click “Run”, the program
searches the members, then
shows a list of the members that
will be billed.
When you highlight a member name in the list, the display will show the recurring dues and
account balances that are billed for that member. Click the “On Account Details” or
Recurring Dues Details” tab to see the specific billing for the member.
If the totals are what you expect, click on the Process button. If the totals are not what you
expect, click on the Cancel button to evaluate why the results are not what you expected.

Unexpected Results
If you try to conduct billing, and get unexpected results, there are several common solutions. If you are processing Recurring Dues, be sure the Next Billing Date for the members
you have selected corresponds to the billing date requested. The “Next Bill Date” field in
the member record must match the billing date in the billing process. Usually, when you
run the billing, the next billing date gets moved forward, ready to be billed during the next
cycle. If the “Next Billing Date” does not seem to be right for a group of members, a utility
is provided to change the “Next Billing Date” for members within a billing cycle.
This utility is selected from the Manager | Utility menu selection, and is called “Reset
Billing Dates”. Follow the prompts to change the Next Billing Date for all Cycles, or to
change the Next Billing Date for all members within one billing cycle.

Sending Files
Many billing options produce a file on the disk. These files must be transmitted to your
bank, credit card processing center, or clearing house. You must make arrangements with
your clearing center on the method to be used for sending this file. Generally, a communication program such as PROCOMM can be used in conjunction with a modem.
During the EFT process, a file is created on the disk. The “Output File” field contains the
name of the EFT file, as it is stored on the disk. Defaults are used, but you can name the
file any valid filename. EFT files are named ACHPPD01.xxx on the disk. The “PPD”
within the file designates a drafting deposit, and the number following designates the
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number of files that have been generated today. xxx represents the day of the year, ranging
from 001 to 365. These files are named using the above convention. However feel free to
rename these files to any other file name with which you feel comfortable.
To send the file, start your communication program, call your clearing center, and send the
file per their instructions. The file name is always displayed during the billing generation.
The file sent should be the same file you generated in the above steps.

Printing Drafts
The setup menu provides options for printer types, printer memory, and check alignment. If
you are using the Digital Design printer, select “D” for the type of printer. Other applications should select the Aphelion option, unless you have been directed to select another
option by your dealer.
If your checks are skewed high or low on the paper, you may wish to adjust the printer
offset. The program defaults to 3. Other numbers will move the check up or down on the
paper.
Printer memory should be set to 256 initially. Performance will be enhanced if you have
more printer memory, as more data can be stored at the printer for formatting.
Printing checks requires the use of a laser printer using the Magnetic Ink Character Recognition (MICR) font for the bank.

Receiving Payments from Mailed Statements
When processing payments received from a mailed statement to the member, use the “Get
Payment” function available from the Front Counter or Data Entry modules. Enter the
amount of the payment received. The amount will be applied to the oldest matching charge.
If you wish to apply the amount to another charge, select the “Manually apply payment”
option and double-click the desired charge.

183

Billing Declines
Processing declined payments is typically necessary after completing a billing function. If
the declines are returned as part of an EFT activity, they will be in the form of a text data
file that can be automatically processed by the software. In this case, the declined payment
is found in the member’s account record and cancelled. In effect the payment is rescinded,
restoring the account balance to the pre-billed state. Late fees, etc. can also be attached to
the member’s account during this process. For these fees, an invoice and charge is created
and added to the member’s account. (To automatically process returns that have been
received from your EFT processor, select the | Process Declines option from the billing
menu).
Declined payments can also be manually cancelled through the member data entry module.
Select a member by either double-clicking or highlighting and selecting the “Change”
button. To manually “Cancel” a payment, select the “Payment History” button. The
resulting window displays the payments that have been made to the account. Highlight the
payment to be cancelled and press the “Cancel” button. You will be prompted to verify your
intentions to cancel the payment. After continuing, the payment will vanish from the
display indicating that it has been removed from the member’s account leaving an open
charge.

Reviewing Prior Billing
If you would like to see the billing that was performed for a prior period, two views are
provided. To view a specific member, choose the <Member History> button.
Enter the member ID, and the range of dates you wish to view. A report will be created that
details every billing transaction for the member.
To view the billing at the club level, choose the <Club History> button. A list is displayed
in the window that shows each billing that was performed.
When you highlight a specific billing cycle, the lower part of the display will show each
member that was billed in the cycle that is highlighted.
If you need to re-run the billing, press the <Duplicate> button. This will recreate an
identical billing so
you can reprocess
it.
If you press the
<Print> button, a
detailed report will
be printed for the
highlighted billing
cycle.
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Billing Tips
This section is designed to review the billing, and to answer commonly asked questions
about the billing.

Billing Types
The software provides two different methods for processing member dues and payments.
The first type of billing is what we call “Recurring Dues”. This form of billing is used to
collect ongoing dues from your members.
Recurring Dues are usually used if you bill your members on an open-ended contract. An
open-ended membership typically gets billed until the member tells you to stop billing his
account. Dues of this type typically are members being billed month-to-month, or those
members who were on an annual contract that has rolled over to a monthly type.
Recurring Dues are the same dollar amount each time, on a fixed cycle.
The second type of billing is what we call “On Account” billing. “On Account” billing is
used when there is not a cycle for the billing. On Account billing is used for enforceable
contracts, to create an Accounts Receivable, or when billing should stop after a period of
time.
On Account is used when there are a fixed number of payments.
Use “On-Account” when a member is on a contract where his payments stop when the
contract expires, when an item is sold from the ProShop, or when you will have the member
pay his initiation fee over the course of a few months. “On Account” billing will bill your
members any dollar amount on any date (or over a range of dates).
On Account billing places charges and a payment due date into the member’s account.
You can use either type of billing, or a combination of both, depending on your requirements.

How Do I Bill My Members?
The first step is to add members to the member database. This is done using the Data Entry
or Contracts module.
Member and billing information is entered into the membership record. You will need to
enter a minimum amount of member information, such as name, address, membership ID,
member category, etc. The program will not allow you to save a member’s record unless the
minimum amount of information has been entered.
You will also need to enter a basic amount of billing information, such as method of billing
(Form of Payment) and frequency (billing cycle).
To bill members with the Recurring Dues method, two additional fields must be completed.
For Recurring Dues, you need to enter the Dues Amount and Next Billing Date. Once this
billing information is entered into the member databases, you can conduct Recurring billing
(called Dues Payments).
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The next step, if desired, is to setup payments in the member’s account with the Invoice
button (if you are in the Data Entry module), or by selling an item On Account (from the
ProShop). When this is complete, you can bill with the On Account method.

Forms Of Payment
Some members may pay on a statement, while others are using EFT, and others use a credit
card. You’ll need to separate these members by different Forms of Payment.
Aphelion provides a variety of methods to bill your members. There are 4 different Form of
Payment (FOP) options to bill your members: Not Billed, Statements, EFT, or Credit Card.
The payment type is created for each member in the member data entry screen, on the
Billing tab. The payment type is selected from a pop-up window. Select Statement, Not
Billed (cash), EFT, or one of the credit card types.
The EFT option should be selected for either Electronic Fund Transfer (EFT) or printed
draft. The same holds true for the credit cards, where they can be sent electronically or
printed. You choose the printed option or electronic method when conducting billing, not
when setting up your members. If you choose to print drafts, you will need a laser printer
with a special font and toner. If you choose to print credit cards, you can use a standard
impact printer.
To set the Form of Payment, select the Member Database, and then select the Member from
the roster. Highlight (or add) the member of interest. Press the Change (or Add) key while
highlighting the member’s name. Once you have the record displayed, change the billing
information on the billing tab. Move the cursor to the “Form of Pay” field, then choose the
FOP from the selection window.

Membership Types
Members can be divided into separate membership types. These categories allow you to
separate the members when you conduct reports and billing.
As above, the membership category is set in the membership record.

Billing Cycles
Members can be divided into billing cycles. These cycles allow you to separate the members when you conduct billing and print reports.
The billing cycle is also selected in the member’s record.
To set a member in a billing cycle, highlight the “Billing Cycle” field in the member’s
record, on the Billing page. Choose the cycle from the selection window.

How Do Fops, Billing Cycles, And Categories Work Together?
Many clubs like to separate their members into different groups for billing and reporting
purposes. The membership Category can be used to separate your members when you are
billing or printing reports. For example, if you have some members in the “Executive”
category, and others in the “Heritage” category, you can bill or print reports for all members, just the “Executive” members, or just the “Heritage” members.
Billing cycles can also be used to divide your membership into convenient billing periods.
You can place some members in a “monthly first” cycle, others into a “monthly fifteenth”
and others into a “quarterly” cycle. When it comes time to bill your members, you can
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select only those members that correspond to one of the billing cycles. You can also select
All Cycles to bill everybody at the same time.
The FOP (form of payment) is used to specify which type of billing each member will use,
for example EFT, credit card, or statements.
When you enter member information in the data entry area, you can add a member using
any combination of membership category, billing cycle, and FOP.
The combination of categories, cycles, and FOP is used primarily when you are taking
information out of the system - when you bill members and when you print reports. When
you bill members or print reports, a filter is used to select membership category, billing
cycle, and the FOPs and limits the output to only those that you have selected.

Combo Boxes
Many areas of the program provide pull down choice boxes from selection fields. These
pull down choices are context sensitive, and accessed while on the appropriate field. Most
of the selections in the combo boxes can be configured from the Configure module.
An example is the membership categories. When choosing a category for a member, a list is
displayed. This list is initially setup in the Configure module.
The Configuration program allows you to setup your own choices for member categories,
billing cycles, payment types, and many others. This capability allows you to configure the
system so it uses descriptions that are familiar to your club, and so that the choices are
appropriate to your facility.

Recurring Dues
Use Recurring Dues to quickly setup payments for open-ended contracts.
Recurring dues are used when the same dollar amount is to be billed over and over again.
The billing is in a cycle. Using the Recurring Dues saves you from having to enter repetitive dollar amounts and due dates into a member’s account. It is a handy billing method for
open-end contracts, where the same amount is billed until the member drops out.
When entering recurring dues, you’ll enter the information into the member database or use
the Contract module. To use the Recurring Dues capability, five major items are required.
Each member is assigned to a membership category, a billing cycle (i.e. monthly, quarterly,
etc.), a payment type (EFT, statement, credit card,), a dues amount and a next billing date.
When you are setting up the billing, you select the member category, a billing cycle, and a
form of payment for dues collection. The selections you make in the billing menu while
conducting Billing correspond to the fields that are setup in the member record.
For example, if you want the billing system to produce “EFT” (payment type) for all
“COED” members (member category), on a “MONTHLY” billing cycle you would select
those items in the billing menu. Only those members that match all these criteria would be
selected for billing.
Once you have assigned the category, cycle, and FOP to each member, you need to enter the
Dues Amount. The Dues Amount should be entered on the Billing page of the member
record. Do not add tax to the dues amount. The tax rate is set in the Configuration, along
with a flag to tell the program whether dues are taxable or non-taxable. By setting the tax
rate separately, you can quickly change the total dues billing if your tax rate changes.
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Lastly, enter the Next Billing Date. The Next Billing Date is used only when conducting
Recurring Billing, and will be matched against the date you set in the billing screen.
Members will be billed only if the Next Billing Date matches the date set on the billing
screen.
You may want to enter a “Contract Expire Date”. Billing will continue for each member,
even if the contract has expired, as long as the status is set to “OK”. If you want the expired
members to stop being billed, you’ll need to set the member’s status to “Terminate” rather
than “OK”. A utility is provided to periodically change the status of “expired” members.
Use the utility “Terminate Expired Members” to search through the database and find all
expired members. This utility will change the member status to “Terminate” for all expired
members. Members that have a status set to “terminate” will not be billed.

Responsible Party Billing
Responsible party billing takes full advantage of our invoice tracking system. Invoices are
attached to the member who initiates a transaction. Charges are generated from invoices
and attached to the member record responsible for payment. Charges or percentages of
charges can be directed to a “responsible” third party if the charges originate from recurring
dues or account transactions (form of payment is “on account”). The Billing module bills
member records for charges that are due based on the responsibility rules you create in a
member’s record.
For example, Member 1 has all monthly recurring dues paid for by Member 2. All invoices
created by Member 1, whether on account or recurring dues, appear under Member 1’s
billing information. All charges generated from recurring dues invoices are forwarded to
Member 2’s billing record. When browsing Member 2’s charges, a reference to Member 1
is given as the source for these charges. Member 1’s billing record retains all invoices
Member 1 created. Only the charges that are above and beyond the responsibility rules (set
in the member record) appear on Member 1’s bill.
Charges are automatically created from invoices. Recurring dues invoices (and the charges
from those invoices) are automatically created when the Billing program is run. The Billing
program scans member records for any attached recurring dues. Based on “Billing Cycle”
and “Next Billing” information (see below), it will generate both invoices and charges.
For example, a recurring dues service is set to charge $5 every week. Your billing program
(assuming it is configured to scan this billing cycle) is run once a month. When it is run, it
creates the necessary invoices and charges to the account. If four billing cycles have past
since the last billing, four sets of invoices and charges are created and attached to the
appropriate records. Likewise, if the billing cycle for a recurring dues service is $100 per
quarter, the billing program will only generate the necessary invoices and charges based on
the last time the service was actually billed, not the last time billing was run.
To set up Responsible Party billing rules (Data Entry):

188

1.

From the member record in the Data Entry module, select the “Responsibility” tab

2.

For Recurring Dues responsibility, select the arrow icon or F2 to select a responsible
member

3.

Create the responsibility rule for the cumulative recurring dues amount. Any amount above
the limits of the rule will be charged to the “Account” responsible party.

4.

For Account responsibility, select the arrow icon or F3 to select a responsible member.
Account responsibility is for the entire account balance.

Family Memberships
Members can be setup so that their charges are billed to another member. This is useful for
family memberships, and for groups that want to share fees.
The member that will be responsible for the billing is called the Primary account, while
other members that will be billed to the Primary account are called Secondary accounts.

Billing To Another Account
If you have already entered information into the data entry area, and wish to designate the
member as a secondary member, you’ll change the “Bill To” field.
The “Bill To” field is used to designate which member is responsible for the dues and
account balances. Normally, the “Bill To” is the same membership ID as the member’s ID.
If you want to have another member responsible for the Recurring Dues and Account
balances, place that member’s ID into the Bill To field (located on the Billing page of the
member record). This will cause the account to become a Secondary account.

The Form of Payment, Billing Name, and payment information for the secondary account is
obtained from the primary billing account, and cannot be changed from a secondary
account.

Adding Family Members
When adding a new member, you can choose to have the account setup as a secondary
account automatically. To setup a secondary account, highlight the primary member on the
member roster, in the data entry area.
When you press the Add Member button, a selection screen is displayed prompting for the
type of member. Select the Family option from the “new member type” screen. This has
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the effect of using all of the information in the member’s record that was highlighted when
you pressed the Add button.
Note that when entering the secondary account information, the Bill To ID, last name,
address, and other fields are defaulted to the Primary member’s information.

Viewing Family Members
To view the accounts that are secondary to the Primary account, choose the Family button.
This button is available on many information windows in the Register, and in the member
database area.

Selling A Proshop Item On Account
ProShop items, memberships, initiation fees, etc. can be added to the member account. To
sell an item, and add the purchase to the member account, conduct your ProShop sale as
normal. When you complete the sale, choose On Account as the form of payment.
The “create Invoice” account screen will appear with the sale total. Note that by entering
initiation fees and various membership types into the inventory database, you can sell these
items, and then place them directly into a member account.
The Account option will not be available on the Form Of Payment screen unless the
member’s name has been entered prior to totaling a sale.

Club Charges And Contracts (On Account)
The software provides an account for each member. The account is used for contracts, club
charges from the ProShop, and non-cyclical charges. Use On Account to enter enforceable
contracts, variable payments, or miscellaneous charges.
The member’s account provides for scheduled payments of any dollar amount on any date.
Use the On Account to schedule a membership payment over the course of a few months, or
to allow purchase from the ProShop on a member’s account. Staggered billing, variable
payments, and contracts are handled using On Account billing. ProShop items can be sold,
and charged to a member’s account.
For example, let’s say you want to bill your member $40/month for the next 12 months,
starting on the first of the month. To enter this into the system, set the Current amount to
$480 ($40 x 12), the first Due date to the first of the month, the number of payments to 12
and the number of months between payments to 1. Also note that you can add a comment
to the accounting database, such as “Manual Debit #”. The program will divide the $480
into 12 equal payments, one month apart. The comment will say “ Manual Debit # 1
Manual Debit # 2”, “ Manual Debit # 3”, etc.
The recurring billing and On Account can be used in conjunction with each other to provide
total flexibility in the methods used to bill your members.

Viewing An Account
The on-line ACCOUNT HISTORY browser provides a summary of accounting information
about each member. The detail Account history screen shows each transaction a member
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has conducted, along with his account balance, the total amount due in the future, and
payment or aging summary.
You can view any member account from the Register or Data Entry area. To view an
account, select the Account button.

Setting Up A Contract
Payments can be automatically entered into a member’s account by using the Contract Sales
module. This module allows you to setup membership plans, including duration, dollar
amounts, down-payments, and other contract options.
When a plan is sold to a member, the payments for that plan are automatically entered into
the member’s account, along with the membership information.
See the section on the Contract Sales Module for more information.

Late Fee For Delinquent Accounts
Late fees are charged to overdue accounts using the “apply late fees” utility. This utility
allows you to set a fixed amount that will be added to the member account, or set the fee as
a percentage of the outstanding balance.
Using the utility, late fees are automatically added to accounts that are greater than 30 days
past due.

Setting Up Paid In Full Members.
Paid in full members can be entered by setting their full dues amount into the dues field, and
then setting their “next bill date” to their expiration date. The member will not be billed
until the next billing date, which corresponds to the renewal rate.

Setting Up Members For Continual Billing.
Continually billed members are members are those who are on an open-ended contract.
This type of member will pay continuously until the member tells you to stop billing their
account. To set up these members, set each member’s next billing date and dues amount in
the appropriate area of the member database.

Setting Up Members With A Contract.
Contract members are members that have a contract that will end at a date in the future.
These members have fixed payments, and the billing is set to stop when the payment term
expires. To set up a contract, set the “next billing date” to the contract expiration date. The
“dues amount” should be set to $0, but generally is not important, as you will not be using
recurring billing with this member.
Apply a debit to the member account or make a sale to their account. Once the debit or sale
is recorded to the member account, members are ready to be billed using the “On Account”
system.

Billing A Corporate Account Or Group
To bill a corporate account or group, the “group” needs to be set up in the group database
and the member database.
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All members that are to be billed to the corporate account or group should have the “bill to
ID” in the database set to the “group”, which is recorded in the member database as a
member. All dues will be billed to the corporate location and name.
Use the same technique to bill a family membership to a primary account.

Setting Up A Family Membership
A family membership is entered the same as an individual membership. When adding a
new record, you’ll select FAMILY as the record type. This has the effect of copying all
pertinent information from the highlighted record to the new record, and assigning the
billing ID to the primary account.

Combining Recurring Billing And On-Account Billing
A combination of Recurring Billing and On-Account Billing can be used for each member.
There are several ways to use both billing types.
An example may be to use On Account billing for the first 12 months of a fixed contract,
which will roll over to an open end, month to month billing. Set up the member account for
the first 12 months, as described in setting up “on account” billing. Set up the recurring
billing, with the monthly dues amount, but set the “next billing date” one year in the future.
The On-Account entries will be billed for the first year, and then the recurring “dues
amount” will start in 12 months

Temporary Billing Suspension
You can temporarily suspend billing using the Status field. By changing the Status field in
the member database to FREEZE, you instruct the system to bypass billing for a period of
time. When you change a member status to Freeze, you are prompted to enter a THAW
date, and a “Next Billing Date”.
The Thaw date is the date you want to re-activate the membership. “Next Billing Date” is
the date you want to resume billing the member.
You can limit the number of Freeze/Thaws for a member. The Freeze limit is set on the
“General” page of the database record, and can be set to any number.
The default number of Freezes is setup initially using the Configure program.
Freeze is only active for Recurring Dues billing and does not affect the On Account billing
Thawing of members is not automatic. You must select the Thaw function from the Utility
menu to reactivate members with a Freeze status.

EFT
EFT means electronic fund transfer. The program creates a standard file which most banks
and clearing houses can process. The file is called a NACHA file. Be sure your bank can
read this type of file before sending it for processing.
Before you can bill your members using EFT, you must prenote each member. Prenote
stands for Prenotify. The prenote process sends a test transaction to the bank to verify the
information. A prenote is a test transaction with the bank to verify that the transit, routing
and account numbers are correct. As new members are added to the database, the program
“flags” the member, automatically recording the need to be prenoted. The prenote process
creates a zero dollar amount transaction to test the information in the database. Once the

192

prenote process has been completed, the “flag” on individual records signifying the need for
a prenote is automatically cleared.
EFT billing and Prenote require two dates to be entered. The billing date is the first date
entered, and is used to match the “member’s next billing date”. The second date entered is
the effective date. This date refers to the date which the bank processes the electronic fund
transfer. Some banks require the effective date to be set two to three days from the billing
date. Funds are usually available to you one day after the effective date.

Improved Declines Processing
The Declines processing feature has a more intuitive interface than before. Use the wizard
to step through the process. Additions include the ability to enter a customized description
and due date for declines related charges.
Note for declines processing: the program looks for records in the member’s billing history
to match a decline record. If found, the newly created declines charge (containing an
amount and due date) will match the original charges to preserve the member’s account
aging. If a match is not found and you choose to process declines, the generated decline
record will have a single charge due on the date specified.
To process Declines (Billing):
1.

From the Billing module, select the “Declines” button

2.

Specify the path of the decline file and choose whether or not you will continue the declines
process if a matching invoice is not found.

3.

Select Next

4.

Review and/or print the Declines process summary report. If correct, select Next

5.

Choose the checkbox to update member records

6.

Set a decline description and due date for generated invoices and charges for unmatched
declines. Do the same for match declines.

7.

Select reports options for member tagging

8.

Select Finish

Billing Declines History
Each member record retains a history of billing declines. This feature displays a listing of
the date, amount and reason for the decline. In order for the history to develop, it is
necessary to use the Declines Processing in the Billing module.
How to access the Declines History window (Data Entry):
1.

From the “Browse Members” window, highlight the desired member

2.

Use the “$” icon to open the “Account Status” window

3.

The Billing Declines history is located under the “Declines” button

Improved Credit Memo
Credit Memos are independent, “negative” invoices. They are applied through the Data
Entry module or through the Point of Sale via an item return credit. As independent
invoices, Credit Memos do not need a previously created, positive invoice to be applied to.
All credit memos are visible under the invoice history as negative invoices.
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To issue a Credit Memo (Data Entry):
1.

From the “Browse Members” window, highlight a member and select the “View Account
Status” icon

2.

Select the “Credit Memo” button

3.

Fill in the form for the appropriate credit amount. Any returned items will affect inventory
accordingly. Use the “Salespersons” button to split the credit amount among involved
sales staff. See “Split Sales Credit” above.

Accounting Period Closeout
By setting a closeout date, all transactions on or before the specified date cannot be
modified. This includes voiding invoices and applying/un-applying payments. This date is
set in the Configuration module and needs to be moved manually to accommodate your
accounting system.
To set the Accounting Closeout Date (Configuration):
1.

From the Configuration module, select the menus Accounting > Close-out

2.

Set your closeout date and select OK

Printing Drafts
To print your checks, you will need to select the billing option to print drafts. Selection of
this option will start the Draft printing software, load the MICR font into your HP Laser
Printer, and print drafts.
The Draft Printing Module has only two options on the opening screen: a Print Drafts option
and a Setup option. It is a good idea to make sure your setup is configured correctly. The
printer offset should be set to three. The printer memory should correspond to the amount
of printer memory you have available. The last configuration option is the font type. The
font type should be set to “A”, which stands for the Aphelion MICR font. The other font
types are only used in special circumstances.
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COLLECTIONS
One of the most effective ways to collect outstanding overdue payments is via a systematic
approach to member follow-up.
Effective sales collections can pull thousands of dollars into your club over and over again,
each month.
Systematic collections is one of the simplest ways to collect overdue payments, and it is
usually ignored or farmed out to 3rd party collection services. Why? Because the skills
necessary to be effective at collections are hard to come by. Plus, the overhead and paperwork are usually burdensome. Most clubs just don’t know how to be effective at bill
collections.
The Aphelion collection program provides a proven methodology to track members that
have overdue payments. It reduces the time and paperwork necessary to be effective at
collecting overdue payments.
This program is a comprehensive approach to collections developed by one of the most
successful groups in the country. The effectiveness of this system will pay dividends in
faster payments, better tracking, and increased cash flow.

For maximum success, you should follow a systematic strategy. This system is used by
successful clubs. You can use this system to categorize members with outstanding payments, keep detailed notes of every call, track follow-up dates, and call back when you say
you will.
When you use the Aphelion collection module, you’ll find it provides a process to set a call
back date for every member in collections. You can run call back reports each day to find
which members need to be called back. By viewing the notes from each record, you’ll be
reminded of prior conversations and know how to escalate the collection activity to the next
level.
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Effective collection tracking is a system. By effective tracking and follow-up of your nonpaying members, you’ll see your cash flow increasing. This program provides the framework for an effective system. Use it and you’ll find your collection efforts pay dividends.

Collections Tracking
The Aphelion Collection software is a specialized Contact Manager software package. The
system is uniquely designed to track members that are overdue in paying. This program
operates in a manner that is similar to the Prospecting module, instead tracking your
members that are overdue, rather than guests. Tracking
The program will track a member that is in the Collections process. Your collectors can
track phone calls and promises, and make a note of each call’s results. Designed to allow
quick entry of each call, the tracking screen allows you to track member information,
including the name, address, account balance, suggested call back date, and the notes from
every phone call.
When you enter a new note, a screen is displayed that will ask for the note-taker and the
note action. The note action will serve to remind and categorize the types of notes you are
adding. Actions and employees can be configured. Set the call back date field to the day
you wish to be reminded to call or contact the member.

Print Call Back Lists
The software will print a variety of useful reports with each providing important information
to your collectors.
Each day you can print lists of members that need to be called. These lists can be sorted by
priority, call back date, action, and employee. The call back lists include all the information
needed to contact the members with overdue accounts.
Or, display a list of call backs on the screen. A comprehensive list of the calls that need to
be made can be printed. Each employee using these reports will have the tools needed to
effectively manage their collection list.
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Simplify Follow-up
Every time a member is contacted you should place a detailed note in the member’s record.
Each note is tagged with the date, the employee, and an action item. With unlimited notes,
you’ll have a comprehensive record of each call, which employee spoke to the member, and
the result of the call. These notes remind your employees of the results of the last call, and
provide a sophisticated, quality image to your call. A detailed record of each conversation
allows you to escalate each call to the next level.
To Place a Member in Collections from Data Entry Module:
1.

In the Data Entry Module choose > Data Entry > Members.

2.

Highlight the member’s name and click <Convert>.

3.

Choose “Collections” and click <OK> and <Close>.
Members in Collections will have a red “C” by their name in the “Browse Member” screen.

To Place a Member in Collections from Collections Module:
1.

In the Collections Module choose > Browse > Collections

2.

Click <New> and then click in the box next to the member’s name to add the member to
Collections. <Close>.

To Preview/Print Call Back Lists:
1.

In the Collections Module > Reports > Call Back Reports.

2.

Enter beginning and ending call back dates.

3.

Choose an action from the pull-down menu.

To Preview/Print Notes Reports:
1.

In the Collections Module > Reports > Notes Reports.

2.

Enter the inclusive dates for desired reports.

3.

Choose “Assigned To” category from the pull-down menu. Choose “All” if you want to see all
notes for that time frame.

4.

Click the box if you want a detailed report.

5.

Click <OK>. At the “Reports” screen choose to print or preview the report.

To Preview/Print Custom Reports:
Custom reports allow you to filter the member data by date, employee assignment, membership
type, and membership status. You can also sort reports by zip code, name, call back date, next
action, sales person, priority, or telephone.
1.

In the Collections Module choose > Custom Report.

2.

Enter the inclusive dates for reporting period.

3.

Choose “Assigned To” category, “Membership Type”, and “Membership Status” from the pulldown menus.

4.

Choose a category to sort by. Click <OK>.

5.

At the “Reports” screen choose to print or preview the report.
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To Preview/Print “Payments by Member” report:
1.

In the Collections Module choose > Reports > Payments by Member.

2.

Enter the inclusive dates for the reporting period.

3.

Check one or more of the “Include payment” options:
-- against “Cash” invoices
-- against charges place “On Account”
-- “Unapplied”
-- generated by billing

4.

Click <OK>.

5.

At the “Report” screen choose to print or preview the report. Click <OK>.

To Preview/Print Member Collections Worksheet:
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1.

In the Collections Module choose > Reports > Worksheets.

2.

Tag the members for collection worksheets. You can choose one or more. Click <Close>.

3.

At the “Report” screen choose to print or preview the report. Click <OK>.

4.

To view the next report click the “Next Page” icon on the menu bar.

REPORTS

The reports module provides a window into the performance of your facility. This module
includes reports which can make “Reports” the most valuable module in the system.
The reports module is comprised of several functional areas. One area consists of
preformatted reports. These reports have been designed and refined over several years to
provide you with the management information required to profitably manage your club.
With these reports, the user will have available all of the information required to make and
implement proper business decisions pertaining to the site.
Another area allows you to define your own custom reports using our Memoritzed Reports.
The drop down menu asks you for the type of information you want on the report and allows
you to create the layout on the page.
You can modify and save your favorite reports so you can quickly run them again. You can
also group several of your favorite reports and run them at the same time with one keystroke.
The preformatted Reports section is subdivided into separate sections. These sections
include Member, Prospects, Inventory, Training, Employee, Accounting, Memorized,
Letters, Utilities, and Settings. The following section details the uses and purposes of the
reports in each of these sections.
The system will also allow you to create a list of “tagged’ members. Tagging your members
allows you to print form letters, mailing labels, or export to third party spreadsheets.
Tagging members can be performed as you run a report or as a user defined query. The
capability to save, modify, and create multiple tagged sets of members allows flexibility to
use other software tools to manipulate your data.

199

The system is tightly integrated with Microsoft Word. Merge fields can be created directly
in any Microsoft Word document. You won’t have to struggle with typical mail merge as
unlimited specialized form letters are supported.

Members Reports
Check-in
The Check-in section of the Reports Module will allow the user to keep track of the membership. Data can be obtained related to how and when your members are using the facility.
Additional reports will provide information on members who have not recently visited your
facility as well as reports showing which members are inactive. A report will give a
complete list of every member that has been entered into the database. The information
displayed includes the identification number, member name, membership type, and entry
date. It is recommended that the manager keep a listing of the members on file for reference and data security purposes. Depending on the traffic of new members, a new listing
should be made monthly. The following reports can be accessed from the “Check-in” menu:
• History (Lists members who have checked in within a range of dates.)
• Totals (Lists total number of member checked in within a range of dates.)
• Totals by Area (Lists total members checked in different areas of the club.)
• Members Visited Since a Given Date
• Members Checked in With Non-Ok Status
• Members Checked in For Status
• Members Whose Entry was Denied
• Inactive Members

Punch Card
Punch card reports will display members checked in using visit units. This report will allow
management to guage how well visit sales are performing. A second report will list all
members with visits remaining. Visit reports are especially useful if you are selling large
quantities of personal training, babysitting service, court time, or tanning. Punch Card visits
can be sold through “hot buttons” at the front counter (Point of Sale screen). From the
“Punchcard” menu you can access the following reports:
• Members Checked in using Visit Units
• Members with Visit Units Remaining

Groups
If you have memberships that are associated with a sponsoring group, you can generate
reports that will monitor your member’s affiliation with a group. The report will list the
members checked in by group affiliations. The following submenus are listed under the
“Groups” menu:
• Members Affiliated with a Group
• Members Checked in by Group

200

Contracts
This group of reports deals with contracts that are developed in Configuration. Contract
reports will provide you with pertinent information regarding active or expired contracts.
The report will help monitor members who are current and those who are not. There are
additional reports that will list members who have signed contracts or who have been
terminated. A statistical overview of all contracts by category will provide useful managerial information. The following reports can be generated from the “Contracts” menu:
• Expired Contracts
• Active Contracts
• Members Renewed over Range of Dates
• Members Terminated Over Range of Dates
• Members Terminated by Reason
• Members Joined Over Range of Dates
• Member Contract Statistics
Expired Contracts: This report provides a list of all members whose contracts will
expire within a specific date range. It is useful if a sales process for these members
needs to be initiated to renew the contract. The report prints a list of all members with
an expired contract. It is sorted by barcode ID and includes the member’s name, home
phone, contract expiration date, last visit (check-in, recurring dues amount, and the
renewal amount).
To Print Expired Contracts Report:
1.

In the Reports module, select Contracts > Expired Contracts.

2.

Select the membership types to be included in the report. The report initializes with all
categories selected.

3.

Click on any membership type (de-select) that you wish to remove from the analysis.

4.

Enter the date range that you wish to test the expiration date field against (Expired from/to).
Tags can be cleared and set from the output of this report.

5.

Select Preview or Print. <OK>.

Active Contracts: This report identifies a list of “active” or unexpired members. The
report program reads each member in the database and looks for members that have an
expiration date greater than or equal to the “Active as of” date. A member is also
included in the report if the expiration date is blank (not set) or the auto-renewal box is
checked. The “auto-renew to open end” check box is located on the Billing tab of the
member record (Data Entry). Checking this box indicates that the member is on an
open-ended contract that does not expire unless notice is given. These members, for the
sake of this report, are considered “active”. The report prints a list of all members that
meet the expiration date criteria. The list includes the member ID, the member name,
home phone, expiration date, last visit (check-in), recurring dues amount, and the text
written in the General Notes field. The report does not include Prospects, but does list
members that are “Frozen,” “Terminated,” or in “Collections”.
To Print Active Contracts Report:
1.

In the Reports module, select Contracts > Active Contracts.

2.

Select the membership types to be included in the report. The report initializes with all
categories selected.

3.

Click on any membership type (de-select) that you wish to remove from the analysis.

4.

Enter the date range that you wish to test the expiration date field against (Active as of).
Tags can be cleared and set from the output of this report.
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Member Contract Statistics: The purpose of this report is to summarize the member
database into classifications of active members, active contracts, renewed contracts, and
terminate/expired contracts. The report prints a summary by membership type and
billing cycle that includes the number of active members, active contracts, renewed
contracts, and terminated or expired members. Average monthly and yearly dues are also
computed in the report. The summary also prints a breakown of the active contracts by
form of payment and if the contract is associated with an individual or family member.
An average value for monthly and annual recurring dues is also computed in the report.
The “Active” criteria for this report is defined as all members that do not have the Status
field set to “Freeze”, “Terminate” or the members are in Collections. Members
designated as active must also have either a blank expiration date or the expiration date
value must be after the date range entered. Members set to “auto-renew to open end”
(on the Renewal tab of the member record) are considered active as long as the Status
field is not set to “Freeze”, “Terminate”, or the member is not in Collections.
The difference between the values for “Active Contracts” and “Active Members” is the
family or primary/seconday relationships. “Primary” members are those member that
are responsible for paying the dues and other charges for themselves and other members
(such as family members). A “Secondary” member has the “Bill To” field (on the
Responsibility tab of the member record) set to whomever is responsible for payment.
A “Primary” member has this field set to “self”. “Active Contracts” is a count only of
primary members whereas the count of “Active Members” includes both primary and
secondary members.
The values reflected in the “Renewed Contracts” are the number of members that have
the “Last Renewed Date” field (on the Renewal tab of the member record) set to a value
within the date range entered to start the report. The count reflected in the terminated/
expired contracts column includes all member that have a value for the “Deletion date”
field or an expiration date that falls in the initally entered date range. The report does
not include Prospects but does include members placed in “Collections”. Please note
that the report will also be affected by the club filter set from the “Settings” menu under
the “Select clubs” menu. You can choose to include members from “All Clubs” or only
from “selected clubs”.
To Print Member Contract Statistics:
1.

In the Reports module, select Members > Contracts > Statistics from the menu.

2.

Enter a date range for the contract statistics you wish to review.

3.

Select Preview or Print. <OK>.

General
There are a variety of reports to help you manage your membership data. These reports will
help distinguish sales trends, give information about your memberships visit habits, tell you
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when members have become inactive, list members by sales person and counselor. Reports on
member interests will help marketing strategies. In the report called “All Members,” the entire
database can be viewed and printed. Most of the member reports can be further divided by
several descriptive categories. Mailing lists can be generated to help improve retention rates
from these reports . There is even a report listing members’ birthdays by month. You will find
the following reports under the “General” menu:
• General Member Information
• All Members
• Members by Membership Type
• Members by Level
• Members by Status
• Member Notes
• Members by Counselor
• Members by Salesperson
• Member Dues by Salesperson
• Frozen Members
• Members with expired Lockers
• Members Birthdays for a Month
• Records that have changed
• Member Statistics
• Members with Interests
• Zipcode Distribution

Facility
This section of reports pertains to facility usage. You can configure the software to coincide
with the different areas of your club. By assigning these areas with specific titles, you can
generate reports that will tell you where and how your facility is being used. Knowing how
your membership is using the facility will aid in developing strategies. These strategies can
range from staff scheduling to facility maintenance. The Facility menu includes the
following submenues:
• Facility Usage Summary
• Activity Usage Summary

Classes
This section lists information pertaining to classes. These reports can help you better
manage your class and instructor schedules. The following reports can be accessed from the
“Classes” menu:
• Enrollments
• List by Instructor
• Calendar
• Attendance by Members

Prospect Reports
Selling new memberships is of paramount importance for your club to profit. Prospect
reports generated here will enable you to increase membership sales. You will be able to
track prospect visits, send correspondence, and develop sales strategies. Your marketing

203

plan to attract new members will be aided by the information generated by these reports.
Information on who and where new memberships are coming from can be charted. Sales
strategies can be developed to enhance how members and prospects are being discovered.
The following reports can be run using the “Prospect” menu in the Reports module:
• Prospect Call List
• Prospect About to Expire
• Prospects First Visit List
• List Prospects that Converted
• Prospects/Members by Source

Inventory Reports
In order to run an effective and profitable Pro Shop you will need to control your inventory.
Inventory control can lead to better Proshop sales and additional profits. Fitness Manager (at
the point of sale) will alert you to low inventory levels that you have specified in Configuration. The “General Lists” menu will provide a report which will list your entire inventory.
Another report will alert you to low inventory levels and aid you in restocking your inventory. The “Value of Inventory” report will help control inventory and avoid over and under
stocking of goods. The following is a list of the reports that can be accessed from the
“Inventory” menu:
Lists:
• General Lists
• To Reorder
• Restocking
• Value of Inventory
Sales:
• Itemized Sales
• Ranked Item Sales
• By Member

Training
The training menu allows the user to preview and print reports concerning personal training.
Select the “Lising” menu to print a report that lists all personal training available during a
specified time period. The “Remaining by Member” option allows you to print a list of
personal training units remaining for all members. Choose “Instructor Commissions” to
view commissions accrued for personal training during a specified time period. Submenus
included under the “Training” menu are:
• Listing
• Remaining by Member
• Instructor Commissions

Employee Reports
It is good business practice to keep accurate and professional employee records. Fitness
Manager will help keep those records. In addition to a basic employee phone list, there are
several reports that will assist in tracking employee wages. The Earned Wage report lists
each employee, the time they checked in and out, and earned wage calculations. The
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“Sales” report lists employee sales over a prescribed time period. The listing includes any
items that are configured as commissioned. The following reports can be found under the
“Employee” menu:
• Phone List
• Time Clock Over Range
• List Timeclock Records
• Earned Wages
• Sales by Attendant
• Sales by Salesperson (Cash)
• Sales by Salesperson (Accrual)
• Certifications
• Certifications by Employee

Accounting Reports
The Accounting reports within the Reports module provide detail and summary information
regarding sales and member accounts receivables. Activities performed through the accounting system can be monitored through these reports.
“Accrual” reporting examines invoices to determine sales while “cash” reports view the
payments that have been received.
Many of the Accounting reports have the option of “Cash” or “Accrual” method reporting.
The “Cash” method examines the payments made against invoices/charges to determine
sales values. The “Accrual” method examines the invoices directly to compute sales values.
In “Cash” reporting, a one-year membership contract that has 12 monthly payments will
only show sales based on the portion of the payments made by the member. In “Accrual”
method reporting, the full amount of the membership sale is reported on the date of the
sale.

Station Cash Drawer
This report provides information required to reconcile the cash in the drawer against sales.
The actual currency in the drawer is compared to the amount sold to produce an over/under
value.

Sales Summary
Sales summary reports provide information on all payments received and club sales within
the range of dates you specify. It is possible to filter the information based on the club
location where the transaction was entered or by the member’s home club.

Income by Account
A table of accounts is displayed with sales values shown in the income accounts. Expense
accounts are shown to summarize amounts placed in these accounts through payment
discounts and credit memos. Select the date range of interest prior to executing the report.

Income by Membership Type
This report provides income reports by membership type. You can choose to sort by the cash
or accrual method as well as by billing categories.
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Sales Tax
Sales tax reports include taxable sales, or non-taxable sales for a specified time period.

Cost of Inventory Goods Sold
This report provides a detailed assessment of retail inventory for costs and profitability. The
report lists each item in the inventory along with its income account. The total number sold
and the total revenue for each item is also listed (with tax values separated). The COGS
(Cost of Goods Sold) is computed based on a First In/First Out (FIFO) approach. The
computer maintains a complete restocking history of inventory. This information is combined with the sales history for each item to computer the COGS. A net dollar margin is
also shown for each retail inventory item that reflects the difference between total revenue
and COGS. A percent of total profit is shown for each item in the list. This column reflects
the items contributing most to retail profitability.

Receivables
A series of reports that analyze the member account receivables are provided under this
menu heading. Aging of the account receivables is provided in current due as well as 30-6090-120 days overdue. The accounts are grouped by member category and show a complete
summary for each member.
A “Value of Accounts” report is provided to show the receivables that are currently due
along with the amount to be billed in the future. This report is useful when assessing the
total value of membership contracts on record.
An “Open Invoices by Member” report shows all unpaid invoices/charges for each member.
This report displays the total amount of the invoice, the amount that is currently due, and
the remaining balance on the invoice. Aging (in days from the invoice date) is shown for
each open invoice.

Billing
The Billing reports in the Accounting section focus on details associated with members
paying recurring dues. These amounts and due dates are controlled in the Billing tab of the
member data entry forms. Recurring dues apply to an open-ended type of contract where
the member is paying a specified amount each month for an indefinite term. The reports
will provide summary information as well as a detailed list of billing information for each
member.

Monthly Totals
This utility is found under Accounting > Billing > Monthly Totals. It allows the user to
generate monthly totals reports. You can filter the information by member type, billing
cycles, and form of payment.

Dues Receivables
This option allows the user to print dues receivables within a specified date range.
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Four Year Billing Prediction
This utility generates a four year prediction of income generated by periodic dues payments. The report lists barcode number, member name, billing cycle, amount due each
billing cycle, accumulated values, and total values of the dues for the next four years.

Form of Payment Summary
This utility generates a report which lists the forms of payments, billing cycle, number of
memebers using each type and cycle, and the total amount due for each billing cycle.

Members Not Billed (R.Dues)
This report helps identify members that, due to an improper data profile, will not be
billed. The report prints the member ID, the “Bill To” name, status, category, form of
payment, next billing date, last billing date, recurring dues amount, and the current
account balance.

Transactions
The reports in this section detail activity within the accounts receivable system. Reports are
available to list invoices, charges, and payments over any range of dates. For security
purposes, reports are also provided to review voided POS transactions, removed (cancelled)
payments, and credit memos applied to invoices on a member’s account. All transactions
performed on a member’s account can be listed in this section of reports. Payments that are
unapplied to invoices can be listed in these reports. These payments should be reviewed and
applied to open invoices/charges through the “Get Payments” function available from the
“Account Summary” screen.

EFT
The EFT reports provide information relative to the accurate creation of EFT files. A list of
members currently set for “pre-note” can be made from these reports. Also, if you have
members that pay their accounts by credit card, a list of members whose credit card has
expired (or is about to expire) is available. Other reports provide information regarding
your bank listings that ensure your transit/route numbers are properly assigned.

Query Integration
A query performs an evaluation against a chosen data field (or fields) to determine if a
member record will be included in the results. This filtering capability differs from Standard Filters by offering customizable evaluation functions. Standard Filters offer a limited
number of “on/off switches,” while the query provides for Boolean (AND/OR) statements to
perform multi-leveled filtering tasks. For example, Standard Filters can compile a list of
members whose form of payment is equal to “draft.” A query can generate a list of members whose form of payment is equal to “draft” and dues total is greater than $50. Query
statements can be as simple or complex as you wish.
The Query function has been integrated into several areas of the software to focus searching
for specific members or employees. The functionality can be found in customized reporting
and member tagging from the Reports Module or Member and employee browsing from the
Data Entry module.
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Creating and Saving a Custom Query:
1.

The Query Wizard is accessible by selecting the “Query” button in many browse
windows. For example, from the Data Entry module, it is available in the “Browse
Members” window.

2.

Selecting the “Query” button opens the “Saved Queries” window.

3.

Select “Insert” to add a new query; “Change” to edit an existing query.

4.

Follow the on-screen directions and use the following documentation to set up
your desired query.

5.

After all parameters are defined, select “Finished” and “Yes” to save the query.

Aphelion Fitness Center
1100 NASA Rd 1 #606
Houston TX 77058
@DATE@
Dear @NAME, FIRST@ @NAME, LAST@,
Thanks for joining our facilities on @Date, Join@.
We hope you enjoy your membership. It will expire
on @Date, Termination@.
Thanks,
Mr. Manager

6.

Assign a description
to example
the query
select
The above is an
of aand
simple
form OK.
template.

Field Selection
To set up a query, it is necessary to select fields to evaluate. The query Wizard lists all data
fields available for comparison. Field selection can be considered the subject of the
statement. Using the above example, the Field Selection is Form of Payment.

Operation Selection
After a field has been selected, it is necessary to choose how it is to be evaluated. Operations determine how a record will be evaluated and whether or not it will be included in the
results. Available operations are dependent on the data field selected. The selected operation of the above example is ‘is equal to’.

Value Entry
Value entry gives options for comparison. Comparison can be based on a constant value,
another field, or expression. Constant values can be numeric or alphanumeric, depending
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on the initial Field selection. Once Value entry is selected, the Query Wizard moves into a
Current Query summary screen.

Additional Condition Statements
Additional statements can be added to the query. This creates a statement with dependent
conditions. By highlighting the initial statement (Form of Payment Is Equal to DRAFT),
add a related statement by choosing from the <AND> or <OR> buttons. This will return
you to the Field Selection window to create a second statement dependent on the first.
The Query Wizard also supports complex statements containing multiple independent
conditions. “Dues Total is greater than $50 and zip code is equal to 77058 OR Dues Total is
less than $50” is a combination of a dependent statement and an independent statement
(separated by OR). The results of this query list member records with both a dues total
greater than $50 and a 77058 zip code, and all members with less than $50 dues total
(regardless of zip code). To create a statement independent of previous statements,
highlight the blank space below the last statement, and choose your additional conditions.
Queries can also be saved using special “Run-time” expressions. See the appendix for more
information.
Run a single Query:
1.

Locate and select the “Query” button from a “Browse” window (i.e. “Browse Members”
window in Data Entry)

2.

Highlight a desired query and press the “Select” button.

Run/Joining multiple Queries:
1.

Run a single query (see above)

2.

Select the “Query” button again to open the “Saved Queries” window

3.

Select the desired query and how you wish to have it joined (and/or)

209

Query Wizard “Run-time” Expressions
A query condition consists of a field, a comparison operator, and a value to compare that field against. For
instance, the condition “Join Date>1/01/1999” has the field of join date, the operator of greater than and the
comparison value of January 1st, 1999.
Normally, when you create and save a query, you used a fixed value for comparison. In order to make the saved
query more reusable, you can use special values for some of the query fields, so that when you select that query,
the program will prompt you to enter that value at the time of running the query rather than when you created the
query. The following is a list of the current “run-time” values you can use:
Field(s)
Any date field
Bank Name
Billing Cycle
Club Number
Salesperson ID, Employee ID
Group Name
Membership Type
Form of Payment
Status

Value
PROMPTFORDATE
PROMPTFORBANK
PROMPTFORBILLINGCYCLE
PROMPTFORCLUB
PROMPTFOREMPLOYEE
PROMPTFORGROUP
PROMPTFORMEMBERSHIPTYPE
PROMPTFORFORMOFPAYMENT
PROMPTFORSTATUS

Action
Select a date from calendar
Select from a list of banks
Select from a list of billing cycles
Select from a list of clubs
Select from a list of employees
Select from a list of groups
Select from a list of membership types
Select from a list of form of payments
Select from a status list

To set up a query using one of these special “run-time” values, take the following steps:
1.
2.
3.

4.

When creating a query, select one of the fields listed in the above table. For example, select Join Date and
press the “Next” button
Set your comparison operator and press “Next” again.
Click on the “Expression” choice. Then in the entry field below it, type the appropriate run-time expression. In
our example, we would type PROMPTFORDATE (the capitalization is not important, but the spelling must
match exactly).
Complete and optionally save the query.

When you complete the query, you will be prompted to perform an action for each run-time value you entered. If
you saved the query, each time you select the query you will be prompted for the values again.
In addition to the special run-time values described above, you can use a number of other field expressions from
the Clarion programming language that Fitness Manager is written in. The table below lists the most useful of
these.
Field(s)
Any date field
executed

Value
TODAY()

Action
Uses current date when query is

To use these fields, follow the same steps as above. However, with these expressions, you will not be prompted for
a run-time value.
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Memorized Custom Reports
The memorized reports process is twofold: member filtering and report layout. It is necessary
to first “filter” the member records to extract data from and then display it in a chosen format.

Filters
The “filtering” process can be accomplished through the use of standard filters, queries, or
tags. Standard filters contain a list of general criteria used to limit your data search.
Queries perform a specific evaluation against a chosen data field. Running Standard
Reports or individually selecting records can set member “Tags.”
Set member record “Tags” for memorized reports (Reporting):
1.

Select a desired member or prospect listing report to run (available under the Members or
Prospect menu).

2.

In the “Member Tagging” boxes, select “Set tags from report results” and “Clear
tags before running report.”

3.

After the report is run, the member tags are set.

Set individual member record tags (Reporting)
1.

In the Reporting module, select the Utilities > Show/Edit tagged members.

2.

Select the members you wish to tag.

Layouts
Layouts select and format specific data fields for output to “Reports”, “Spreadsheets”, and
“Crosstabs”. Reports creates a hardcopy, printable format of selected data fields. Spreadsheets incorporate selected data fields into a spreadsheet file. Crosstabs provide a cross

Aphelion Fitness Center
1100 NASA Rd 1 #606
Houston TX 77058
11/01/97
Dear John Doe,
Thanks for joining our facilities on 11/01/97. We hope you enjoy
your membership. It will expire on 11/01/99.
Thanks,
Mr. Manager

The above is an example of the results after template has been “processed”
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tabulation of summary information (sum, average, or count) for a selected data field. The
Reports layout is limited in the number of available data fields it can process due to paper size.
Spreadsheets and Crosstabs can be formatted into various versions of Excel spreadsheets,
HTML documents, or ASCII tab delimited files. All layouts can be saved for repeated use.
“Reports” prints a hardcopy of the selected data field results. To create a “Reports” layout,
first select data fields to print. Limit the layout to 5 or 6 selected fields. If the report is
unable to fit data onto a printed sheet, it will not process any fields outside the printable
area. Next, choose a sort order. Default sort order refers to the order data fields were
selected. Pre-defined sort order allows you to choose from a drop-down list. Custom sort
orders allow you to sort by a maximum of four data fields and choose an ascending or
descending order. If you select a Custom order, you can choose group heading and footing
options based on your sorting levels.
To create customized reports layouts (Reports):
1.

From the Reports module, select Memorized > Members > Reports.

2.

Select the filtering method you wish to use

3.

In the “Custom Reports” window, select “New” to create a new report or “Modify”
to edit an existing one.

4.

Define the new Report description.

5.

Define the Report column layout by selecting listed data fields.

6.

Select Next.

7.

Select a sort order for the output.

8.

Follow any on-screen instructions.

9.

Select <OK>.

Spreadsheets give more flexibility for displaying data than Reports. Because they are an
electronic format, a printable area does not limit the number of selectable fields. In addition, the Spreadsheet layout offers multiple “destination” formats. Creating a Spreadsheet
layout is similar to creating a Report layout. First select data fields for output, and then
select a sort order. Sort order options are the same as the Reports layout; however, there are
no group header/footer options. After the layout has been selected, a destination format is
required. View/edit the results, save results as a Microsoft Excel® spreadsheet (versions 4,
5, or 7), display results as an HTML document, or save as an ASCII tab delimited text file.
To create customized spreadsheet layouts (Reports):
1.

From the Reports module, select Memorized > Members > Spreadsheets.

2.

Select the filtering method you wish to use.

3.

In the “Spreadsheet Layouts” window, select “New” to create a new report or “Modify” to
edit an existing one.

4.

Define the new Spreadsheet description.

5.

Define the Spreadsheet column layout by selecting listed data fields.

6.

Select Next.

7.

Select a sort order for the output.

8.

Follow any on-screen instructions.

9.

Select <OK>.

“Crosstabs” provide summary cross tabulations for selected data fields. For example, this
layout will create a table that calculates an average dues total (data point) per salesperson
(columns) per zip code (rows). Create a “Crosstabs” layout by selecting a data field you
wish to summarize (data point) and two plotting criteria (rows and columns). Next, select an
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operation for the data point (sum, average, or count) and plotting options (limit output to the
highest value row/column pairs, if desired). When the cross-tabulation is complete, the
intersection of a row/column combination represents the overall sum, average or count for
that row/column pair. Complete the report by selecting the saved crosstab layout and a
destination format (same as Spreadsheet layout).
To create customized crosstab layouts (Reports):
1.

From the Reports module, select Memorized > Members > Crosstabs.

2.

Select the filtering method you wish to use.

3.

In the “Cross-tabs Layouts” window, select “New” to create a new report or “Modify” to
edit an existing one.

4.

Define the new Crosstab description.

5.

Select the data elements for each axis and Next.

6.

Select the data operations and plotting options and Next.

7.

Select a format style and Finish.

Mail Merge
Mail Merge is a process similar to customized reporting. Specified data fields from member
records are “merged” with a layout (Word document template) you create. The purpose of
mail merge is to create personalized letters for promotional or account balance information.
Mail Merge is a feature of Microsoft Word® that the Fitness Manager incorporates to create a
seamless interaction making this feature easier to use.
Mail Merge is performed in two steps: first, select a document template that contains embedded member data fields; next, use filters to select member records. The Mail Merge feature of
Microsoft Word® creates a Word® document (. doc file) for each selected member and automatically replaces embedded data fields with actual values.
If you do not have a document template containing embedded merge fields, it is necessary to
create it (see below). Available filtering tools are the same as Customized Reporting filters. See
above for descriptions.

Installing the Fitness Manager Macro
The Fitness Manager provides a Microsoft Word® macro to make inserting data fields into the
newly created template easier. To take advantage of this macro, it is necessary to copy the file
“FM Form Letters.dot” (located in the Aphelion\Letters directory) into the Program
Files\Microsoft Office\Office\Startup directory (assuming default installation directory).
Once the “FM Form Letters” template is located in the Office\Startup folder, it is necessary
to restart Microsoft Word®. The macro is located on the bottom line of the Insert menu.

Mail Merge Templates
Fitness Manager uses Microsoft Word® templates for Mail Merge. Templates contain the
body of a given form letter and embedded tags that specify member record data fields. All
embedded tags are then replaced with appropriate member record data and printed.
The following is an example of a simple form template:
Creating Microsoft Word ® Templates:
1.

From the Word menu bar, select File > New.
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2.

Select the radio button “Template” and click OK.

3.

Write the letter as desired, using the Fitness Manager macro to insert (embed)
data field tags where needed.

An example of text that contains embedded data field tags is: “Dear Mr. / Mrs. @Last Name@,
as of today, your account balance is: @Current Balance@.” Data field tags are surrounded
by the “@” symbol. For this example, they are also italicized. Sample document templates are
located in your Fitness/Letters directory.
How to use the Fitness Manager macro in Microsoft Word®:
1.

Place your cursor where you wish to insert a data field.

2.

Select Insert > Fitness Mgr Fields. If the macro is not available from this menu, it
is not installed properly. See “Using the Fitness Manager Macro” for installation
instructions.

3.

Select the field you wish to insert.

4.

Exit the macro.

Mail Merge Setup
The Mail Merge Setup window is accessible through the menu bar by selecting Letters >
Setup in the Reports Module. In this window, select your local version of Microsoft Word®
and other preferences as follows.

Testing the Mail Merge
Before printing hardcopies of your merge results, you may wish to test their appearance. To
do so, place a check in the checkbox “Show the document after processing” and remove
checks from “Print the document” and “Delete the document after it is printed.” When the
Mail Merge is processed, you will be able to look at each Word® document created from the
selected template. You can edit each file and print as normal.

Direct Printing Mail Merge
Mail Merge can also directly print the created documents. To do so, in the Setup window,
uncheck the checkbox “Show the document after processing” and check the boxes “Print the
document.” To increase computer performance, place a check in the checkbox “Delete the
document after it is printed.” After member records are selected through the filter process,
Word will begin the merge process and directly print each document created.

Letters
The software provides the capability to print custom form letters to send to your members and
prospects. The form letter generation is sometimes referred to as “mail merge” though this
term is incorrect for the method we use. Mail merge requires you to export a file and then
merge it using your word processor. We make it simple! Form letters allows you to set up a
letter that includes a common message or information and add information that changes (such
as a member’s name) to each letter. In this manner you can create your letter one time and
sequentially print the same letter to your members right from the program.
You can set up as many form letters as you want, and they can be adapted for whatever
situations you require.
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The program utilizes Microsoft Word as the editor. You must have Word installed on your
computer to utilize the Form Letter capability.
The form letters use Dynamic Data Exchange. DDE is part of the windows environment
which makes it possible to exchange data between different windows programs. The
dynamical thing about it is that when data is updated in the Aphelion program, it is automatically refreshed in the document.
The Aphelion software modules use merge fields. The merge fields allow you to automatically update your document with current information. If you add an address to your document with the address-merge field from the program, the address is always up to date.

Keywords
A comprehensive list of available keywords is located in the Appendix at the back of this
manual. Since the program is constantly upgraded, you may find more keywords in the pull
down menu than on the list.

Choosing Members For Your Form Letters
The Aphelion software has the capability to “tag” members. Tagging members allows you to
send a form letter to a member or a group of members. Tags are “flags” on a member record
that indicate that they’ve been marked for a special purpose.
Reports act as a filter on the member database and are used to select which members or groups
of members are tagged.
The Reports are used to select the subset of the members that will be tagged. When you run a
report, you have the option of tagging all of the members that are included in the report. It is
useful, for example, to tag all members that have delinquent accounts, or those that just joined
the club. To tag members in this manner, run the report that will provide the information that
you are looking for, and then select the report option that tags the members (for example new
members that have joined since the first of the month).
When the members have been tagged, select Letters > Print Form Letters from the menu. Look
in the Aphelion folder for the form letter you want to use.

Sending The Letter
As outlined previously, members can be “tagged” via the reports or via a manual process.
Regardless of how you tag the members receiving the letter, you would want to have a form
letter previously written. Each form letter will be written specifically for the type of
situation required. For example, one type of letter may be a membership letter and another
type of letter may be a late fee payment letter.
You choose the specified form letter every time you run the utility to print form letters. The
members that are “tagged” will receive the form letter.

Utilities
Utilities are provided to support the convenient operation of the Fitness Manager. Utilities
will make recurring work and database maintenance easier, allow you to clear special
counters, delete terminated members, update the Pro-Shop selling prices, modify billing
dates, and print membership cards.
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Select Utilities from the Reports module: Reports > Utilities. Following is an overview of the
utilities provided.

Show/Edit Tagged Members
This utility allows the user to browse the member database by last name, barcode ID number or
agreement number. Members can be tagged for use in other applications of the program. You
have the option of tagging all members or a select few.

Mailing Labels
Use the mailing labels utility to print mailing labels for the names in your database. Printing
mailing labels is a two step process. You must first choose the way the labels are sorted when
they are printed. Second, you must choose the members you want selected for printed labels.
There are various ways to filter your members: standard filters, queries, tags, or none. When
you select none, you will get labels for all of the names in your member database.
To Print Mailing Labels:
1.

In the Reports Module, select Utilities > Mailing Labels.

2.

Select a starting postion. This refers to where the first label will print on the page.

3.

Select the sort output by: name, barcode or zipcode. Click <OK>.
If you choose to sort by name, the labels will be sorted alphabetically. When you
sort by barcode or zipcode, the labels will appear in numerical order on the page.

4.

Select a method to filter member names.
Standard Filters: Select the members you wish to include in the label output.
Query: Select a saved query or define a new query.
Tags: Select members by manually tagging them.
None: Selects all members in the database.

5.

Select Preview or Print labels. Click <OK>.

Barcode Labels
Selecting the “Barcode Labels” option from the Utilities menu prints client barcode labels. To
print the cards, insert the card stock into the printer.
The label utility will print the barcode identification labels on single column mailing label stock
of 15/16 inch (height) by 3 (or 3 1/2) inches wide.
Once you have the printing centered on the labels, the automatic printing can begin. Start the
printing process and stop it after approximately 10 labels have been printed. Use the barcode
reader to sample the 10 labels printed. If the successful read rate is high, continue printing the
labels. It is recommended that you periodically (every 250 labels or so) stop the printing
process to check the labels with the barcode wand and make any changes to the Lighter/
Darker adjustment on your printer. Also, this gives the print head a chance to cool.
During label printing you can select the database record you desire to print. Note that you can
print an individual barcode, a sequence of barcodes, or all barcodes. Printing can be aborted
by pressing the <ESC> key. After pressing this key you must wait while the printer buffer
clears before the printing actually stops.
Once you have determined that the labels are working properly, restart the batch printing
process. If the labels are not reading properly, you should check several potential problem
areas. First, see if the ink is spreading from the dark lines into the white spaces. The print
head can be adjusted away from the platen surface (check your printer user’s manual). Also,
verify that the ribbon is installed properly and that it uses a carbon or black dye based ink.
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Membership Cards
Membership cards must be printed with an indelible ink based ribbon.
To print membership cards:
1.

In the Reports Module, select Utilities > Membership Cards.

2.

Select a starting postion. This refers to where the first card will print on the page.

3.

Select the sort output by either name, barcode or zipcode. Click <OK>.
If you choose to sort by name, the cards will be sorted alphabetically. When you
sort by barcode or zipcode, the cards will appear in numerical order when printed
on the page.

4.
5.

Select the type of card stock you wish to print the card on. Click <OK>.
Select a method to filter member names.
Standard Filters: Select the members you wish to include in the label output.
Query: Select a saved query or define a new query.
Tags: Select members by manually tagging them.
None: Selects all members in the database.
Click <OK>.

6.

Select Preview or Print labels. Click <OK>.

Numbered Barcode Labels
Use this utility to print barcodes when you don’t want the member name or other demographic
information attached. Choose any number to begin the numbering process. You can also
choose a three digit prefix to be added to the number. The starting position refers to where the
first label will be printed on the page.

Coupons
Coupons can be printed using two methods. This utility will allow you to print coupons for a
single member, a range of members, or a member category. You’ll enter the total dollar amount
and the number of payments, and the software will print coupons three to a page.
An alternate method to print coupons is available from the Register screen. When you are
finished conducting an Account transaction to a member account, you are prompted to print
a receipt or alternately, to print coupons.

Batch Change Member Fields
The “batch change member fields” utitlity allows you to change information for several
members in one step. For example, you can change the membership status from “OK” to
“Freeze” for several of your members with one action.

Batch Change Member Dues
This utility provides a way to change all tagged member’s dues to a new amount or change
their dues by a percentage.

Batch Change Visit Counts
Use this utility to batch change visit counts for club services.You can change the visit count
by adding to the current value or changing the current value.
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Check Required Member Information
This utility will allow the user to check the member database for missing and required information. The program requires a minimum amount of data to be present in the member database to
operate correctly. This utility checks the member database records for missing information that
is required for proper operation. Missing information includes missing credit card numbers,
expired billing dates, bank information, categories, etc. You should run this report periodically,
and add any information to the member record that may be missing.

Apply Late Fee To Accounts
If you charge a late fee for overdue accounts, this utility will be of service to you. This utility is
designed to automatically sort through the member accounting records and detect delinquent
accounts. When a delinquent account is found, a late fee is assessed to that account. The
late fees can be either a fixed fee or a percentage of the late amount.
To operate, select the report filtering method: default settings or select filters. Choose to “set
tags from reports results” and/or “Clear tags before running report”. Check the box to “apply
late fee.” If this box is not checked, late fees will not be applied to the members you designate.
Select “fixed amount” or “fixed percentage”. If the fixed late fee is selected you must enter the
dollar amount of the late fee. Similarly, if a percentage is desired for late fee computation, enter
the percentage in the appropriate field. Select a date for “accounts Past Due since” field. Enter
a minimum dollar amount for past due accounts. Enter the late fee due date. Enter the late fee
description. Click <OK>. Preview or print the report.

Add Charges To Members
This utility will allow the user to manually add charges to all tagged members’ accounts. For
example, you could apply NSF fees to a group of members by using this utility.

Non-Active Members
Selecting this utility option causes a submenu to appear with further utilities for maintaining
your member database with respect to inactive members. Inactive member maintenance is
recommended to preserve good performance in the system since unused information tends
to clog the computer’s throughput.
Terminate Expired Member
This utility will search through the member database records and find members with expired
contracts. When a member is found with an expired contract, the member status is set to
“Terminate.” You can select whether you want the data sorted alphabetically or by barcode
ID number. When you use this utility, the program will prompt you for some date parameters to govern the execution of the utility.
Purge Terminated Members
Select this option to delete all members that have their status set to “Terminate.”
Members are set to “terminate” by changing the STATUS field in the member’s record. This
can use the TERMINATE status, rather than deleting your members, so that they can remain
in the member database. This will allow you to keep them on mailing lists, etc., without
conducting billing.
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You can select the order of the listing to be either alphabetical or by member ID number. The
parameter field to be entered is the “Terminate before” date. Members will be purged from the
database if the termination date in the data record falls before the date entered in this field.
This field can be used to purge only those members that have been terminated for an extended
period of time by setting this date six months, one year, etc. in the past.
Deleted Expired Prospects
Select this option to delete old/inactive prospects. When entering a Prospect record (in the
member database) you can enter an expiration date to support deletion of old prospects.
The utility uses this date to look for expired prospects and delete them from the Prospect
database. Any prospects that are older than the user set date are deleted.
Choose the listing order, either by member ID or alphabetical by last name. Then enter the
reference date for deleting old prospects. Each prospect record will be examined and the
expiration date compared to the date entered. If the expiration date in the prospect record is
before the date entered in this field the prospect record will be deleted from the database.

Purge
Use this utility to delete check-in data, time-clock data, member notes, and paid transactions.
Select the data you wish to purge and then set the date parameters.

List Members w/Duplicate Agreement Numbers
Agreement numbers are entered in the database at the time the sales contract is entered. Any
number can be entered into the agreement number field. The “List Members w/Duplicate
Agreement Numbers” utility prints a list of the members with duplicate agreement numbers.

Set Values For Blank Member Agreement Numbers
This utility will set all blank agreement numbers from the member’s existing barcode IDs.
You can choose either “prefix” or “postfix” values to place before and after the barcode ID
in the resulting agreement number.

Edit Timeclock Records
If timeclock records were incorrectly entered, or if an employee neglected to clock in or
clock out, the records can be changed by the manager. Use this utility to enter the correct
clock-in or clock-out time.

Inventory
The inventory utility allows the user to print barcode labels for inventory items. Two options
are available: “Quantity update labels” or “Barcode Labels.” Choose “Quantity update
labels” when you wish to update the number of items in your inventory and print additional
barcode labels for those items. You can also change the barcode number on an existing
inventory item. The “barcode labels” option allows you to batch print barcode labels for
existing inventory items.
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DATA EXCHANGE
Overview
The Data Exchange module is designed to allow you to have free access to your data, and to
allow the exchange of data from other software programs. This module will move information out of the Fitness Manager program (export) into ASCII files, or move data into the
program (import) from ASCII files. Additionally, the software will export data in a format
that is unique to other types of programs, including accounting, fitness assessment, and
restaurant POS.
The import and export of data can be used to move information between clubs, to send
accounting information to your accounting package, and to share information with other
fitness related software packages.
The module is organized with an import and export menu. These menus provide for moving
data into and out of the databases. A setup menu is also provided to define the format of the
date fields

Multiple Site Data Exchange
This section describes the utilities that are available to move data from one site to another
and the programs that can be used at the central site.
As new members are added at the clubs, data can be moved from each site to the central
site. Billing, membership changes, and accounting can be performed at the central site, and
updated information can be moved back to the clubs.
Moving Data
New and changed contracts can be moved between sites without overwriting local changes.
While only a subset of the data files handled in Fitness Manager are moved, these files are
sufficient for billing purposes. The files available for import/export include member
records, member account information, and membership contracts.
The exported files can be transferred between sites via modem or using disks.
The Data Exchange module can be operated interactively, via the menu selections. The
program can also be automated, via a scripting language, which will allow the program to
automatically move information in and out of the club databases on a schedule.
Setup your sites
Each site should be running the same revision of Fitness Manager and have a copy of the
Data Exchange module available. You will want to assign each club a separate “club
number”, starting from 1. Each site number should be unique. The club number is setup in
the Configure program at each club.
(If you set the club number to “0”, all records in the database will be displayed.)
Each member record and member payment record is tagged with a club number. When the
club adds a new member or accepts payment against a member’s account, the club number
is stored with the transaction. This will allow the Data Exchange module to distinguish
where that data came from when shifting the information between locations.
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In order to maintain consistent member information between sites, it is also important that
configuration settings are consistent at each location. This would include the member types
and billing cycles, and the forms of payment. If you are using activity tracking, make sure
that the activities are configured identically. For prospecting, ensure that the source
categories and actions are consistent.
Running The Data Exchange module
This section will explain the operations that the Data Exchange module can perform. The
next section will explain how to use these operations to handle various multi-site scenarios.
Exporting data
Select “Export data” to extract data from a local club to move to another location. The
following inputs are date fields that will determine which records will be exported. The
date labeled “Added since” will filter the records and only export records that have been
added on or after the date you set here. The “Updated since” input will restrict any records
that have been changed to those before that date. Most likely you will want these dates to be
identical, and set to the date value based on the last time you ran the export function at this
location.
The “Include Member types” setting is combination box choice, which can be toggled using
the space bar. A check mark indicates that prospect records, customer records, or both,
should be included in the export.
The customer export allows you to specify which fields are to be included. A list of all
exportable fields is displayed on the export screen. You can also limit the records that will
be exported, based on either the date the record was first added, or when it was last updated.
Leave these fields blank to export all records.
You can specifically choose which member fields will be exported, or you can choose all of
the fields. Once you are satisfied with your inputs, select the “OK” button. The program
will warn you if any of the inputs are invalid. Once the export process is started, a display
will indicate it progress.
Importing data
You will choose to Import data in order to move information from another location into the
local club’s data. You will need to have the file from the other club that has been exported
by the same release of the Data Exchange module.
You must tell the program where the import data should be read from, by setting “import
file name”.
As the import process is taking place, a screen will show its progress. A file will be created
in startup directory, named IMPORT.LOG. This is a text file that will note any errors or
conflicts that occurred during the import process. You may want to print or edit this file for
a detailed explanation of the import results.
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Using The Data Exchange module
There are 3 basic multiple site scenarios that the Data Exchange module is intended to
satisfy:
Entering/modifying contracts at a central site and distributing the information down to the
club level.
Entering/modifying contracts at local sites and moving the changes to a central site for
billing purposes.
Entering/modifying contracts at multiple local sites and distributing changes between them
to maintain common sets of members.
Centralized billing
Each club location will add and modify their own member data and post payments. On a
regular basis, these sites will export data for their club. All of the exported data will be
transferred to the central site where each set will be imported.
The central site will perform the billing for the merged data from all of the clubs.
If account payments are posted at the central site, then member payments should be exported for the remote club locations. The central site should have a unique club number,
such as 1. Be sure to export using the club number assigned to the central site.
At the remote club sites, import the data from the central site. You should use this process
to update the accounting information at the clubs; thus only account transactions associated
with members at that remote clubs should be imported.
Localized data entry & billing
This scenario may apply to where there are multiple clubs in the same area and members are
allowed to float between locations. In this case, it may be desirable to maintain a common
set of members at each club, and maintain the ability to make changes at each site.
As an example, consider a case with 2 clubs, numbered 1 and 2. Both clubs would be
routinely exporting their own club’s data and importing the other club’s data. This would
ensure that new members added at each club would get merged with the other club’s
members.
If billing will be run at each club, the process will require some additional precautions. You
will want to segregate members that will be billed at each location in some way; probably
using separate member categories would be the best approach. This would allow each club
to export payments posted locally to the other club, but will avoid sending the member
multiple bills. It will also allow the member to place pro-shop charges “on-account” at any
of the locations.
If the billing will only be run from one of the clubs, you may still want to move each club’s
new account transactions to the other club. This will allow both clubs to properly identify
members with outstanding account balances.
Data Exchange File Formats
Aphelion has standard file import and export functions that are used for data conversions
and for moving data between sites running the Fitness Manager software

223

The files used in the import function must be in standard comma delimited text files
formats. A comma separates each field, with string fields surrounded by double quotes.
Each record in the file is ended with a carriage-return line-feed pair.
A following is an example of a 4 record comma delimited file consisting of a string,
numeric, and string field:
“John Doe”, 34,”713-651-6487"
“Mary Sutton”, 42,” -334-4078"
“Bob Smith”,,””
“Al Currey”, 14,”123-456-7890"
The fields in the customer import must be defined in the first line of the file, using a
“header” record. This line consists of the included field names, in a comma delimited
format. The field names should exactly match the allowed field names for the customer file.
You can view a list of these in the program under the menu item: “Help | Member Import
Field List”. In addition, a utility is provided to check the field names in the header of your
customer import file, under “Import | Check Member Import File Header”. The lines
following the header line should include values for the fields included in the header, and in
the same order.
The customer import allows you to add new records, update existing records, or delete
existing records. You can specify which action the program should take by including a
“Record Action” field in each data line. Alternately, if you don’t include this field, you can
specify a default action on the import options screen. You also specify the location of where
the customer data file for import is located. If the file does not exist in that location it will
be created. The Record Action is discussed in the next section.
When a “Delete” record action is taken, the program will delete records related to the
specified member as well as the main member record. This can include check-in history,
account payments, class enrollments, etc. Care should be taken when specifying this option.
The member account transaction import and export requires the comma delimited data in a
fixed format. You can view the list of these fields under “Help | Account Transaction Field
List”. For import, the header field is optional. All included records in the import file will
be added to the existing (or newly created) account transaction file.
Both the member and account import functions have a checkbox setting to “Build indexes at
end”. This can be used to speed up the import function when a large number of records are
being imported. However, it is best to only turn on this option when populating a new
database.
The program allows you to specify how dates are formatted on import and export. See the
“Settings | Field Formatting” menu item. This is particularly important when you are
importing data.
Transaction Data Exchange file specifications
Fitness Manager allows details of invoice and payment transactions to be exported from or
imported into it’s data files. This data exchange utilizes a comma-delimited text file.
Fitness Manager uses this same file format to perform data replication services. The
following presents a brief overview of the how accounting transactions are represented in
Fitness Manager and a detailed specification for the exchange files.
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Accounting Transactions in Fitness Manager
Before discussing the specifications of the data exchange format, it is helpful to have a
general understanding of how Fitness Manager logically structures its accounting information.
Member account transactions are grouped into invoices and payments. Whenever you sell
something, the system creates an invoice. The invoice consists of several parts:
a invoice header containing common information to the invoice, like date and time and
information to indicate who (if anyone) that the sale was made to:
one or more invoice detail records, corresponding to each line item in the invoice
one or more invoice charge records, each containing an amount and a due date
Whenever a payment is made against an invoice, whether at the time of sale or at a later
date, the system creates a payment. Generally a payment is applied against a single invoice
charge, but a payment can also be applied against multiple charges from one or more
invoices. Fitness Manager even allows you to create a payment for a member that is not
applied against any specific charges. This is referred to as an open or unapplied payment.
A payment consists of the following parts:
a payment header containing common information to the payment, similar to the invoice
header
zero or more payment detail records, each linking a part of the payment against an invoice
charge (an unapplied payment has no details)
In addition to invoices and payments, Fitness Manager also allows a user to create a special
credit against an invoice, known as a credit memo. As used in Fitness Manager, a credit
memo applies to a specific invoice and represents a credit to that invoice where no actual
payment is reflected when running a cash accounting report. For example, a credit memo
could be used to eliminate an uncollectable balance against an invoice. Logically a credit
memo is represented by a single group of information that is always related to a invoice.

Data Exchange File Formats
As mentioned previously, the data exchange uses a simple text file of lines (or records), each
containing multiple fields delimited by commas. The records are arranged in a structured
manner which allows certain types of information to be grouped together; for instance an
invoice header with it’s details and charges.
The exchange file can contain different record layouts for different types of information.
For instance an invoice header consists of a different set of fields than an invoice detail. The
different record types supported correspond to those discussed in the previous section. Each
record type supports a set of fields that can be included; some of which are required and
some are optional.
For each type of data record, a header record (not to be confused with the invoice header or
payment header term) specifies which fields are included in the data. Special keywords at
the beginning of a header or data record identify the record’s type. A header line starts with
an exclamation character and is followed by the the data type keyword and a list of the
included field identifiers. A data line starts with the data type keyword, and is followed by
the values for the fields listed in the header.
For example, the following is a simplified representation for an invoice header containing 2
fields:
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!INVHDR,DATE,TIME
INVHDR,9/30/1997,2:19PM
!ENDINV
The INVHDR keyword identifies both the header and data line as corresponding to the
invoice header data type. A header record for a specific record type does not need to be
repeated in the file. It should always appear earlier in the file than its corresponding type of
data record. If the list of included fields for a specific data record or the order of those
fields change, then a new header line should be included prior to the newly formatted data
record.
Since both invoices and payments are logically represented as groups of information, the
data exchange format supports grouping the various types of data records together. An
invoice always starts with an INVHDR data record and ends with and !ENDINV record. It
would typically contain an invoice header data line as well as multiple details and charges.
Similarly, a payment group starts with a PAYHDR (payment header) data record and ends
with an !ENDPAY record. A payment group can also be nested within an invoice group to
express a payment’s relationship to that invoice.
See the Appendix for a list of the data record types and the field identifiers.
The field indentifiers listed in italics are of special importance. These are used to uniquely
identify data records and their associated data records. As an example, an invoice header is
uniquely identified by a combination of its CLUB and ID fields. When a new invoice is
created, the program determines its ID value from the next available number. The CLUB
value comes from the value assigned in configuration for the “home” club. In exchanging
data between multiple Fitness Manager locations, there can be no collision between this
combination of fields as long as the home club numbers are different. An invoice detail is
linked to a specific invoice be a combination of its CLUB and INVID fields.
Except for the CLUB field in the invoice header (and a payment header if it is not nested
with an invoice group), you only need to specify the ID-related fields under special circumstances:
You need to update a pre-existing transaction. For instance, if you want to update an
invoice in the database to a voided status, you can re-import it with the void date and time
fields set. Another example, may be that you want to correct the amount of a payment. In
each of these cases the ID and CLUB fields would need to be set to the proper value to
allow the import program to identify that it is updating an existing transaction.
You need to link a payment to a pre-exisiting invoice. The payment detail CHGID and
CHGCLUB fields must be set to associate the detail with a specific charge. If these fields
are omitted or assigned zero values the payment will be set up as unapplied.
You need to link a payment to a new invoice. You can either chose to supply the linking
fields, or you can nest the payment record within the invoice record.
As an alternative to specifying the ID-related fields to update existing transactions, the
import program allows you to clear out all existing transactions originating from a given
club. You can choose this option and re-import all of those transactions along with the
changes to them.

Detailed Examples
The following examples are typical of the usage of the data-exchange facility in importing
account transactions.
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Example 1: Importing a new member contract, nesting related transactions
This example shows an invoice consisting of 4 charges due a month apart and totalling
$200, with a single payment of $50 by check made against it. There is one line item in the
invoice and for a non-database item with the description “New Membership”.
This example includes some fields that aren’t needed for this case, but would typically be
included. For example, the this invoice isn’t taxed, but the tax-related fields are included,
because a typical file would include some taxable invoices. Also, the invoice detail includes
item type and barcode fields. If an inventory-database items was involved, the type would
be set to 1, and the barcode to the item’s barcode number.
While the example payment header record includes the club number, the customer barcode,
and the date, these can be omitted and will get the values from the invoice header data that
the payment is nested within.

;Comments can be placed anywhere in the file. As long as the line does
not start with a recognizable token, the line is ignored. To improve
readability of your comments, you may want to start them with a standard character as is done here. All the “header” specifications are placed
at the top of the file in this example.
!INVHDR,CLUB,DATE,CUSTBARCODE,TAXRATE1,AMOUNT,TAX1,ACCNTID
!INVDTL,ITEMTYPE,ITEMBARCODE,DESC,AMOUNT,QNTY,TAXABLE1
!INVCHG,DUEDATE,AMOUNT
!PAYHDR,CLUB,CUSTBARCODE,DATE,DESC,AMOUNT,PAYMETH
!PAYDTL,AMOUNT
INVHDR,1,11/06/1997,”001478",8.0,1
INVDTL,0,””,”New Membership”,200,1,”N”
INVCHG,11/06/1997,50
INVCHG,12/06/1997,50
INVCHG,1/06/1998,50
INVCHG,2/06/1998,50
PAYHDR,1,”001478",11/06/1997,”Downpayment”,50,2
PAYDTL,50
!ENDPAY
!ENDINV

Because the payment detail does not include the charge ID field, the program will attempt
to apply it. It looks for the charge in the current invoice with the matching amount of the
payment detail. If it doesn’t locate a match, it then takes the charge due the earliest that has
an amount greater than the payment detail. For this case, the $50 payment is simply applied
against the earliest charge for $50.
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!INVHDR,ID,CLUB,DATE,CUSTBARCODE,TAXRATE1,AMOUNT,TAX1,ACCNTID
!INVDTL,ITEMTYPE,ITEMBARCODE,DESC,AMOUNT,QNTY,TAXABLE1
!INVCHG,ID,DUEDATE,AMOUNT
!PAYHDR,CLUB,CUSTBARCODE,DATE,DESC,AMOUNT,PAYMETH
!PAYDTL,CHGID,CHGCLUB,AMOUNT
INVHDR,1016,1,11/06/1997,”001478",8.0,1
INVDTL,0,””,”New Membership”,200,1,”N”
INVCHG,2100,11/06/1997,50
INVCHG,2101,12/06/1997,50
INVCHG,2102,1/06/1998,50
INVCHG,2103,2/06/1998,50
!ENDINV
PAYHDR,1,”001478",11/06/1997,”Downpayment”,50,2
PAYDTL,2100,1,50
!ENDPAY

Example 2: Importing a new member contract, using IDs to relate
transactions
This example shows the identical invoice to the first example. However, in this case the
internal identifiers (transaction Ids and club numbers) are supplied for the invoice headers,
and invoice charges. It is not necessary to nest payments within invoices, since the payment
detail is directly linked to the associated charge

Import-Export Scripting
The Import-Export program supports a scripting facility to assist you in automating an
exchange of data between sites running the Aphelion Windows software.
The syntax for running the program using a script is:
IMPTEXPT /SCRIPT=<complete file name, including path>
The scripts are text files, in a Windows-standard INI format. INI files are divided into
sections, with the section name enclosed in square brackets, followed by one or more lines
of entries. An entry consists of a setting name, followed by an equal sign and a value. A
line starting with a semi-colon is ignored, and can be used for commenting the script. The
following is an example of an INI formatted file:
[some section name]
entry=value
another entry=another value
The import-export scripts currently supports 7 different functions:
Member data import
Member data export
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Account transaction data import
Account transaction data export
Contract data import
Contract data export
Healthcalc data export
Each of these function groups has its own section in the INI script. The function entries are
described below, and are current as of release 2.0 of the program.
Member data import
The following entries are supported:
Source (Required) a valid DOS file name specifying the source data in a delimited ascii
format.
Target (Required) a valid DOS path name specifying the location of target Fitness Manager
dataset. Any missing tables will be created as necessary.
Default Action (Optional) allowed values are A (add), M (modify), D (delete), or left blank.
If left blank, it defaults to M. If the source file contains a “record action” field, this entry is
ignored. When the record action is to modify the record, the program will attempt to
retrieve a record with the ID Number field from the import file. If the record is found, the
fields specified in the import record will update those in the database record. If the matching database record is not found, a new record will be added using the import fields.
Build (Optional) allowed values are Y (yes), N (no), or left blank. If blank, the entry
defaults to N. This option determines whether the member database is indexed after the
import is process (build value of yes), or on the fly as the records are imported. Setting
build to yes can speed up the processing of large import datasets, but should be used with
caution. In this case, the import can result in duplicate key values as some testing of the
imported data does not occur as the records are processed. If you are relying on the program to test whether to modify or add the records, than be sure that this option is set to no.
Lookup Method (Optional) allowed values are A (agreement number), B (barcode number),
or left blank. The default is B. This setting determines how records in the import file are
related to any existing member records in the target database. The default behavior is for
the program to use the ID Number field from the member import record and search for a
matching barcode ID in the member database. If a match is found the member database
record is updates; otherwise a new member record is added. If the “agreement” lookup
method is specified, the import process use the import agreement number field and looks for
a match on the agreement number field in the member database. If you use this method, be
sure that each member’s agreement number is a unique value. The Fitness Manager
program does not enforce this requirement.
Force Barcode Update (Optional) allowed values are Y (yes), N (no), or left blank. If
blank, the entry defaults to N. This option is only used when the lookup method is by
agreement number. By default, when a mathcing agreement number is found and the
member fields are updated, the barcode ID field is not updated. Set this option to Y to force
the program to update the barcode field with the barcode value from the import file. The
barcode field will always be set from the import value when a record is added.
Field<N> (Optional) Use this entry to limit the which fields from those included in the
import file will be used in updating member records. Each entry should consist of the word
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“Field” followed by a number and an equals sign, and finally by a valid member field name.
The field names are listed in the program from “Member Import field names” under the help
menu. Number these entries consecutively, starting from 1. The ordering of the fields in
these entries is of no consequence. These entries should be used in conjunction with the
Field Handling entry.
Field Handling (Optional) allowed values are I (include), E (exclude), N (none), or left
blank. If blank, the entry defaults to N. This option specifies how the Field entries are
used. If set to include, then only the specified fields from the Field entries (that are also
present in the import file) will be used when updating an existing member record. If set to
exclude, then all fields (included in the import file) will be used to update a member, except
those specified in Field entries. If set to none, or left blank, and Field entries will be
ignored.
Member data export
Entries:
Source (Required) a valid DOS path name specifying the location of the source Fitness
Manager dataset.
Target (Required) a valid DOS file name for the exported delimited data file to be created
in. Any existing file with this name will be overwritten
Added Since (Optional) specify a date here to limit the exported records to those that have
been added (“member since” field) from the specified date forward. The date can be
specified in mm/dd/yy or mm/dd/yyyy format. You can also set this entry to a value of
LAST or AFTER. A setting of LAST will limit the export to records added from the date of
the last member export. A setting of AFTER will limit the export to records added from the
date of day after the last member export. The last member export date can be edited from
within the import-export program from “Import/Export Dates” under the help menu.
Updated Since (Optional) specify a date here to limit the exported records to those that
have been updated from the specified date forward. The LAST and AFTER keywords work
here just like in the Added Since entry.
If the above 2 entries are used, they should be used in conjunction. If only one of these is
set, all member records will get exported.
Include Prospects (Optional) allowed values are Y (yes), N (no), or left blank. If blank, the
entry defaults to Y. Set this to no to exclude exporting prospects.
Included Categories (Optional) this is a list of the member categories for which associated
members are to be exported. If left blank or not included all member categories will be
included. The list should be the category numbers, separated by commas (e.g. 1,3,4,6).
Club Number (Optional) specify a numeric value here to limit the exported members to
those assigned to the specified club number. A blank setting or a value of 0 results in the
program not filtering by member club number. The default value is zero.
Field<N> (Optional) Use this entry to limit the set of exported fields. Each entry should
consist of the word “Field” followed by a number and an equals sign, and finally by a valid
member field name. The field names are listed in the program from “Member Import field
names” under the help menu. Number these entries consecutively, starting from 1. Currently, the exported file will contain the fields ordered alphabetically, rather than in the
order specified by the list of field entries.
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Transaction data import
Entries:
Source (Required) a valid DOS file name specifying the source data in a delimited ascii
format.
Target (Required) a valid DOS path name specifying the location of target Fitness Manager
dataset. Any missing tables will be created as necessary.
Format (Optional) allowable values are VER1, VER2, or blank. The default is VER2 for
the (current) version 2 transaction import format. This tells the program which data format
is to be expected. The program still supports the version 1 “payment” import file format,
which is much simpler but does not take advantage of some the of new capabilities in the
version2 accounting.
Club to Skip (Optional) Specify a numeric value to skip importing payment records with
the matching club number. A blank or zero value (the default setting) will not exclude any
records. When a payment is added by Fitness Manager, the club number field is set to the
value configured for the club where that payment is added. This entry is used to ensure that
payments originating from a club will not be re-imported into that location, resulting a
double entry. To avoid this, be sure each location has been configured with a unique club
number, and when importing payments, set this field to the local club number.
Club to Clear (Optional) Specify a numeric value to delete account transaction with this
club number before the data is imported. If the club number is set to zero, then all existing
transactions will be cleared. If the entry is omitted or left blank, no action is taken.
Check for Transaction Member (Optional, version 1 only; if version2 can not locate
member, transactions are associated with “cash” customer) allowable values are Y (yes), N
(no), or blank. The default is no. Set this to avoid importing transaction records into a
database where there is no matching member record.
Build (Optional, version 1 only; ignored for version2) allowed values are Y (yes), N (no), or
left blank. If blank, the entry defaults to N. This option determines whether the transaction
databases are indexed after the import is process (build value of yes), or on the fly as the
records are imported. Setting build to yes can speed up the processing of large import
datasets, and unlike importing the member data, is always safe.
Lookup Method (Optional) allowed values are A (agreement number), B (barcode number),
or left blank. The default is B. This setting determines how records in the import file are
related to any existing member records in the target database. The default behavior is for
the program to directly create an account transaction record based on the fields from the
import record, treating the BILL TO ID and BILLED FROM ID as member barcode
numbers. If the lookup method is set for agreement number, the program treats these import
fields as agreement numbers instead. If looks for a database record where the agreement
number matches the import BILL TO ID. If found, the transaction is created and linked to
this member. If you use the agreement lookup method, be sure that each member’s agreement number is a unique value. The Fitness Manager program does not enforce this
requirement.
Reject Duplicates (Optional, version 1 only; always yes for version2) allowable values are
Y (yes), N (no), or blank. The default is yes. When set to yes, the program checks each
import record for a matching record in the target database based on the following field
values: BILL TO ID, TRANSACTION DATE, DUE DATE, AMOUNT, and CLUB #. If a
complete match is found, the import record is skipped.
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Calibrate (Optional, version 1 only) allowable values are Y (yes), N (no), or blank. The
default is no. Use a value of yes for this option to import a full set of transaction data. If
you have existing data, you will want to also set the “Club to Clear” option to a value of 0
to remove existing data. The calibrate option writes a “Last Post Date” setting the local
APHELION.INI file based on the latest TRANSACTION DATE field in the import file.
This last post date is used in conjunction with the “Smart Update” option.
Smart Update (Optional, version 1 only) allowable values are Y (yes), N (no), or blank.
The default is no. When set to yes, the program will only import records with a “TRANSACTION DATE” field greater than the locally stored “Last Post Date” This last post date
value is stored in the local APHELION.INI file and is updated by both the “smart update”
and “calibration” imports. Note: the smart update and calibrate flags should not be set to
yes for a single import. Usually a full set of transaction data should be available for import
and either the smart update or calibrate options can be used with it.
Be careful, when importing version 1 payment information, that you do not import the same
data more than once. If you do, you can end up with duplicate payment records, resulting in
invalid billing information. You can use the “Reject Duplicates” setting to avoid this
problem.
Transaction data export
Entries:
Source (Required) a valid DOS path name specifying the location of the source Fitness
Manager dataset.
Target (Required) a valid DOS file name for the exported delimited data file to be created
in. Any existing file with this name will be overwritten
Added Since (Optional) specify a date here to limit the exported records to those that have
been added (“post date” field) from the specified date forward. The date can be specified in
mm/dd/yy or mm/dd/yyyy format. You can also set this entry to a value of LAST or
AFTER. A setting of LAST will limit the export to records added from the date of the last
payment export. A setting of AFTER will limit the export to records added from the date of
day after the last payment export. The last payment export date can be edited from within
the import-export program from “Import/Export Dates” under the help menu.
The LAST keyword can optionally be followed by an arithmatic modifier in the number of
days, as follows:
LAST+10
LAST-2
Included Categories (Optional) this is a list of the member categories for which associated
payments are to be exported. If left blank or not included, payments for all member
categories will be included. The list should be the category numbers, separated by commas
(e.g. 1,3,4,6).
Club Number (Optional) specify a numeric value here to limit the exported payments to
those assigned to the specified club number. A blank setting or a value of 0 results in the
program not filtering by payment club number. The default value is zero.
Lookup Method (Optional) allowed values are A (agreement number), B (barcode number),
or left blank. The default is B. If set to agreement number, the BILLTO ID and BILLED
FROM ID fields are populated using member agreement number values rather than barcode
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IDs. If you use the agreement lookup method, be sure that each member’s agreement
number is a unique value. The Fitness Manager program does not enforce this requirement.
Contract data import
Entries:
Source (Required) a valid DOS file name specifying the source data in a delimited ascii
format.
Target (Required) a valid DOS path name specifying the location of target Fitness Manager
dataset. Any missing tables will be created as necessary.
Update Existing (Optional) allowable values are Y (yes), N (no), or left blank. If blank, the
entry defaults to Y. This option determines whether records which already exist in the target
database will be updated by values from the source import file. Set this entry to N to limit
the import to only adding new records.
Build (Optional) allowable values are Y (yes), N (no), or left blank. If blank, the entry
defaults to N. This option determines whether the contract database is indexed after the
import is process (build value of yes), or on the fly as the records are imported. Setting
build to yes can speed up the processing of large import datasets, but can result in duplicated records if you import the same data more than once.
Contract data export
Entries:
Source (Required) a valid DOS path name specifying the location of the source Fitness
Manager dataset.
Target (Required) a valid DOS file name for the exported delimited data file to be created
in. Any existing file with this name will be overwritten
Added Since (Optional) specify a date here to limit the exported records to those that have
been added (“member since” field) from the specified date forward. The date can be
specified in mm/dd/yy or mm/dd/yyyy format. You can also set this entry to a value of
LAST. This will only limit the export to records added from the date of the last contract
export. The last contract export date can be edited from within the import-export program
from “Import/Export Dates” under the help menu.
Updated Since (Optional) specify a date here to limit the exported records to those that
have been updated from the specified date forward. The LAST keyword works here just like
in the Added Since entry.
If the above 2 entries are used, they should be used in conjunction. If only one of these is
set, all contract records will get exported.
Include Approved (Optional) allowable values are Y (yes), N (no), or blank. The default is
yes. Set this value to no to exclude exporting approved contracts.
Include Unapproved
Optional; allowable values are Y (yes), N (no), or blank. The
default is yes. Set this value to no to exclude exporting contracts which are not yet approved.
Club Number
Optional; specify a numeric value here to limit the exported contract to
those assigned to the specified club number. A blank setting or a value of 0 results in the
program not filtering by contract club number. The default value is zero. A contract is
assigned a club number based on where it originates.
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Healthcalc data export
Entries:
Source (Required) a valid DOS path name specifying the location of the source Fitness
Manager dataset.
Target (Required) a valid DOS file name for the exported delimited data file to be created
in. Any existing file with this name will be overwritten
Added Since (Optional) specify a date here to limit the exported records to those that have
been added (“member since” field) from the specified date forward. The date can be
specified in mm/dd/yy or mm/dd/yyyy format. You can also set this entry to a value of
LAST or AFTER. A setting of LAST will limit the export to records added from the date of
the last member export. A setting of AFTER will limit the export to records added from the
date of day after the last member export. The last member export date can be edited from
within the import-export program from “Import/Export Dates” under the help menu.
Updated Since (Optional) specify a date here to limit the exported records to those that
have been updated from the specified date forward. The LAST and AFTER keywords work
here just like in the Added Since entry.
If the above 2 entries are used, they should be used in conjunction. If only one of these is
set, all member records will get exported.
Notes and Limitations
Exclusive access to the Fitness Manager database files are required to perform the import
and export operations. This means that no users should be accessing the Fitness programs
when running the scripts.
Only a subset of the member fields are currently supported by the import-export program.
This limits which information can be transferred between clubs when using this mechanism.
All of the contract and payment fields are currently included.
The program can only handle 1 function of each type in a single script. For example, only a
single member file export will be processed from a script. If you want to export multiple
member files (perhaps based on club number), you will need to set up multiple scripts.
For a script with multiples function included, exports will be processed before imports. If
you need to process the imports first, set them up in a separate script and excute it first.
Specifically, the script functions are processed in the following order:
1)

Member Export

2)

Payment Export

3)

Contract Export

4)

Healthcalc Export

5)

Member Import

6)

Payment Import

7)

Contract Import

If you are using the LAST or AFTER keywords for setting dates in your scripts, there are a
number of special precautions you must take. Use LAST if imports and exports are
performed before the start of your business day. This ensures that you won’t lose any
changes made during that day. Use AFTER if you perform the imports and exports at the
end of your business day. This ensures that succeeding process doesn’t include that day’s
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changes. Finally, there may be a need to manually reset the last export dates that are picked
up by these keywords. You can edit these fields from within the import-export program
from “Import/Export Dates” under the help menu.
Compression/Archival Options
The output from export operations can be optionally placed in compressed archive files,
allowing for faster transmission of your data between sites. To accomplish this, specify a
file name with an extension of LSP for your export Target entries. For example,
C:\TEMP\EXPORT.LSP. You can specify the same archive name for multiple export
operations in a single script.
For import operations, specify the LSP extent for the Source entries.
For both export to and import from an archive, the intermediate text files which result from
the export/import operations will be placed in the same directory as that specified for the
archive file. The following filenames are used:
Member Export:

MEMBERS.TXT

Transaction Export:

TRANS.TXT

Contract Export:

CONTRACT.TXT

Healthcalc Export:

HCALC.TXT

;Sample script file for IMPTEXPT program
;To use a script, set up the name of the script on the program’s commandline using “SCRIPT=”. For example: IMPTEXPT.EXE
SCRIPT=C:\FITNESS\SCRIPT1.INI
;Include “Import Members” section to specify a member import
;Include “Import Transactions” to import customer account transactions
[Import Members]
Source=A:\CUSTOMER.TXT
Target=C:\FITNESS\DATA\CUSTOMER.DAT
;If “record action” field is not specified in the import file, record will be
;added
Default Action=A
;The following setting tells the program to update the index on the fly
;set to Yes for importing a complete new file
Build=No
;Set the following to limit which fields are used to change existing ;member data. This example never changes a member’s status message ;or
birthday, even if that data is included in the import source file.
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Field Handling=Exclude
Field1=Status Message
Field2=Date of Birth
[Import Transactions]
Source=A:\CREDIT.TXT
Target=C:\FITNESS\DATA\CREDIT.DAT
;only set the following to delete payments for a specified club, prior to
;import, otherwise omit or leave blank
Club to Clear=
;set to skip records with the indicated club number this can be used to
;avoid importing your own records back in exchanges between multiple
;clubs
Club to Skip=1
;The following setting tells the program to update the index on the fly set
;to Yes for importing a complete new file
Build=No
[Import Contracts]
Source=A:\CONTRACT.TXT
Target=C:\FITNESS\DATA\CONTRACT.DAT
Build=No
[Export Members]
Source=C:\FITNESS\DATA\CUSTOMER.DAT
Target=A:\MEMBEXPT.TXT
;limit export to new records added after last export date
Added Since=AFTER
;don’t export updated members
Updated Since=12/31/2099
;export only members in selected categories
Included Categories=1,4,5
;export a subset of the member fields
Field1=ID Number
Field2=First Name
Field3=Last Name
Field4=Last Updated
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An additional entry is available for the export sections to support the archival option:
Clear Archive (Optional) allowed values are Y (yes), N (no), or blank. The default is no.
Set this value to yes to delete the archive file (if it exists), before export. This can provide
an improvement in speed over updating an existing archive.
Sample script file

Quickbooks Export
The Quickbooks accounting program utilizes data structure very similar to the v2.0 Fitness
Manager. Therefore, this information can be exported from the Fitness Manager to
Quickbooks through specially formatted text files. There are two type of interface to
Quickbooks supported in v2.0 of the Fitness Manager, Detail and Summary. The Detail
interface exports all sales invoices and payments individually to Quickbooks. The Summary
interface exports a single “summary” invoice for each income account. A single merged
payment that summarizes all payments received into an income account is also exported to
Quickbooks. The choice between these two options depends on the accounting functions
you wish to perform in Quickbooks.
Selection of Detail vs. Summary Quickbooks Interface
A combination of your business operations and Quickbooks limitations must be considered
when selecting the proper Quickbooks interface. Several factors regarding limitations
imposed by Quickbooks should be considered. Also, whether you use a cash or accrual
accounting method needs to be factored into the interface selection process.
Quickbooks does not provide the facility to link payments with invoices during the export/
import process. This is a significant limitation because it forces the user to manually apply
payments to invoices. Unapplied payments in Quickbooks will disrupt cash accounting
methods and inaccurately depict customer account balances in Collections reports. This
limitation can be particularly burdensome if the Detail interface is selected and payments
that result from a billing process are exported (since a payment will be created for each
member). This can create a significant manual process of linking these payments with the
membership sale invoice previously exported to Quickbooks. These difficulties are mitigated if an accrual method is used since Quickbooks will read invoices, and not payments,
for sales information.
The Summary interface is recommended for most users. This approach will provide
accurate financial reports and minimize the amount of manual work imposed by the limitations in the Quickbooks import utility. The Fitness Manager will provide all of the detailed
account information for each member. The Detailed interface can be considered if your
POS activity is small and you have outsourced your billing function to a third party service
company.
Other Quickbooks Import Limitations
Quickbooks can accept invoiced sales for retail inventory items contained in the “Items”
list. However, the import utility does not allow for restocking quantities to be added to
inventory. Therefore, to maintain proper inventory levels in the Fitness Manager and
Quickbooks, restocking values must be entered into both software programs.
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Payments from the cash sales at the POS counter are exported in this process. However,
these payments must be manually “Grouped with other Undeposited Funds” in Quickbooks
for them to appear in the Make Deposits window. This can have significant work impact if
a large number of POS sales/payments are exported from the Fitness Manager to
Quickbooks.
Export Process
Prior to performing the export/import process, make a current backup of your Quickbooks
data.
To export the accounting information from the Fitness Manager to Quickbooks, the Import/
Export utility program must be executed. Select the “Export” menu and highlight the
option for “Export to Quickbooks.” A window will be displayed that allows you to enter the
range of dates for information to exported. Specifying the date range is critically important
to accurate information transfer. The importance is derived from the fact that Quickbooks
does not recognize duplicate invoices. Therefore, if you overlap the date range with earlier
exports, duplicate invoices will be created in Quickbooks resulting in corrupted data files. It
is recommended that a specific export frequency (e.g. daily, weekly, monthly, etc.) be used
to avoid duplication of data within Quickbooks.
Once the file has been created, start Quickbooks and select the Import function under the
File menu. Provide the path and filename for import and process the file. Verify that new
invoices, etc. have been imported by running reports over the same date range used when
exporting the data from the Fitness Manager.

Detail Interface
This section describes the export/import of Fitness Manager v2.0 information to Quickbooks
using the “Detail” interface option.

Members
In the Detail interface, all active members contained in member database file of the Fitness
Manager are exported to Quickbooks. Prospects are not included in the export process.
Once imported, each member will be in the Quickbooks Customer list.

Inventory Items
All retail inventory items, personal training, membership plans, and activities (sold by visits,
such as tanning, etc.) are exported from the Fitness Manager into the Items list in
Quickbooks. This allows Quickbooks to properly associate items sold on the invoices with
items in Quickbooks. The income account for each item is also transferred to Quickbooks
for proper internal association of the item with the Quickbooks income accounts.

Income accounts
The complete list of income accounts from the Fitness Manager is exported for inclusion in
the Quickbooks “Chart of Accounts.”

Expense accounts
The complete list of expense accounts from the Fitness Manager is exported for inclusion in
the Quickbooks “Chart of Accounts.”
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Invoices
Each sales invoice is exported to Quickbooks. This includes all invoices created during
billing processes as well as all POS activity.

Credit Memo
These items are not exported from the Fitness Manager and need to be manually created in
Quickbooks using the “Create Credit Memo/Refunds” option in the Activities menu.

Payments
All payments received by the Fitness Manager are exported to Quickbooks. This includes
payments applied to invoices as well as payments that are “unapplied.” Payments for billing
activities as well as POS are included in this export.

Payment Discounts
These items are not exported and will need to be manually applied in Quickbooks through
the “Discount” button on the Receive Payments window.

Summary Interface
This section describes the export/import of Fitness Manager v2.0 information to Quickbooks
using the “Summary” interface option.

Members
A single customer is created in Quickbooks called “Membership” to represent sales to all
members of the club.

Inventory Items
A single inventory item is created in Quickbooks as a “non-inventory part” for each income
account. This inventory item represents all items in the Fitness Manager that are associated
with that income account.

Income accounts
The complete list of income accounts from the Fitness Manager is exported for inclusion in
the Quickbooks “Chart of Accounts.”

Expense accounts
The complete list of expense accounts from the Fitness Manager is exported for inclusion in
the Quickbooks “Chart of Accounts.”

Invoices
A single invoice is created in Quickbooks that summarizes the sale of all items associated
with the income account. If no sales are recorded for a given income account, no invoice is
created in Quickbooks. The invoice for each income account is sold to the “Membership”
customer in Quickbooks.
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Credit Memo
These items are not exported from the Fitness Manager and need to be manually created in
Quickbooks using the “Create Credit Memo/Refunds” option in the Activities menu.

Payments
A single payment record for each income category is exported to Quickbooks that summarizes all payments received against that income category. The payment is received from the
fictitious customer “Membership” created in Quickbooks.

Payment Discounts
These items are not exported and will need to be manually applied in Quickbooks through
the “Discount” button on the Receive Payments window.

240

APPENDIX
General System Information
This chapter is designed to provide you with technical information about the system. The
information is this chapter may be useful when troubleshooting the system, or to determine
more information about the installation.
Program Version And Installed Options
To determine your program version and installed options, select the Utilities module. Select
Utilities | Installed Options. The version number, plus a list of the options that are installed
in your software version will be displayed.
Installed Directories
Program files are located in the “Aphelion” directory. Several sub-directories are created
when you install the software. The “DATA2” directory contains all “live” club data. Other
important directories are: Pictures (if you are using video imaging this directory contains all
of you pictures), Sounds (if you are using audio messaging this directory will contain all of
your wave files), Letters (any form letters, contracts, etc. written with our word processing
will be stored here), Icons (any icons used for the POS buttons will be stored here), Workout
(Workout Partner files are stored here).
Networks
The Aphelion software works with all network platforms that support the NETBIOS
standard, such as Lantastic, Novell and Microsoft Windows (all versions, 3.xx and above).
As was mentioned in the installation guide, the software is fully installed on only the
computer acting as the Server, and is only partially installed on the Workstations. If you are
using a network system it is highly advisable that you have someone locally that can help
maintain your network. There are may times that what appear to be software problems are
really network problems and can be fixed very easily. Most computers sold today are
provided with Windows95, a very good, stable network platform that is easy to work with.
Video Imaging
Optimum display settings for this function are at least 256 colors at 800 x 600, super VGA.
If your video card only supports 16 colors then it will need to be replaced in order to take
advantage of the high quality imaging capabilities. Also if you are using one of the new
popular “golf ball” cameras, then you will want to make sure that the video mode set for the
camera is Video for Windows.
Barcode Scanners
Barcode scanners are usually very reliable. If the scanner has never worked, check to see
that you are connecting it properly. Be sure it is properly connected to the computer and
keyboard. Scan the Reset barcode in the manual to re-initialize the reader.
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If the scanner has been working but suddenly stops, be sure you are reading valid barcodes.
Try to scan a barcode from the manual or from a product, rather than from one that you
have printed.
If you are using a laser scanner, try placing the scanner on its stand. This type of scanner
uses a sensor to determine when a barcode is placed in it’s field of view. If the scanner is
lying on the counter top, then the sensor may fail to detect the barcode.
Computer Lock Ups
If the computer appears to be locked and not processing data, you should reset the machine.
If you are using Windows95, briefly hold down the Ctrl Alt Del keys. An “end task” box on
the desktop will be displayed. This box will show all of the programs that are currently
running on your machine. Generally, one of the programs will have (in brackets to the right
of it) the message “Not Responding”. Select that program, then left click on the <end task>
button. This will end the particular application and will usually free up the computer. If
this continues to happen or you start getting Windows error messages, then a reinstallation
of the Windows software may be required.
Demo Mode
If you suddenly get the message that the computer is running in Demo Mode, one of several
things may have happened. The most common problem is that you have an older printer
plugged into the security key that is provided, and it is either turned off or is off line. If it is
turned on, check to see if the printer prints properly. If it does, then go into the Aphelion
Utilities Module and select the Utilities | keytest option. If you get the message “No Key
Detected”, call Aphelion Technical Support.

Mail Merge Keyword Tags
The following tables are a list of available keywords that can be inserted into your Microsoft
Word templates for use with the mail merge functions. These keywords are accessible
through the Microsoft Word macro in the “keywords.dot” file located in the
Aphelion\Letters folder.

M e mbe r Fie lds
Account Responsible
Party
Account Value
Address

@Account
Responsible Party@
@Account Value@
@Address@

Address 2

@Address 2@

Age

Bank Route #

@Bank Route #@

Custom Date 2

@Custom Date 2@

Bank State
Club Zipcode
Contract Expiration
Date

@Bank State@
@Club Zipcode@
@Contract
Expiration Date@

Custom Date 3
Custom Date 4

@Age@

Convert Date

@Convert Date@

Custom Number 2

Agreement #

@Agreement #@

Corporate Message

@Corporate
Message@

Custom Number 3

Bank Account

@Bank Account@

Credit Card #

@Credit Card #@

Custom Number 4

@Custom Date 3@
@Custom Date 4@
@Custom Number
1@
@Custom Number
2@
@Custom Number
3@
@Custom Number
4@

@Bank Account
Type@
@Bank Address@
@Bank City@
@Bank Name@

Credit Card
Expiration
Credit Limit
Current Balance
Custom Date 1

@Credit Card
Expiration@
@Credit Limit@
@Current Balance@
@Custom Date 1@

Bank Account Type
Bank Address
Bank City
Bank Name
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Custom Number 1

Custom Text 1

@Custom Text 1@

Custom Text 2
Custom Text 3
Custom Text 4

@Custom Text 2@
@Custom Text 3@
@Custom Text 4@

M e mbe r Fie lds (cont.)
Custom Text 5

@Custom Text 5@

Group Name

@Group Name@

Past Due Current

Custom Text 6

@Custom Text 6@

Height

@Height@

Custom Text 7

@Custom Text 7@

Home Phone

@Home Phone@

Custom Text 8

@Custom Text 8@

Join Date

Custom Text 9

@Custom Text 9@

Last Checkin Date

Prenotify

@Prenotify@

Custom Text 10

@Custom Text 10@

Last Contact Date

Priority

@Priority@

Custom Text 11

@Custom Text 11@

Last Dues Billing

@Join Date@
@Last Checkin
Date@
@Last Contact
Date@
@Last Dues
Billing@

Past Due Days
PIF Renewal
Amount
Preferred Name

@Past Due
Current@
@Past Due Days@
@PIF Renewal
Amount@
@Preferred Name@

Promotion

@Promotion@

Custom Text 12

@Custom Text 12@

Last Name

Recurring Dues Total

@Recurring Dues
Total@

Custom Text 13

@Custom Text 13@

Last Renewal Date

Referrals

@Referrals@

Custom Text 14

@Custom Text 14@

Last Update Date

Custom Text 15

@Custom Text 15@

Level

@Level@

Renewal Amounts

Custom Text 16

@Custom Text 16@

Locker Expiration
Date

@Locker Expiration
Date@

Salesperson Name

Data Exchange ID

@Data Exchange
ID@

Locker #

@Locker #@

Sent Card

@Sent Card@

Date of Birth

@Date of Birth@

Marital Status

@Marital Status@

Social Security #

@Social Security
#@

Medical Note

@Medical Note@

Source

@Source@

Medical Risk

@Medical Risk@

Spouse Name

@Spouse Name@

Middle Name

@Membership
Type@
@Middle Name@

Statement Renewal
Amount
Status Effective

@Statement
Renewal Amount@
@Status Effective@

Month of Birth

@Month of Birth@

Status Ends

@Status Ends@

Next Action

@Next Action@
@Next Contact
Date@
@Next Dues
Billing@

State

@State@

Status

@Status@

Status Reason

@Status Reason@

Driver’s License #
Dues Responsible
Party
EFT Renewal
Amount
Email
Emergency Contact
Employer
Emergency Phone

@Driver’s License
#@
@Dues Responsible
Party@
@EFT Renewal
Amount@
@Email@
@Emergency
Contact@
@Employer@
@Emergency
Phone@

Membership Type

Next Contact Date

@Last Name@
@Last Renewal
Date@
@Last Update
Date@

Remaining Thaws

@Remaining
Thaws@
@Renewal
Amounts@
@Salesperson
Name@

First Contact

@First Contact@

Next Dues Billing

First Name

@First Name@

New to Fitness

@New to Fitness@

Tour Completed

@Tour
Completed@

Form of Payment

@Form of
Payment@

Occupation

@Occupation@

Tour Date

@Tour Date@

Full Name

@Full Name@

@Tour Time@

@Future Balance@
@Gender@
@General Notes@
@Guest Period@

@Open- end
Membership@
@Past Due 30@
@Past Due 60@
@Past Due 90@
@Past Due 120@

Tour Time

Future Balance
Gender
General Notes
Guest Period

Open- end
Membership
Past Due 30
Past Due 60
Past Due 90
Past Due 120

Trainer Name
Weight
Work Phone
Zipcode

@Trainer Name@
@Weight@
@Work Phone@
@Zipcode@

M e mbe r Lis ts
Dues Services:
Secondary Members:
Interests:
Status History:
Remaining Visit Units:

@DUES SERVICES LIST@
@SECONDARY MEMBERS LIST@
@INTEREST LIST@
@STATUS HISTORY LIST@
@VISIT UNITS LIST@

Table 1: Member Related mail merge fields and lists
243

Contract Re late d Fie lds
Account Responsible
Party
Additional
Downpayment

@CONT:Account
Responsible Party@
@CONT:Additional
Downpayment@

EFT Renewal
Amount

Address

@CONT:Address@

Finance Charge

Address 2

@CONT:Address
2@

First Name

Age

@CONT:Age@

FOP Choice

Agreement #
Amount Financed
Annual Percentage
Rate
Approval Date
Approval Status
Bank Account
Bank Account Type
Bank Address
Bank City
Bank Name
Bank Route #
Bank State
Bank Zipcode
Barcode ID
Barcode ID Label
Billing Name
City
Credit Card #
Credit Card
Expiration
Date of Birth
Dues First Due Date
Dues Responsible
Party
Effective Date

@CONT:Agreement
#@
@CONT:Amount
Financed@
@CONT:Annual
Percentage Rate@
@CONT:Approval
Date@
@CONT:Approval
Status@
@CONT:Bank
Account@
@CONT:Bank
Account Type@
@CONT:Bank
Address@
@CONT:Bank
City@
@CONT:Bank
Name@
@CONT:Bank
Route #@
@CONT:Bank
State@
@CONT:Bank
Zipcode@
@CONT:Barcode
ID@
@CONT:Barcode
ID Label@
@CONT:Billing
Name@
@CONT:City@
@CONT:Credit
Card #@
@CONT:Credit
Card Expiration@
@CONT:Date of
Birth@
@CONT:Dues First
Due Date@
@CONT:Dues
Responsible Party@
@CONT:Effective
Date@

Expiration Date

Form of Payment
Free Extension
Months
Full Name

@CONT:EFT
Renewal Amount@
@CONT:Expiration
Date@
@CONT:Finance
Charge@
@CONT:First
Name@
@CONT:FOP
Choice@
@CONT:Form of
Payment@
@CONT:Free
Extension Months@
@CONT:Full
Name@

Gender

@CONT:Gender@

Group Name

@CONT:Group
Name@

Height

@CONT:Height@

@CONT:Home
Phone@
@CONT:Last
Last Name
Name@
@CONT:Medical
Medical Note
Note@
@CONT:Medical
Medical Risk
Risk@
@CONT:MembersMembership Type
hip Type@
@CONT:OccupatiOccupation
on@
Payment First Due
@CONT:Payment
Date
First Due Date@
PIF Renewal
@CONT:PIF
Amount
Renewal Amount@
@CONT:Recurring
Recurring Dues Total
Dues Total@
@CONT:Renewal
Renewal Amounts
Amounts@
@CONT:Sale
Sale Date
Date@
@CONT:SalespersSalesperson Name
on Name@
Home Phone

State

@CONT:State@

Statement Renewal
Amount

@CONT:Statement
Renewal Amount@
@CONT:Total
Discount@
@CONT:Total
Downpayment@
@CONT:Total
Dues@

Total Discount
Total Downpayment
Total Dues

Total Payments
Total Proration
Total Sale Price
Total Tax
Void Date
Weight

@CONT:Weight@

Work Phone

@CONT:Work
Phone@

Zipcode

@CONT:Zipcode@

@PLAN:Billing
Account@
@PLAN:Billing
Billing Cycle
Cycle@
@PLAN:Billing
Billing Starts
Starts@
Default Membership @PLAN:Default
Type
Membership Type@
@PLAN:DescriptioDescription
n@
@PLAN:EFT Dues
EFT Dues Amount
Amount@
@PLAN:EFT Terms
EFT Terms Amount
Amount@
@PLAN:End
End Date
Date@
@PLAN:Finance
Finance Rate
Rate@
@PLAN:FOP
FOP Available
Available@
@PLAN:Max. Free
Max. Free Extension
Extension@
@PLAN:Months in
Months in Contract
Contract@
Billing Account

Note

@PLAN:Note@

Open- end
Membership

Statement Dues
Amount
Statement Terms
Amount

@PLAN:Open- end
Membership@
@PLAN:PIF Terms
Amount@
@PLAN:Proration@
@PLAN:Start
Date@
@PLAN:Statement
Dues Amount@
@PLAN:Statement
Terms Amount@

Type

@PLAN:Type@

PIF Terms Amount
Proration
Start Date

Contract Re late d Lis ts
Member Add- on List:
Member/Service Add- on List:
Contract Federal Disclosure:
Plan Service Add- on List:

@CONT:Member Add- on List@
@CONT:Mbr/Service Add- on List@
@CONT:FEDERAL DISCLOSURE@
@PLAN:Service Add- on List@

Table 2: Contract Related mail merge fields and lists
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@CONT:Total
Payments@
@CONT:Total
Proration@
@CONT:Total Sale
Price@
@CONT:Total
Tax@
@CONT:Void
Date@

Data Exchange Scripting Reference
The following tables document available keywords for Data Exchange scripting purposes.
Invoice He ade r (INVHDR) ke ywords
Field identifier

Required
Field

Data type

ID

No

Integer

CLUB

Yes

Integer

DATE

Yes

TIME

No

Mm/dd/yyyy
Hh:mm
[A/P]M
Integer
String
Integer
String
String
String
String
Numeric
Numeric
Numeric
Numeric
Numeric
Integer
Integer
Mm/dd/yyyy
Hh:mm
[A/P]M

RCPTNUM
No
EMPLID
No
STATION
No
CUSTBARCODE
No
CUSTAGREE
No
BILLEDBARCODE No
BILLEDAGREE
No
TAXRATE1
No
TAXRATE2
No
AMOUNT
Yes
TAX1
No
TAX2
No
ACCNTID
No
FLAGS
No
VOIDDATE
No
VOIDTIME

No

Description
used to uniquely identify invoice
header
Club number where invoice was
posted
Invoice post date
Invoice post time
Invoice receipt number
Employee “assigned” ID
Station number
Member barcode
Member agreement #
Billed member barcode
Billed member agreement #
1st tax rate
2nd tax rate
Total amount of invoice
Total amount of tax type 1 on invoice
Total amount of tax type 2 on invoice
Reference # of invoice billing account
(Internal use only)
Date invoice was voided
Time invoice was voided

Table 3: Invoice Header keywords

Invoice De tail (INVDTL) ke ywords
Data type

Description

ID

Required
Field
No

Integer

CLUB

No

Integer

INVID

No

Integer

ITEMTYPE

Yes

Integer

ITEMID

No

Integer

ITEMBARCODE

No

String

ACCNTID
DESC
AMOUNT
QNTY
TAXABLE1
TAXABLE2
LINENUMBER

No
Yes
Yes
Yes
No
No
No

Integer
String
Numeric
Integer
[Y/N]
[Y/N]
Integer

used to uniquely identify invoice detail
Club number where invoice was
posted
Identifies assoc. Invoice header
Item type: 0 = non- database 1 =
regular inventory 2 = personal training
3 = visits
Internal identifier which uniquely
identifies item of given type
Barcode ID which uniquely identifies
item of given type
Reference # of item income account
Description of line item
amount for line item (not incl. Tax)
Quantity of items in line item
Charged tax at 1st rate
Charged tax at 2nd rate
Position of line in invoice

Field identifier

Table 4: Invoice Detail keywords
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Invoice Charge (INVCHG) ke ywords
Field identifier

Required
Field

Data type

ID

No

Integer

CLUB

Yes

Integer

INVID
DUEDATE
AMOUNT
QNTY
FLAGS

No
Yes
Yes
Yes
No

Integer
Mm/dd/yyyy
Numeric
Integer
Integer

Description
used to uniquely identify invoice
charge
Club number where invoice was
posted
Identifies associated Invoice header
Date charge is due
amount for charge
Quantity of items in line item
(Internal use only)

Table 5: Invoice Charges keywords
Invoice Cre dit (INVCDT) ke ywords
Data type

Description

ID

Required
Field
No

Integer

CLUB

No

Integer

DATE

Yes

TIME

No

POSTDATE
INVID
INVCLUB
AMOUNT
EMPLID
STATION

No
No
No
Yes
No
No

Mm/dd/yyyy
Hh:mm
[A/P]M
Mm/dd/yyyy
Integer
integer
Numeric
String
Integer

used to uniquely identify invoice credit
Club number where payment was
posted
Invoice credit post date

Field identifier

Invoice credit post time
User- edited post date
Identifies associated invoice header
Identifies associated invoice header
Total amount of invoice
Employee “assigned” ID
Station number

Table 6: Invoice Credit keywords
Payme nt He ade r (PM THDR) ke ywords
Required
Field

Field identifier

Data type

Description
used to uniquely identify payment
header
Club number where payment was
posted
Payment post date

ID

No

Integer

CLUB

Yes

Integer

DATE

Yes

TIME

No

POSTDATE
RCPTNUM
EMPLID
STATION
CUSTBARCODE
CUSTAGREE
AMOUNT

No
No
No
No
No
No
Yes

Mm/dd/yyyy
Hh:mm
[A/P]M
Mm/dd/yyyy
Integer
String
Integer
String
String
Numeric

PAYMETH

No

Numeric

REFNUM
FLAGS
VOIDDATE

No
No
No

VOIDTIME

No

String
Integer
Mm/dd/yyyy
Hh:mm
[A/P]M

Payment post time
User- edited post date
Invoice receipt number
Employee “assigned” ID
Station number
Member barcode
Member agreement #
Total amount of invoice
Payment method: 1 = cash 2 = check
3 = coupon 4 = gift certificate 5 =
discount 11- 15 = credit card types
corresponding to those configured in
Fitness Manager If not supplied, this
default to check (2)
Payment reference # information
(Internal use only)
Date invoice was voided
Time invoice was voided

Table 7: Payment Header keywords
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Payme nt De tail (PM TDTL) ke ywords
Field identifier

Required
Field

Data type

Description

ID

No

Integer

CLUB

No

Integer

PAYID
PAYCLUB
CHGID
CHGCLUB
AMOUNT

No
No
No
No
Yes

Integer
integer
Integer
integer
Numeric

used to uniquely identify payment
detail
Club number where payment was
posted
Identifies associated payment header
Identifies associated payment header
Identifies associated invoice charge
Identifies associated invoice charge
amount for charge

Table 8: Payment Detail keywords
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B ill'g C olle ct
Mem bers hip Pre-Sales
Mem bers hip Sales
Pro-s hop Sales
Ac c ounting Trans ac tions
Setup Pers onal Training
Setup C las s es
Setup Inventory Item s
Setup 'Q uic k-Add' Form
Setup Mem ber Types
Setup Paym t Sc hedules
Setup Servic es /Vis its /Fees
Setup C hec k-in D efaults
Setup Station Hardw are
Setup Site-C kin Fields
Setup PO S D is c ounts
Setup Inc om e Ac c ts
Setup Expens e Ac c ts
Setup Billing C ategories
Setup/C hange Status es
C reate PO S D ept. Keys
Setup C us tom Fields
Setup Sec urity Ac c es s
Print Gues t Pas s
Print Mem ber Photo
Print Barc odes -ID
Print Barc odes -Inventory
Approve Agreem ent
Print Ac c ounting R eports
C us tom R pts -Spreads ht
Q uery D atabas e
As s ign Pas s w ords
As s ign C om m is s ions
C reate Mailing Labels
C reate C oupons
Signature C apture
Sc heduling C las s es etc .
Em ployee Tim ec loc k
Enter Notes (to/from )
D is play pic ture
Pop-Up Inform ation
Set C redit Lim its
Apply/Unapply Paym ents
Sales Perform anc e
Setup PT/C om m is s ions
Tag Mem bers
D is play Graphs & Trends
Interfac e to Affiliates
Set C om m is s ions -Item s
C reate Team s
Setup Mem ber Plans
Setup Plan C om m is s ion
Billing-EFT/Statem ents
C reate Form Letters
C reate W O Pres c riptions
Mas s age D ata-Tes t H/W
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C on- M br D ata D ata C omm Exp
figure Sale Entry Exch O pt
O pt

X
X

X

X
X
X
X
X
X

X
X
X
X
X
X
X
X
X
X
X
X
X
X
X

X
X
X
X

X
X
X
X

Fit.
Front M gr U til M ktg WO
B kup C tr
R pts
Ptne r

X
X
X
X

X
X
X
X

X
X
X
X

X

X

X

X
X

X

X

X

X
X
X
X

X
X
X

X
X
X
X
X
X

X
X
X

X

X

X
X
X
X
X

X
X

X
X
X
X
X

X
X

X
X

X
X

X

X

X

X

X

X
X

X

X
X

X

X

X

X

X
X

X
X

X

X

X
X
X

X
X
X

Index
A
Account
Summary 161
Accounting Period Closeout 194
Accounts
Billing 160
Income/Expense 160
Alerts
Check-in 124, 132

B
Backup 9
Bank 97
Billing 27
Charges 188
Credit Memo 193
Declines 184
history 193
Invoices 158, 188
Member setup 169
On Account 170
Process (running) 182
Recurring Dues 170
Tips 185
Billing Module
Configuration 174
Browser
Database 73

C
Cash vs. Accrual 159
Charges 158
Add to member account 168
Check-in 118
Activities 127
Alerts 132
Classes 131
History 123
Personal Training 129
Punchcard 129
Unattended Mode 120
Visits 129
CheckFree 44
Class 99
Adding 99
Collections 27
Tracking 196
Commissions
Classes 149
Inventory Settings 89

Splitting sales credit 148
Configuration 27
Accounting period closeout 194
Discount Levels 57
Member Services 66
Configuration Menus 31
ACCOUNTING 50
FILE 32
FRONT COUNTER 90
MEMBER 58
SECURITY 71
SITE 41
STATION 32
Contract Sales 26
Contracts
Add-ons 114
Management Approval 113
Plans 109
Sales 111, 113
Templates 108, 111
Coupons 88
Credit Memo 166

D
Data Entry 26
Adjust P/T & Visit credits 130
Credit Memo 194
Declines History 193
Member Status History 122
Record Browsing 73
Record Editing 74
Record Searches 74
Recurring Dues 66
Status Date Range 123
Data Exchange
examples 226
Export 222
file formats 223
healthcalc export 234
quickbooks export 237
scripting 228
transactions 224
Data Restoration 242
single file 242
total restoration 243
Data Set 28
Discount Levels
applying 57
creating 57
Discounts
Point of Sale 145

E
Employee
Timeclock 154
Employees 93

Access Settings 95
Additional 94
Commission Levels 89
General 93

F
Features 9
Form Letters 214
Contracts 111
keywords 215
member filter 215
Front Counter 25
Adjust P/T & Visit credits 130
applying Discount Levels 57
Classes
commissions 149
selling 149
Member Status History 123
P/T & Visit Expiration Dates 131
Splitting sales credit 148
Status Date Range 124

G
Groups 98
Adding 98

I
Icons 23
Installation 12
Hardware Keys 13
Network 12
Inventory
Adding 86
Commissions 89
Coupons 88
General 87
Restock 88
Invoice 163
Charges 158
Member History 163

L
Login 29

M
Mail Merge
Fitness Manager macro
installation 213
using 214
printing 214
setup 214
Templates
creating 213
testing 214
Marketing 26. See also Prospect
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Call Back Lists 106
Member
Account 78
Adding 76
Delete 77
Editing 77
Records 75
Member Records 78
Billing 82, 169
Contract History 115
Custom 84
General 80
Notes 84
Personal 79
Picture 85
Renewal 84
Membership Sales
at POS 145

N
Notes
Add Check-in 121
View Check-in 120

P
Payments
Apply 164
Cancelled 164
History 163
Personal Training 100
Adding 100
Batch Adjustments 131
Credit Adjustment & History 130
Selling 146
Picture Capture 14
Point of Sale 135
Change price/quantity 137
Inventory Sale 136
Misc. sales 138
Split Tender 141
Using Quick Keys 136
Program Group 24
Prospect
Add via Front Counter 150
Adding 107
Browsing 107
Conversion 77
Edit 107
Tracking 105
Prospect Records
Prospect 85

Q
Query
compound statements 209
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creating & saving 208
field selection 207
operation selection 208
running 209
value entry 208
Quickbooks
export to 237

R
Recurring Dues 170
Reports
Customized 211
crosstabs 213
spreadsheets 212
Filters 211
Invoice History 149
Memorized 211
Personal Training
Batch Adjustments 131
Recurring Dues
Batch Adjustments 66
Visits
Batch Adjustments 131
Z-out 149
Reports Module 199
utilities 215
Requirements
Hardware 9
Returns 142

S
Scheduling 101, 152
Add appointments 153
Adding Groups 101
Security
Login 29, 95
Services
Add to Contract 110
Create New 66
Recurring Dues 66
batch adjustment 66
setting 66
Signature Capture 112
Sound 14
Support
Technical 15

T
Touchscreen 13
Calibration 20

V
Visits
Batch Adjustments 131
Credit Adjustment & History 130
Selling 146

W
Workout Partner 27
setup 156

Z
Z-out 149

